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ADDRJ[2:0]—®
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| - L
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|
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DO
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z1 ZDET CMPO
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INSTR_ADDR = 000 (Decrement A0)
INSTR_ADDR = 001 (Reload A0 from DO)
z0 = INSTR_ADDR Isb
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project.
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project.
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SRAM using DA - without processor
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Shows the 16-bit differential 4DC,
hardware multiplexed into 8 channels
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Shows the 16-bit differential ADC,
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Location: C:\MyProjectshaMEz156

Advanced

[-]

[ oK || conesl |

XN, EECLAVEE— N, TG INA: . PSoC Creator 3.0 A13.0 SP1 (1] UDB 4wia#s A At 5 R &1f
. BUE, AME—ATE R EIEMARE. &8 7E PSoC Creator ) F AN KA R F MEIE .

2. V43| Workspace Explorer 1) Components &3, #5417 Project ‘AN82156’. M FHizicsir, kP

Add Component Item...J5, & 9 Fis.

K 9. @S2l

Warkspace Explorer

R

B Workspace '‘WME2156' [1 Projects]

EIEI *Project "A

=¥ TopDes j Irnport Cornponent.,

NE82156' [CY BC3B664>1-0401

| Add Component Iterm..,

Set s Active Project

Update Components..,

Build ANS2156

sjuauocdwoy
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3. i%#% UDB Document, F-¥ 41~ “SimpleCntrg_vl 0”7 , Wi 10 firw.
B 10. ¥ 1 UDB SCAY

A AFEPZ B TR T 5 “_vX_Y” WRERImBI A5k, e,

Add Component ltern

= Symbol
©| Empty Spmbol
& Symbolwizard
= Implementation
é] Schematic
Iﬂ Schematic Maco

Creates a blank spmbal

Creates a symbol using a wizard,

Creates a blank schematic.

Creates a blank Schematic Macio

new file to add/configure UDB

EF UDE document
1 Werilog File Creates an empty verilog file. Al
s B
Target
Generic Device
Architecture: Item name: SimpleCntid_+1_0
Fanily: Componeit namme: SimpleCnt8_v1_0
Dievice: Destination: ANB215E_Libr
[ Create New 'J ’ Cancel ]

X7 IR EERRAR

PSoC Creator HA A #I ThAg, il e 4] DA IS 08 4441 22 A A .
4. fitd Create New, 6% UDB XCRYJRHLIK .,

UDB SR R e — ok AR, T AR AR LB 2E T UDB RYZLfF. AT LUK UDB Jo RS2 5 S b, #ig i
TR E ) PSoC Creator JR BN —#F . EHEMENZ R B K _ERA M SR iz B ER 2, ES%5E 11,

=)
)

Oz BS 02 05 05 (4

11. UDB 0E

Pointer

Datapath

Control Register
Status Renister
Status with Interrupt
Count ¥

State Machine

YR A IR B .
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5. RO RIS UDB SCRYEELE By, 1S 1A 12,
K 12, Hdm e n R

| TepDeskn,cysch | *SimpleCntra_v1_Duyudl

INSTR_ADDR[D]  Zero_Detect m ) Decrament
INSTR_ADDR[1] 1'b0 . u Count
INSTR_ADDR[Z] 10

Reload Count

ALUout=(A0)

ALUput={A0)

)
&
B
#
S
&
k=)
O
a
~
-3
T
i

ALUput={A0)

6. HEHPREASS]. UDB i AMZENERE D, Ei%E DK & Datapath properties (FIEEEZIEME) -
BRI L FRM ‘Datapath_ 17 BEEh ‘entr8” , & 13 iR,

K 13. Fdm s as m

Datapath properties —
EH Misc

“Wwidth [bitz] g

MSE offset 7

= Shift common configurabon
Shift ot Left
Drefault shift in a

E= Shift configurabon &

7. fEcntr8 [, Wi Inst FIZREME. NTHT B B XHEHE L 3'b000 (ZFH [ 14) £ 15 F &R,
14, 5%

3'b000 ALUout=(A0)

WWW.CYpress.com %45 001-89207 kA *D 13
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15. AR B E X TEHE

Configure Instruction (3'b000) @
Comment:
AL operation Register writes
Shit: [Mo-op +|  [Noop -
ALU_out (A0)

Compare optiohs

Option O: AD compare ta DO

Option 1: Canfig & Al compare bo D v]

[ oK. | [ ool |

8. FEIZARHEPEES N EIE S . BEIEEL 2, JF TRBEXTHRAE, HuRBAREE (FEHEE A0 NI it
Hfh .

¥ ALU operation Function ## N A0—1 GEJD . 7E Register Write B 1 E A0 = ALUout. IXFEATECE
kI8 NIEEL A0, IFEHEIE R A0 N, BHW DU ZIE S1E A — NIRRT U B, BN
“Decrement Count.” i¥&#% 16.

K 16. A F M E

Configure Instruction (3'b000) @
Comment: Decrement Count
AL operation Register writes
Funcion:  [a0 (- =] [1 | [AD=ALUow -
Shit: [Mo-op +|  [Noop -
ALL_out (&0-1)

Compare optiohs

Option O: AD compare ta DO

Option 1: Canfig & Al compare bo D v]

[ oK. | [ ool |

10. Tk, BLEEAHEE 3b001. W ZME. Wk 2 A, 84 1 KA DO FIEE N s A0 W. 7
Register Writes B & A0 = DO, HAHKE 17,

K17, 54— E

Configure Instruction (3'b001) @
Comment: Fieload Count
AL operation Register writes
Shit: [Mo-op +|  [Noop -
ALU_out (A0)

Compare optiohs

Option O: AD compare ta DO
Option 1: Corfig & 0 compars to 07 -
QK ] [ Cancel l
WWW.Cypress.com RGNS . 001-89207 A *D
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11, 5T REA TR ZL FEER B AR AR BRI B0 R N PR AT 1048 %o B, SRATEE AR B Blim A P I A D 8 . 1
Je, BATR TR EAE 5 f i 45— D Ol 4 bRgs

12, Wik [ 18 o i e A

Kl 18. Hod e A2

13, H IS B RO B AR A, & 19 o
14. ¥ Output O BLE A A0 ==0, ¥4 Name & &N ‘Zero_Detect’ .

19, ¥ s g G

(7 )
Selection: Name:

Dutput 0: [a0==0 -] Zera_Deteot

Output 1: [Wore -]

Output 2 [Mane -

Dutput 3: [Wone -]

Output 4: [Hore -]

Output 5: [Wore -]

[ o ]| oo |

15. {55 Zero_Detect F#/RiZ BRI 20 Hith . 24 AOZ5T O, Zero Detect A EF, 4 A0 AT O,
Zero_Detect K HL .

16. ¥ iZ(5 5 H AR AR RIS k. %5 S B EEEE BT 5 R E .
17. WA 20 BRI A AE .
P 20. HdEE AR
jon XP
INSTR_ADDR[0] 1'b0
INSTR_ADDR[1] 1'b0

INSTR_ADDR[2] 1'b0

WWW.CYpress.com %45 001-89207 kA *D 15
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18. X T Input 0, i#i{f Selection 11X B INST_ADDR[0]. jf H. Expression #i% &} <Zero_Detect” , X

21 fi7R.

K 21, B e A E

Configure Datapath Inputs Iilu
Selection: Evpressior:
R @ [INSTR_4DDR(0) »| e Dotz |
Inputt:  [INSTR_ADDRII] M T |
e [iNsTR_4DDRE) - [ |
e [Hone - |
Input & [Mone - |
Input 5: [ Mone n ] ‘ |
I ak. I l Cancel

l i

19. M Zero_Detect 55 A UL F % BRI 2K EHAT 464 . Zero_Detect A BT, FHRBAKEHUATIE S
1; EE S NHETN, RSB AaKIITIES 0.

20. NHCATH SRS AR A 25 77 2% 2 SO ST UR {H

21, Xk 22 HF BN IR R 25 AP RS L AR

P 22 Hdl BR AT 5 A7 4%

Reg.

A0
A1
DO
D1
FO
Fi

Load

Not supported

Not supported

Unused

Unused

Unused

Initial Value

Not supported

Unused

Not supported

22. ¥ AO Il DO M¥IRE R E N 15, ESHK 23.
K 23. HiE R E SFEAEL B

Configure Datapath Registers &IM
Load: Initial walue:

A0 | Not supponed | |15 |
A1: | Not supponed | &0 |
DC: [ Urwsed G |
D1 | Urwised | [ &hoo |
Fo: | Urzed | | Mat supparted |
F1: | Unused | | Mot supported |

| ok || teed |
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23. EAICLXElR T THE. BTk, BAEE XA . iz R &0 (TC) o HitHds’y 0 i,
ik oy, AR AL, R R AT

24. 1f Outputs FHJ‘SimpleCntr8_v1_0’ Properties &0, & X —/N4& KN ‘TC” R, ¥ Expression #
BN ‘Zero_Detect” , d 24 fiR.

& 24. 5
SimpleCrtrd_vLU' P _

X+ &

Inputs

E- clock

Mama

Outputs

= Zero_Detect

Mamme Expreszion

25. NZAMAERFFS . BV R RTER I TIE Rt E S S .
26. Fiti UDB XCB (.cyudb) KIZSAXIK, fiE#% Generate Symbol, 5% K 25.
25. S

|@ Generate Syrmbol "
Change Template

8 Paste Chrl+4
Select All Chrl+2,
Zoom »
path instruction

Froperties

27. JFHE B SE A 26 Fis.
& 26. J5 1 E A4S

SimpleCntr8_v1_0_N
SimpleCntr8_v

[+clock TCH

28. fEFF ST, A ATER (AR SAL) , WRE N TR RILESE Properties.

WWW.CYpress.com YA . 001-89207 JEA *D 17
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29. TEJEMETBCR I Symbol #i5 HE A\FTRR EUE, Wl 27 Fio:
o Doc.APIPrefix = SimpleCntr8

ZAEAE AL AT AP U IET A . AR 2Bl R A R AEAENT APL, (HRRH QIZ A AL, 7L

AN H

o Doc.CatalogPlacement = AN82156/Digital/Cntr8

Wi s cL. #EEFTIF Catalog Placement X1iEHE, SAJE 4 fEMiN1%{E. PSoC Creator ¥ FiZ{H & A1k
HRIZR. FH-TRRIETFR, FiZETE SRR ERTPHAaAEt. 8—AREmrHRr—4rEHR. 4
fFEFUARPEE—ANTHFR. ERMEER R ZAMFRE ‘Cntr8” , ER/RTE AN82156 EII-K T

‘Digital” FHZXN.

o Doc.DefaultinstanceName = SimpleCntr8

KRN B A R h i SR R BRI AL B
K 27. IRINAT S s itk

Froperties @
0400 /2014 14:36:37 -
B Symbol

Do AP Prefis SimpleCntrd

Doc.CatalogPlacement [Callection) [

Doc.CataloghizibilityE spression  true

Doc.DefaullnstanceM ame SimpleCntrd |

Doz ExtemnalCarmpotient Falze

Doc. SymbolS urmarny
Doc. SymboliziblelnCatalog True
Doc.URL |

m

1

Doc.CatalogPlacement

| ook || e |

30. KIKEFE File > Save All, H{RARAE T 300 H 4T BT 5 .

31. BAETTLMERIZA M. #£ AN82156 IR AL H T, W EEBIIHM, WK 28 Prs.

28. 411 H = B AL

Cormponent Catalog (311 components) > 0 X
Search for... iy LI.J! e

AMBZ156 | Cwpress - OFf-Chip q I
AMB2156 Component Catalog
=-%g Digtal

WWW.CYpress.com R4S 001-89207 fiA *D
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32. {£ Component Catalog NReE BHMFfE, a DL Z A8 B AR S L b . 1R ROE IS 00 5 S e 4L A )
33. N T MIZAME, RN AREEATH RS TC Mth A E L.
34. 4 Cntr8 L /HE AL H IR B K

35. FEANBHAMFERLE ‘clock’ i, JERHMARBE 10 kHz. ATDMERHE TR, [HEERM S LS T
M 10 kKHz AT

36. KN SUALFER R ‘clock” Zm, MIMER A EREIEE . #iZ5I a4y PO_0_clk, JEOREF
HAnBRA B E -

HER: XT PSoC 4, AR EHK B B3N 51 0. BRI b i e B 3EAN 51U, AT DU IR AE:
a. CKBEHCEE S AR E S R E L
b, 7E5| e HI#% Fik#E Clocking &R,

c. ¥ Out Clock: ¥ & AN External.

d. R[E Pins &L, FF4£3F] Output FiEIF.

e. ff Output Mode: TFi%&#% Clock.

f. il OKo

g. CKIEME SRR T AL B out_clk 53

37, W5 AECEHH B WALHERE TC . KZIMA AN PO_L tc, IR . AL TR,
3 B AR T
[l 29 BT AG A e BT R

P 29. fj gt Hae p It H JE A
SimpleCntr8_1
SimpleCntr8_v
Clock_1 [} clock TC——— — +{m/PO_1_tc

10 kHz

>[ual PO_0_clk

WWW.CYpress.com R4S 001-89207 fiA *D 19
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6.3

38. 7E cydwr [fJ Pins i& T T, RYE 51 I & Bk & 4114 B 4s PO[O]FT PO[1].
39. HITE, HEPILAYm BRI H HgmfE PSoC. # Rl LATES| K1 PO[O]F PO[L] bW 5= i i N 28 ity T4 o
40. RAFIIE, T IF9mEE PSoC.,
A1, AR FEE R S, AT RLWEE ‘clock’ A1 ‘tc” Frdd, Wil 30 FiAR.
B 30. i BT s g

U : ; ‘_ T ‘_ : ‘ : :
4

Lirenc b RV E L LR DL EL LV D ET
Chil 1.00V  [@i¥ 1.00v M| A Ch1 7 1.02V

42, FITE CUGACEATE 15 N3 A0 1Y, TRIHEUE #Ih 16 (M 15 3 0 &) AN e A, AOME N 0 B, ‘TC’ 5|
JHIZE— AN Bh R A AL T3 F T, AR, AO Y4 E#: DO (fH. AOHIEENT, ‘TC’ MEHT, AR EFHK
B %635 98 AO.
TG e B — AN E T BRI AR A, 1A 75 B g B AT AT A AS

Bt BESCh PWM

PWM 22— EA LR 5ds. N T B PWM, BEEMHEANEE A0 FIME S 5 —ANE 3T .

AL D1 2977 2R A7 [ e Lh i, 8 % B LR Bk A 7 A0 2 75 /T D1

WWW.CYpress.com R4S 001-89207 fiA *D 20
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A PAE A 31 A SR ROAE B A %75V

B 31, N o R PWM AE K]

INSTR_
ADDR[2:0] CFGRAM
—» FO - » F1 -

A

DO D1
(Reload Value) (Compare)

-
]

]
(Count Value

SHES

\ A0,A1 /
PFﬁ PO

Pl
—ivV Y Y VY

o
oD
Q
g 2
g c
>
&

cel
FFDET cl1

_a ZDET CMPO

CMP1

INSTR_ADDR ==000 (Decrment A0)
INSTR_ADDR == 001 (Reload A0)
z0 = INSTR_ADDR Isb
cll=Compare A0 < D1

FEZoRBI T, XSRS PR 8 (LTS B N BTN RIS, thn] DUR S S w i Sl

P, TS R W I 1 B AT 1 0
1. #T7F SimpleCntr8_v1_0 HZHHSFS C.cysym) .

2. f%fE ‘O, BIESI—A T &m. Kiz&amiar o8 ‘omp’ . IRRETRELER 32 s E .

Kl 32. #H ‘cmp’ LA

SimpleCntr8_N
SimpleCntr8_v

[Hclock TCH

3. Kki%k#E File > Save All MR1EITE B A2

4. JR[A UDB X4 C(.cyudb) , FffdiiZsdE%1%. 7€ Datapath properties % 19, &#fiff Configurable
comparator inputs ] Config A #1%E v AO compare to D1; 5% 4 33.

cmp |
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33 A LR e

D atapath properties
Drefault shift i 1]
= Shift configurabon A
Shift direction Shift left
Shift in gource Diefault shift-in
=l Shift configurabon B
Shift direction Shift right
Shift in zource Default shift-in

El Configurable comparator mputs

A0 compare to D1 -

Config B A1 compare to 01

5. BT T4 0 /154 1, ©44% Compare Option 1 % & ConfigA: AO compare to D1, 1/ 34 fiiR. EAH
FTTFAZSTRAE, 175 B A LR S 4R A A o

K 34. i Btk I

Configure Instruction (3'b000)
Cornmeit: Decrement Count
ALL operation Register wiites
Functior: [AI] v] [ V] [1 v] [AEI = Al Uout V]
Shift: lNurop vl [No—on ']
ALU_out (A0-1)

Compare optiohs

Option O: AD compare ta DO

Option 1:

6. X HEIF¥ Output 1: Bt BN Config A: A0 <D1..., %RJ5¥% Name &y ‘Compare ” , H1/4 35 fizs.
P 35. Mic & bb i

Configure Datapath Outputs
Selection: Narne:

Output [a0== - Tern_Detect
Output 1: [Config A A0 ¢ D1, Canfig B: &1 < D1 v] Compare
Output 2: [None ‘] 4|
Output 3: [Nune ‘] 4|
Output 4: [None '] 4|
Output &: [None ‘] 4|

[ 0k ] I Cancel ]
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7. EX—ANEA ‘cmp’ BB, ¥ Expression %E Ny Compare (LD i i & %K 36,
36. LhAzd

|'SimpIeCntr8_v1_IJ' Properties - 1
X+ +

Inputs

clock

Mame

Outputs
= TC Zern_Detect

Mamea Expragsion

8. fJm, NHEFFE (D) MEYIHIHE.
9. #IJF Configure Datapath Registers (JlE 3 HEZT A4 SGHE. ¥ DL MWIGE®E N 7, WK 37 fior.

K 37. D1 MWIEEE

Configure Datapath Registers
Load: Initial walue:

Al | Mat supported | [&noF |
&1 | Mot supparted | | 2'h00 |
DO | Unused | | &nor |
D1z | Unused [ [l |
FO: | Unused | | Mot supported |
F1: | Urused | | MNat supparted |

| ook || cemes |

10. #&kIRiEFE File > Save All,
11, R ES, X A0 /NT DL, RS S A 2 A0 KT DB, &4 Ak F.

£ Component Catalog & [+ f#] AN82156 £ -~ ISR T LA E PWM HAF-FIRTFS . HA7EDH R EE B b 5 30
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12, WIN—ANg S, IR EEER ‘omp’ L. BT E A PO 2 cmp . T 5 Po[2],
| 38 Ao

] 38. fij . PWM 135 B E

SimpleCntr8_1
SimpleCntr8_v

Clock_1 [T} clock TC}—— —+{m|PO_1_tc
10 kHz cmp P0_2_cmp

»Jool PO_0_clk
13. PUAE, 0] DAk H JF4ifE PSoC. A LA{ES| A PO[O]AN PO[1] L RL&Lmy Al Z i i+ £, 7E PO[2] LA M%E PWM
.
14, fRETH, 4l HamFE PSoC.
15, IR B EA R SERE S O, BT ‘clock’ . ‘tc’ AT ‘cmp’ Hd. B 39 BaRHIE ‘ck’ Al
‘cmp’ 5%,
& 39. fai B PWM %t

& SRR AR S

'_ CCMP j'i .......
N

CIK |- vo et

LTI T 22 PR AT 30 0mv

ST R AR {E 15 INE] A0 A1 DO WY, AUkt SUR I BE R0y 16 DM B 1. T4 D1 E N 7, FrblfEd A0 /b
T 7wk, femp’ SUARENE. ETLOE 0 D1 T RIE, X PWM AT,

6.4 NS
FEMBSCE N A IS HET, TR Verilog RISEA . 556, 2475248 T EUS A EEEUE I A AHF B PWM
W, EEEAAEE? 50T AT R R AR TAE DT AR, BT DL IS IR I T LB S
1. ATIFZA A SIS TUE Ceysym) JRA T2 H M,
2. M35k Symbol Parameters.
3. HEIASHTFHTATN, MAFRNSE.
o %4k = Compare_Value
o %A = uint8
o fH=8
4. EEHAMK Misc BB 7B, K ‘Hardware” FpEBEN “True” , Wil 40 Pios.
RFEAT LIS OIS Verilog AU, I UDB BEAF AT LUREHTE
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40. IFIN— NS

Parameters Definition @
Mame Type &
Cv_MaJOR_VERSION string =G
CY_MINOR_VERSION string =G Category  Misc
Check R: T
CY_REMOVE bool Faled ek ng [TUe
Diescriptic
CY_SUPPRESS_API_GEM |baal fals| = DizplayOr Falze
N LeEEE True El
CY_VERSION string =G Foad Onl False
INSTAMCE_NAME string =G Tah Basic
. “alidators 0'alidator
» Compare_%alue uint8 g - Visble  True
4 | 1 ;
*._Formals | Locals 4B
Name: Compare_%alue Hardware
Uipess Wi Iz the: Parameter passed as
Value: 8 5

Yerilog DefParam?

———

5. TEBRIGIEMLEEE X TF—1TH, AA—NHNSH:
o 4%k = Counter_Period
o 28 = uint8
o fH=15
6. MEHE AN Misc % B 7B, ¥ Hardware i3&E %N ‘True’ , W1 41 AR,
AL I — AR

Parameters Definition @
Marme Type &
Cv_MINOR_VERSION stiing e ||F Misc '
Category  Misc
Cv_REMOVE bool falze Check Az True
CY_SUPPRESS_&PI_GEM |bool false Dessintio
E Dizplay0r Falze
CY_VERSION string “=Get SEEER True E'
INSTANCE_NAME stiing ““Get Fiead Onl Fales
Tab Basic
Compare_Value uint8 8 L4 Validatars 0% alidator
» Courter_Period uintd - Visile True
4 | . s
“. Formals | Locals a0
HName: _Enunler_Pelind Hardware
"I’;;;?:;_u{r%tB |z the Parameter paseed az
B Yerilog DefParam?
= Il ee

7. MHili OK HRikiE¥% File > Save All, RN IZAL4HET T A B ik
BT 5 S RO B IR A AR
8. #%|UDB %i%Ee% (.cyudb) , I3 Configure Datapath Register XHiE#E.

X} AO #1 DO, ¥ Initial value: % & Jy'=$Counter_Period”. #HyEE, HHKRARERS, MARLEI S
T D1, ¥ Initial value: & N =$Compare_Value'; EZSH K 42,
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Kl 42 IS B B AR E

Configure Datapath Registers @
Load: Iriitial walue:
a0 Not supported “=§Counter_Period”
A1 Mot supported S'hi0
D0 | Unused "=} Counter_Period”
D1: | Unused "=fCompare_Walue
FO: Unused Mot supported
F1: Unused Hot supported
l Ok ] [ Cancel

XUEARADHE AO. DO I D1 1HI4E A A7 25 (A B B A S 40
WAE, VT AR I 5 B R AR LU E, 1R 75 ZEA4E UDB 2 28 S U 251 .
10. K Ki%EF File > Save All.
R ETH H R, AR5 W SimpleCntr8_1 Z14F, LT IFJ@ MEXHEHE ..
11, KEHEMESCR 3, FiHEE SN 10, W& 43 s,
B 43 BEAMNSH

Configure 'Simple Cntrd’ IEI

Mame: SimpleCntrd_1

- Basic " Built-in qp

Parameter Walue

Compare_Yalue | 3
10

Parameter Information
Counter_Period: [Mo description available]
¥alue:
Type: uintd

l Datasheest [ ak. l l Apply ] [ Cancel

12. #di OK, MAEANZE.
13. R I%EFE File > Save All, 4wi¥TiH, I4wFE PSoC.
THEUR BAR L B R O, dnlE] 44 iR
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Kl 44. IRIEHSENE PWM i

A T B . I .

Mcmp ......... ]

‘‘‘‘‘‘‘ 4.
clk |- - ...........

Chi 100V (@ T.00v M ] A Ch1 A 100V

THEA MRy 11 AR IR KT 10+1” , BUATHEER 6 10 B89 E) 0, RIGARATEED , W
{679 3. F3BIMILEFERE Y 8 A Bl ] 3T A1 FEL P B A0 =Bk ] 300 A v P~ B S

REFE R uint8, AT LLK S5 OB E . A m] DA E HiCE 2 N, JRReqlnz

O B A R B -

B2 HRBMAMFSHIEL (BIERER P RRMNERED . E2% 25157

6.5  IINSkICAF

o e BB PWM IPERE, 534h, EILAEA C AURSEE PWM w7248, ROE T LIRS AT I 122 PWM. f1
n, oy RIER] DO A D1 W A7 R ORAE MM LA . O T8 T U5 X e 35 248, T BB — e L R # A7

LIPSl

1. #£ Components () i+, Al SimpleCntr8_vi_0 Ji%#% Add Component Item GRINAMT) .
2. {f Add Component Item & 9, SHiE] APl #4>, %5 sidi API Header File.
3. 4 ltem name N SimpleCntr8.h, #1& 45 FizR.

Bl 45, Ak rE
Add ComponentItern @
=1 &P <
A 8051 Keil &ssembly File Createz an empty 8051 Keil azzembly file
c APICFie Creates an empty AP C File.

A8 GNL ARM Azsembly File

=l Misc

m APl Header File Creates an empty AP header file: = ‘
Createz an empty GNU ARM assembly file b

484 Realview ARM Assembly File [Eg;a[ggi.agiﬁngi:rigmﬁ: ARk

Target
Generic Device

Architecture:

Itern name: SimpleCntr8.h

Farriily: Component name: SleCrtrd_w1_0)
Device: Diestination: - SimpleCi
[ Create New 'J I Cancel

4. 55 Create New (BUEEHTD , #L R mBIE AN .
IINHLEE (D) MEHHME (DO E Lo
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5. TERSCHEM // [1END OF FILE FITH, ¥R HFIEX:
#include " SINSTANCE NAME' defs.h"

#define 'SINSTANCE NAME  Period Reg “$INSTANCE NAME' cntr8 DO _REG
#define “SINSTANCE NAME  Compare Reg "SINSTANCE NAME' cntr8 D1 REG
AN E LA VFE EAES NG (R ) DO A1 D1 %5 4725 INSTANCE_NAME'_defs.h SCFEL & 7 #icda i 42 o i) % /%7 47
A IE LA

AT DA 5% T 1 A B SO e 3R B INSTANCE_NAME_defs.h, 48l 46 ffizs.
& 46.defs.h SCft
Workspace Explorer (2 projects) > 1 X
&
B Workspace 'AMB2156' [2 Projects)
= Pa] Project *AN82156" [CY8C38665X1-040]

wn
lﬂ' TopDezsign.cpzch _E!
P ANEZ1EE cpdwn q
=L'f} Header Files 5
EH.'f} Source Files %
Lelg] mainc §
EHy Generated Source =
B PSoC3

B+ Clock_1 B
ti'l cy_boot E’:-._
FHE) PO_0_ck i

FHED) PO_T_te
.ti'l P02 cmp @
EH::) SlmpIeEntrB 1 ‘%

IR SRAE AR 3 AT S 18] ST LA /\E'ﬁ)\ﬁﬂ‘ MBI 5 SCRITT . n R S i) 2 14 44 SimpleCntr_1, A %)
CHRISH T

SimpleCntr8 1 Period Reg = 0x08;
SimpleCntr8 1 Compare Reg = 0x02;

SR AR 4 J J (A0 LR AEL 7 1) BE 50T JOX08HIOX02 . B 2 A7 RN il X w52 LIS B, 1555 ZI7F 4751, THiERE,
HESABSFASNNIE (nEmprdfCiid) FoE 8w f7at. X T16frskilehs UL EK#Hfras, EuaifiH
T IH T R AR D5

6.6 ¥ PWM¥EZ] 16 AL

BAVET W — THURE AR M S SO AE R EERIMASURSANERAGES . Bl FES, nUAl@EEEN
1 3 32 iR Lhie. EZnplt, K@Juﬁ% —A PWM ERIFHE—An B E i PWM, HERSERN 16 £,
K 47 FioRo

K 47. 455 UDB 1] 16 f7 IhfiE

1264

{E‘PT UDB1 |eF=
T+ 1(LSB)

Datapath

PLD PLD
Chalning Chalning
FLD PLD PLD PLD <
¢ 12
and Ras: and Ras
i i

Datapath
Chaining Ghaining

Routing Channel
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T BAREEAR K ALU H TR AL R LA AR PHA5 5 B B i M B B A2, &) 48 o $im A 279
B A AT T R BER A AR 5 5 . AR MR B R B e e A 27T . AR R IR 2T
TR B R AR R

Kl 48. Hofis 2 I B RS

CED CEDi [ CEO CEDi ~— 0
cLo CLO | cLo CLOI — O
CE1 CE1i |-t CE1 CEli g— 0
CL1 CL1i |t CL1 CLi lg— D
Z0 Z0i -t Z0 Z0i -— O
Z1 Z1i [ Z1 Z1i lag— 0
FFO FFOI -t FFO FFOi leg— 0
FF1 UDB1 FF1i | FF1 uDBo FF1i eg— O
CO_MSB Cl gt CO_MsB Cl g— 0
SOL_MSB SIR |- S0L_MsB SIR l-— 0
CFBO CFEI |- CFBO CFBI — 0

00— SIL SOR = SIL SOR

0 —= CMSBI CMSBO = CMSEI CMSBO

IR UDB gfEdt, RERRRAHLRE % M B B AR BERAE . (I IRATNINIBIEE ) PWM, RTLUK LS BN 16
fir.

1. %3 UDB 84 (.cyudb)
2. {f Datapath properties T H, ¥ Width (bits) X &k 16, 15 49 firR.
K 49. 16 i &

D atapath properties
= Misc

Marme chtrd

Wwidth [bitg] 16
M5B aoffzet 15
3. KAHME (DO) FIWIEAEMIE (A0) B N512, JH¥EbEfl (D) & E ~256, MXIS0fR.
& 50. 16 frA1EAE

™

Configure Datapath Registers @
Load: Iitial walue:

A | Mat supparted 512

a1 Mot suppaorted 60000

DO | Unused 12

D1: Unuzed 256

FO: | Unuzed Mot supparted

F1: | Unuzed Mot supparted

Ok J l Cancel

4, EHE O, KKEREFile > Save All,
5. RETE&ITEEE Ccysch) , FKH 8 M10 kHzE A1 MHz (R AFE R 4% g ED
6. RIKIEFE File > Save All, 4iFWiH, 4% PSoC.
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6.7

6.7.1

Tl B B Y, R A% R AT E B L DA R BN EE Y 8 A2 PWM [ RTE2, Il 51 . Al e 1 B oNAEAT
—A~ 16 (i BUHE .

[ 51. faiEL[ 16 fi7 PWM HiH

=T e — :
_________ . P S O S .

|/ @lccococoooommancoosconacoooEo0c000s
chi| 1.00V [@® 1.00v M A Chl % 1.00V|

T T S T A P 7 A 5 R B0 i Pk 32 . KETE 1o B BT A 48 1 SR N TR K ) R A

PSoC 3 [ 16 frZa sk 3oft:

WHTTRTIR, X 16 ML AF8 T SEAERNT 8 ML A AT —FE. T 1T DA &b B 35 R 2% 12 27 A7 A 2 8]
WMz, HETTEESAT 8 MF A, MEEANT 16 Mok i EH KM FAHTN, FTELZEIZENFNZE
5o

PSoC 3 #1 8051 M==H5 7 AN M T /MR B AZ R I o 9 TE T X 223 T SHAE, SRR at T —ugz, .
CY_SET REG16. CY_SET REG24 fll CY_SET_REG32. XM HAEMWNANSE.: H—MEEMFERENTENM
Ik, SEoAREEEEMNE. X AT AT RS e

Rk, BUAERSBARKATFAAN L. IR ARGk (_defs.h) FLL_PTR AEEMIE XL, REH
e HHE B bt

BRI EEAMY, A S o T E U CY_SET_REG16 g4t . i F & B BEM R E155 A .

16 s

TR — NG, AR S SO E N uint8 288, SR LLESHAINE] 16 17 PWM . &R T 208 E N
uint16 RpmAT,
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7.2

TH 2 — BB

ORI TR SRR B B B AR R . SR T PWM AR, DLEEAT I BOg T A 1RO
A BRI AT I B E S HL

GBS AR T RILARGITE R AT HEM S . AN ZEIE P34 T —A s B F #5150 PWM T H .
FEZHHMAER
T BRI ek T 2 PWM T B il R PR FOIR S . AR SEEL AN S g Bas, TR A VU MOIRAS, Wkl 52 Fior.

P 52. 3 % JH BEs IR S

> S
Count Dwn Count Up

Count 1=0 Count <X
REG 000 REG 010

Decrement Increment
Count Count

Count >= X

Count !=0

REG 001 REG 011
Clear

Reload
. Count Count
Count==0 ‘

RGBS, BARRARR RIR B S AO. St mT AR B B AN LB -

BRI B KI5 R
N T EGIREL, TSRS AL, TRAZ AR — T . LIRS B A

1. Ja3) PSoC Creator, F-FTHF 81 8 i~ mi H Brff FH W “AN82156” T{EX . | TAEX ¥4 KA
“UpDwnCntrPwm” K13 H .

2. 1£ Components (44 &K, 4 Project ‘UpDwnCntrPwm’ 3£i%% Add Component Item.
3. %P UDB A4 I# Component name: 2y UpDwnCntrPwm_v1 0. fidi Create New (SIZHiT) .

Count >= X
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E 53. G @ dif:

I=1 Symbal -
©| Empty Symbol Creates a blank symbal L
©| Symbol'wizard Creates a symbal uzing & wizard, .
= Implementation
Igl Schematic Creates a blank schematic.
@ Schematic Macno Creates a blank Schematic Macro
EF‘ UDE document
,“'a-’ “Yerilog File Cieates an emply verilog file.
Targét
Generic Device
Architecture: | - ‘ Itern narne:
Family: | - ‘ Component name: m
Device: | - ‘ Destination

| ‘ I:I I Create New |'I ’ Cancel ]

BB R T R AR T AR L

5. 3| Datapath properties (H#EEEZEM) , I Name (%) &8 ‘UpDwn’ .
T T A PR AR SR B2 R BRI ThAE . BT ARTE R S RIERN 8 2 PWM HAHF], HAMNRINT Wik, KXW
IR A RENE SEILBIGINRE, WK 3 PR,

R 3. BN R

INSTR_ADDR e FRBEEAN R
000 ALU=AO-1 | A0=ALUout | imit#(t
001 No-op A0 =DO EHIHEUE
010 ALU=AO0+1 | AD=ALUout | iisif%ift
011 ALU=AONAD | ADO=ALUout | Eif#

XOR ACE W H TR (A0) Ziffdt. THE (AQ) aFfFasib g vH 4 A IE R, et B ST XOR #
&, RINSEERATTHEE N %

AR 3 W26 AR A HATICE o 8] 54 IR IR R A48 A W S AR o 3 TPk AT 34K
& 54. UpDwnCnitr 154

Inst.
Addr.

' ALUout=(A0 - 1) Decrement
3'b000 AO=ALUout Count

Instruction Comment

] ALUout=(A0)
3'b001 |Ao=po Reload Count

' ALUout=(A0 + 1) Increment
30010 jAg=AL Uout Count

\ ALUout=(A0 ~ A0)
3'b011 AO=ALUout Clear Count

6. {f Datapath properties (EdlEEM:) Mk, &#iff Configurable comparator inputs (HJ i & L B4
THJ Config A #71% & 4 A0 compare to D1.

7. EHifR Compare options T {45545 4 &R 4 ¥ B 4 ConfigA: AO compares to D1.
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8. MR#EE /M RPIMLE Zero_Detect 1 Compare #ith, HAMNAIIT ="tk (Period) o HiT-HaHE 2 &A% 7
4 (DO FERT, 5= AR HUKE A N T X RN AR B RO A W R AT E AL 1S
Kl 55.

& 55. UpDwnCntr i H

Zero_Detect

Config A: A0 <D1.. Compare
AQ == Period

9. MEHlarfrdy (CR) fEMEIERJREE L, W 56 Fix.
K 56. il A 77 a4

CtrIReg_1

ctrl_ 0
ctrl_1
ctrl_2

ctrl_3
ctrl_4
ctrl_5
ctrl_6
ctrl 7

10. MW ZIER 7. ¥ 0 A/ Name (Z#0) W E N Up_Down. H1Z45H 4 1728 E w44 A CtrIReg; WS % & 57,

11. CPU W] L= P A7 S5 AT S #ff . BItk, CPU B X Zas i A A7 S A0 AT SRR HH 0T 7. 1 FoRidig
T 0 RN
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K 57. 1z A A7 SR E

Configure Control Register @
Marne: CulReg
Marne It Mode
b 0 1] Sync
1 ekl 0 1] Sync
2 et 1 1] Sunc
3ol 2 1] Sync
4 chl_3 a Sync
5 chl_4 ] Sync
E chl b 1] Sync
7ot B 1] Sunc
*
l ok l l Cancel l
TE5H *A/TWJEP BATAEPWA RS2 4 @il ff fHZero_Detect(5 SR A 5 & F M CFGRAMBUTIIES . TIrE, &

AR S PIZBIT HEE & P B T e 2.

Ty RI LK Zero_Detect ] T g iH 4. XF T4, A Period5 5. 54b, BATEH —ME 5 H TH# 2 IEERIT
PR T RO TS ( Up_Dwn ) o BATEIILIES, B bﬂ]rﬁ%ﬂﬁ/\ﬂbhﬂi B2, FAUEALLF=AME
. Up_Dwn. Periodl},Zero_Dectect, ﬁu?@ﬁﬁ%o R, 208 B R X =ME S AR o S bk 2

# 4. UpDWnPWM 54 fiftht

Up_Dwn | Period | Zero_Detect | INSTR_ADDR Theg
Down N/A 0 000 Gy
(@Uit:D)
Down N/A 1 001 A,
(@UiY:D)
Up 0 N/A 010 Buih:
Gt
Up 1 N/A 011 b1
G

B’EEA, RANESKEM, IHEEEH AN EREF|Up_ Dwnis 5. Hothdhht A7 1 4 7% 2 2 Period(% 5 8{Zero_Detectfs
5o wRup | Dwnﬁ%%ﬁ&ﬁijDown, M #7257 82 5] Zero_Detect; 15 Up_Dwniz S 4% & AUp, MIHihEfr £
%R Period(5 5

INSTR_ADDRJO0] = if(up) Period else if(down) Zero_Detect
INSTR_ADDRJ[1] = Up_Dwn

UDB# i &% U VPl An i Verilog A N BIgm B 2 P IS AN F B 7i4h, BATIE BRI 2 LR, EXAREF,
T — A, FTULEINSTR_ADDR[O]f# i Periodif /& Zero_Detect.

12. {E Properties & ¥ Variables CE&) TJ7, WMT —M45N Reload (EFH) MHFHLTE, HiEEHFEA):
(Up_Dwn) ? ( Period ) : ( Zero_Detect)
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13. HEHE H Y E N Combinatorial, %% WL,I& 58.
K| 58. A8 E X

W ariables
@ Reload [ Up_Dwin ] ? [ Period ): [ Zer_Detect)
Mame Expragmion Regiztered

14. ¥&:. HI, “Combinatorial” % B#E B N “Registered” . iEHIEMIFT HAT, SIHLWEE RN
“Combinatorial” . %I 7 PSoC Creator [f) ~ —MRA K A7t ¥ LUEIE .

15. &3 Reload = (Up_Dwn ) ? ( Period ) : ( Zero_Detect )& — /M=t B . XS —/MAH if-else 18] (1) 5E X
&7 o
16. AT
A=B?C:D. WA B Ntrue (&) , MA=C; Wi BNfalse () , MA=D.
EiZnplF, fH Up_Dwn A, Il Reload = Period; 1% Up_Dwn A{%, | Reload = Zero_Detect.
17. Reload AT #HHIRHKILTES .

18. i# A\ Datapath Inputs (g &EHND , 3% INSTR_ADDR[O]E.E AN Reload. # INSTR_ADDR[1]f: & N
Up_Dwn, #/& 59 R,

59. R4 ik

Canfigure Datapath Inputs ="
Selection: Expressian:
Input 0: [ INSTR_ADDR(0] - | Relosd
Input 1: [\NSTF{_ADDFIH] v] Up_Dian
@t (insTR_2DDR[2) - 60
Iput 3 [Mone -
Input & [Mone -]
EE [Hone -
[ oK || cocel |

19. Rk, WE PWM Hith. Winfmimg, FAMHE —D%mi8 (TC) M—AM i (emp) Hith. cmp %tk H
Compare (EED 55, TCIE5 MR HH Reload L.

20. o EHid, Wk 60 AR,

P4 60. it
Outputs
F= T Reload
cmp Compare
Mamma Expragion

21, gt cyudb U R B4, IFiESE Generate Symbol (AERFFS) o
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22, AR R B ETI Ceysym) , FRIRIIRT S JE k-
o Doc.APIPrefix = UpDwnCntrPwm
o Doc.CatalogPlacement = AN82156/Digital/UpDwnCntrPwm
o Doc.DefaultinstanceName = UpDwnCntrPwm
WO A ESWSE, W WEES A eEUE ARG B U . W E T, EE XS
BRI DL K A ME .
23. LRSS IUN, JHTITR 5SS HBOEHE.
24. i Types CEAD FIF&E M, BUEHISHEEA.
25. PG EN] ‘+ IEESRINIEIRAL. ¥ E a4 8 UpDwnCntrPwm_UpDwn,
26. K &{HH AT Enum Set 7B, LAHIE ‘CountDwn’ Fl ‘CountUp’ € X, 1/ 61 fliar.

K 61. QI SHH Y

Enumeration Types @
Type Mames: r :_, x Enum Set:
Mame Yalue Display Mame
CountDiwn 0 Court Diown
CountUp 1 Count Up
*
ok l I Cancel

27. Hifi OK REIF 5 S HHEHE.
AT LGS S HU LA X PO R, FREAILAE IR E N 0 (CountDwn) B 1 (CountUp) .
28. WAL RBITE FEME, NAFEEA=ANHSE: ES LK 5.
5. BRI S
B LS| H

Compare_Value uint8 4

Count_Mode UpDwnCntrPWM_UpDwn Count Down

Counter_Period uint8 9

Count_Mode Z¥{ F 7 #Hi 28 B AHE 1) 5E X o
29. ¥M=AESH) Hardware Fr &% BN ‘True’ , WA 62 .
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K 62. IshE AL 24k
Parameters Definition @
Mame Type i
Compare_%alue uintd 4
Count_hMode UpDwnCrtrPwm...| Cow) = E:::cgkng' ?r'j:
» Counter_Period uintg 3 Descnph;
CY_FITTER_NAME stting G DisplayOr Fakse =
CY_MAJOR_VERSION 3tring =G Fead Ol Falze
CY_MINOR_VERSION | sting =5 \T;::i’datw gﬁdatm
CY_REMOVE bioal falz = izhle ) Tre
4 n 3
~._ Formals |. Locals 4 b
¥ame: Cot;nter_F‘eriod Hardware
ype: Un 2 [he Farameter passed as
Value: 3 {u"etr"i]UgPDefPa:amP? i
&) e
30. s OK, {RA7S e ATt AT I TE B4
31. & E].cyudb X, FEARIEE — DRI RS, (BECEF ARG E: HS WA 63.
Kl 63. RIS HO BVIMEME
Configure Datapath Registers @
Load: Initial walue:
a0 Not supported “=§ Counter_Period”
A1 Mot supported S'hi0
DO | Unused "=} Counter_Period”
D1: | Unused “=f Compare_Walue
Fi: Unused Mot supported
F1: Uruzed Mat supported
l Ok, ] [ Cancel ]

32, phi, FATA B AR B AR A AR AR . B, NN EA R E .

33. g — Ak, /£ Components () EOI-RA, 48 & UpDwnCntrPwm_vl 0, #AJ5i&# Add
Component Item (ZINAMTD o i%#F API 30, FKH A48 UpDwnCntrPwm.h. siifi Create New (1%
WO .

34. FERICAFH/* [ END OF FILE /AT, bl FARSAT
#define UP _DOWN °SCount Mode’

35. i% define UP_DOWN H{7E C 5% 322 B 41 1 5 il 23 h i B Y Count_Mode 4.

36. LI T AL & AFE ] A AE A BB main.c ST THEER T 1A . TEVERE, IrAARAERE S AR AR A AP ET AT B .

37. £ main.c 3, IR EACEDAT
UprnCntermﬁlictrlRngNrite (UP_DOWN) ;

38. WG AELEES UpDwnCntrPwm_1, WAGUEHAG LR EHRE. R EmL2ER AR CriReg, N

i FHEE I 2R AR B o B ) 29 A7 2% TR AE .cyudb SCHET,  SRINAE TT LA R AR AR 3 270228 APL ,
25 28 TR
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39. WA AL,

AR 55— AR 350 H 380 BT A R A

40. ¥HEA UpDwnCntrPwm ZEL 4 i i 3 55 5 J5 2 &

A1, KNI B ERERRZ AN ‘clock’ &K, FOEE IR E N 10 kHz.

42. BB AHU s S AR Y BT E i A & (B PO_0_clk. PO_1_tc 1 PO_2 cmp) , Il 64 iR,

K 64. IE/E T EER HT PWM T H R A

UpDwnCntrPwm
UpDwnCntrPw
Clock_2[fm} clock TC -] PO_1_tc
10 kHz cmp o] PO_2_cmp
—oo] PO_0_clk

43, #KkitF File > Save All,
44. YT H JExT PSoC AT TE .
BB S 5. period. Count_Mode 73 %I E A 4. 9 F1 Count_down. 7E—AN/RIEEEFME clk. cmp Al TC K.
EATLLE WE BRI 8L, FOAE RIS, TCANSEE, cmp 278 81K, W 65 Fix.
K 65. T PWM %

ITC:

@ 200V & © :nurx )[nvovpssosooous][?b?m)siﬁs][ 7 200V

T LR L3R 1] 5. PWM o= Bl b (7735 58 R A B 2 4. BT DU SO 24, 8 PWM AT 3 08 T Ao A2 i
A

45, R[EHH KRR, 303 UpDwnCntrPwm 2484 BAFT I & 1 SHEHE

46. ¥ Count_Mode % &4 ‘CountUp’ , il 66 A,
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& 66. ¥ PWM ¥ & Ay 114

Mare: UpDrwnCrtrPyrn_1

/ Basicl’ Built-in a4k

Parameter Walle
Compare_Yalue | 4
Count Up
Counter_Period | 9

Farameter Information
Count_Mode: [Mo description available]
Value: [Court Up)

Type: UpDwnChnttPwm_UpLiwn

e = s

47. Hii OK, NAFEKHNE.
48. k¥kRik#E File > Save All, ZwiEWiH, 4% PSoC.
BTWEE, XR— NS, RO EEER ISR, TC RIS ecmp AR, WK 67 Fix.

67. I PWM EE

TC

2.00V & @ 2.00V 2.00V ngov}iszg‘t.ooo sl?b‘:(omosiaslsl o 7 200V
THER, TC Ja, tHEUEMCT tEUE, It T -, Ruthdi s, WIE NSt Zoiant, 8B K T L BdE,
FEREATE TR Dt AR
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PSoC®3. PSoC 4 1 PSoC 5LP — {§i ] UDB % %% PSoC Creator™ 244 14T %11

WiH 3 - &8 UART

PRI R T —ME A EE B AR I B TX UART. AT A& Ae @A — A PR, AR
PATEA R B T H A B 4R UDB g4 3o A2 2 L5 7l (¥ Simple_Tx i H A13-4% “ Simple_Tx” 411}
AR A P A LA B — A= B e S AR R B AR XA, JFALT “SimpleTx” TH .

TX UART AHKHEYHE R

AP HER AR . AR FO T AIME INE 3] A0 P BRI AR R 1E .
ALU Hir o b BA —ANF0ids, Wl 68 Fiax.

68. FE 7 AR

isrca srch
cmshi — cmsbo
cfho - Alu cfbi
oo_msh-1
GO_MEh - o
co_msh_req -
sol_mshb sir
snl_msb_teq Shift sor_reg
il sor
WSk e amask
oull [
cmsi

AL B A LARAT ) A2 B A B A . B B8 AR AN 48 S S S W B R A BRI 1E . ERENIE S Configure
Instruction XFiEHEFR BB 1ZET, Wk 69 Fiaw.

K 69. B i E

Comment:

Functior:
Shift:

ALU_out

Option O:

Option 1:

Configure Instruction (3'b011)

AL operation

Shift data out

Register writes

(A0 =ALUou

[shift Config s > 110) +]  [MNoop

Shift Config &: [
Shift Config B: [>> 1110

No-op ‘

Compare options

AD compare ta DO

Config &: AD compare to D1

QK

Cancel

l
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T 3 E Config A fll Config B HIlCE , %%\ Datapath properties (B2 M) , JFACE Shift configuration
A Fl1 Shift configuration B; %% W& 70,

70. HdE AR RS A L B

D atapath properties
El Shift common configuraton

Shift cut Right
Default zhift in 1]
B Shift configuration A

Shift direction Shift right T

Shift in zource Drefault ghift-in
= Shift configuraton B
Shift direction Shift right

Shift in zource Drefault shift-in

MALIA AT L2 DSI A (SD 55, BE e A RMEIME (0. 1 .

Datapath it E A2 LCE— M (SO Hathi. A#H (Shift Out Right) A H (Shift Out Left) FL[FEIEH
ZHn . 18 Shift common configuration § (Shift Out) ECE#FZE M, WK 70 ffix.

TEZoRBh, QIERASHUH T HI40E #2108 4 . 7E UDB PLD HSeBliZREHL. EHiE T UART f&4if ZHET I
—HBsr. WE. B3 HdEeiFit.

WAEHLOCH PIFRES, Tt S st An B . DUk, B 4% 5 258 AT DU hURs 38 £
*® 6. Hln A2 E 2ol 3

RA INSTR_ADDR ek SHIFT HHREN
IDLE_STOP 000 TeefE 7 ’
STOP 001 TotAE . .
TX_START 010 T x A0 =FO
TX_DATA 011 T fAE SR A0 = ALU

AN ZLRENLA RS, B 7 BB AR 4R o XA S SUR ¥ ik .

JUF-FrAT 5225 B e B AR 2L A1 7 S — SRS LR E PP B B i . 1 71 SR K2 fag i TXORESHLIn T T
(=
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K 71. TX UART RSP AL E

IEnable || fifoEmpty
TN DP: INSTR 000: IDLE
Y TX Pin: High

RN 000 -
_— IDECESIOR Enable && lfifoEmpty
/ AN
DP! INSTR 010: LOAD A0 from FO
|
DP: INSTR 001: IDLE
TX Pin: High
001 bitCnt == 7 && 010
STOP ITWO_STOP_BITS TX_START
{
\ /‘
N /
bitCnt==7 && S
TWO_STOP BITS_ 011 - ’
TX_DATA

DP: INSTR 011: Shift AO

\ TX Pin: Shifter
bitCnt ! =7

e, R fifoEmpty R, REVUREAPHBIEESAZ] FIFO W. —H FIFO s, MaREUR it
NEFPRES, IFEd s TX LR E AR KIE— START Gi24R) 7. fEXFRRE T, BIRHEE FIFO (FO) FffE

Jn#E A0 Y.

R —REST, BUEBREK A0 T RIBEER LS TX 51 LSB 1t (A1) . AR5, IREHLES KB — A EFHA STOP
o

T UDB 4i%gas, EalLLEHIE 71 bt SRSl BBliziils, FEERSHI TR Rgt,; 52
K 72,

72 RENITER

<unknown>

1'b1

Rz e oz o A PUNMERE BRI AR, FFIEREAT, W 71 PR, B R AORIER RSN, SHB—E
HE, EEEHA-ANRIARX, RRVGERIR AR HZ WA 73,

WWW.CYpress.com R4S 001-89207 fiA *D 42


http://www.cypress.com/

o CYPRESS

> EMBEDDED IN TOMORROW™ PS0C®3. PSoC 4 #ll PSoC 5LP — {#i i UDB ({147 % PSoC Creator ™4 {4471 1

K 73, & TIRIL
Caonfigure Transition @

Espression: Erable s o Empty
M ame Expression
#* 0 Enfarmame ‘Ef:u‘er ANTIAEHOT |

>-:++

Qg ] I Cancel

Enable {5 5 N H T3 H. fifoEmpty A2 & PR, 2RAER 73 AR Z 01 6 RS HLAAT R BIR S
HENBSRA . TR EA, REEHSERN Enable (25 Ba B, 3FHEIERE FIFO AR .
fifoEmpty 155 K B E=AMEEE R L, E2 0 74, FIFO 1A EIEN, ZES BT, FIFO haHIEN, Z%E

5 KA.
P 74, a4
Configure Datapath Cutputs @
Selection: Name:

Dutput 0: [FI] b staus ok full) '] fitaNotFull

Output 1: [FU block. status [empty] ‘] fitoEmpty

Dutput 2 [hitt ot right) -] 50

Output 3: [None ']

Output 4: [Nnne ‘]

Output 5 [None ']

[ QK. l I Cancel ]

TERAORA S, AT LRI &, ot ix ey BT IR A EIRIE H . B, iR UART B\ M8 . XEks,
Him s L AR R (FBA0) RS RN 8 AN i 3 .

% 6 BoRHIHE INSTR_ADDR 5 011b B R AERI# L. B 75 BoR 7 HE=MIRES (011b) MECE RN, WS, £K 75
1) Variable assignment R i, A& bitCnt 54 () Expression bitCnt +1 F7R: FRPUTIZIRA, bitCnt = bitCnt+1.

RSP AR A AHE B AR AE S I B B THY RI84T
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&l 75. RS E

Configure State @
State setiings [T] 15 start state
Marme: TX_DATA StateMachine_1
Encoding: 2B11

Wariable aszignments: Uszed to define varables internal to a state machine that are updated using the given expression when
the state iz entered.

Outbound tranzitions: Defing the priorty order of ranzitions out of this state. |f more than one outbound transition expression is
true, then the higher priority transition will be preferred.

Waniable azzignments: Dizplay oh sheet, Outbound tranzition priority order:
Mame E spression Trangition Expr. State
bitCnt bitCnt+1 bitCnt 1= 7 Te_DATA
* 0 Enfername Enfer exprassion bitCnt == 7 && TWwWO_STOP_BITS 5TOP

bitCht == 7 && I TWO_STOP_BITS IDLE_STOP

)<f+ +| |+

oK || concal |

[ 75 B/RH#E Outbound transition priority order CHUSRFEHOLEINT ) XHGHE . ZXEHE TRCEIRES V). 157E
B, RIEREHL bitCnt AT 7, RSHUK A T H RS . WnliirINH, TEBEING, R A REERFRESR
B RA LA LB b, RFXFRS KT\, bitCnt B gl 2T W IN Pl . B — PP iZRIA
K, bitCnt AZE,

RS HL IR AR P, IF HRMRES ISR AR 71« T 76 o2l 71 5 UDB 4ifids R
YIRS
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K| 76. UDB g 25 IR ASHUAE K

IEnable|[fifoEmpty

IDLE

TxState
2500

Enable&&!fifoEmpty

Second_Stop

TxState
2b01

bitCnt==7 &8

TxState
2b10

bitCnt == 7 && ITWQO_STOP_BITS

BICNT2:0]=3'h0

TxState
2b11

bitCnt=bitCnt+1

BTk, #HEURRARTR S AREN . WK 76 Fix, ARENEFRA TXState, F RSN F LA IRORA, Fril UDB
gAY N TxState Gl —A 2 MIES %K. XA 2 04557 LAB S B8 #4210 INSTR_ADDR 55; 55 L

K77,
77 RSP B AR A
Configure Datapath Inputs @
Selection: E zpression:

Irput O [INSTR_ADDRID] - TuSrate(]]

Input 1: [INSTR_ADDR[] - TuState(1]

Input 2 [INSTR_ADDR(2] - 80

Input 3: [ MNone v ]

Input 4: [ Mane b ]

Input 5: [ Mane - d ]

[ ok l I Cancel ]

BIOR, R EHBAES] TX fidk. Warmng, A8RRE TR h . £RarRE . TX LiE VIR
BT, AR RS AN BRI 2o RZ R BB v T [ 78 s e th Rk sUR R 71X — s

K 78. Tx iR IA

Outputs
bx [TwState ==Data) ¥ S0 1T=5tate[1]]
Mamea Expragmian

WAL THHRIRES, BBl TX & L ‘TxState” 1) msb fiz. 4T HEFIRET, msb v 1, BIHA LN
‘07 o MAEFIEAMRERSET, msb 0, Frilmtioy ‘17 o ARHRIRET, effl SO (i) fF5.
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G IOME AR AN T IR AR S RS T AR R BN 1 1A CPU R IR B B AR RS
K 79. RE TR E

Configure Status Register @I
Register narme: StatusFeqg

E=pression Mode
0 I[fifoEmpty && [T=State == IDLE)) Sticky [clear on read)
1 fifaatFull Sticky [clear on read)
2 1'b0 Sticky [clear on read)
3 10 Sticky [clear on read)
4 1'b0 Sticky [clear on read)
5 1'b0 Sticky [clear on read)
E 1'b0 Sticky [clear on read)
7 1'b0 Sticky [clear on read)

X[ #| |+

[ Ok l l Cancel ]

RS TR — 0K [ CPU 75 UART AT ZAr RS I [A] . 7T LUEE X MR ST, H 2| UART 52K 1%
NIk, B0 FIFO 2B KB . CPU MTUMERIZES, UMERGEIE I3 FIFO F, E2| FIFO N1k,
WA KSR IS TAiZ AN o S0t 8 U RS AR 3 e By 7 —AME 1 AR sl g M3 1B A AR X P %%
Bz, HFHRSTFERSENNHE. AP EER: X ESIRET AR H A8 H ATk AL ITE .
ZIE ARG RE TR AT AL AR, SRFIESAE 0 B 10 Bl WAEFN 9600 A A LSEEL iz E. K
FEUSCBS D B Y 9600 IR AN A5 1R A7 .

5 PSoC Creator —[f] %23 ()& — M AR N HI B2 (BCP) MIFER . A LMEH BCP k#2lk RX #4%. 7£ BCP
o, JEREF COM 3 (TX il E4ERES % ) o 7€ Tools (T.E) > Protocol Configuration (BMUECE) 1,
fii & RX8 (UART) , #n[& 80 fs.

80. BCP RX8 il &

Protocal Configuration =)
sPl_[12c[{RRBTUARTT]
Bitrate (bps): 2,600 v
Drata bits: [8 v]
Farity type: ’ Mong - ]
Stop bit: [Twn vl
Flow zantral: Mare

1E BCP HIZmE 280, WA TLATFSCA: X8 X X X X X X X X X X Xo Mk 5E K COM i LR 11 M5 . R, BafLL
B A Repeat (FEE) 8 RE WS .
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M UDB $ERBEIIBIEBRLRE T A

ABEAAAE— DI EAREREA UDB SR as K SEHLT & 20 Thae. X, & HBERM Verilog SCIFRIEE MR E T
Ho XD OB . LI A PR S A& Verilog SCF, 285 Rl UDB 4 as 4= i) Verilog GRS IAk I 2157
i Verilog XN BUfE, ST DUEE B AR HC B TR Verilog SCIHMEHONE RGN 2. GUEZH1F AN FH £ 42
Fo B TRERG], EZHR A,

/S
1f PSoC n]4mfEiZ i @4l -it, UDB Bl A3 n 7 dit i R ik, B@AE RO UDB Bk %1% Rets
PSoC 3. PSoC 4 fil PSoC 5LP el id & g i ab ¥ 28 Frie i ohfe.

AN 2L R A 4RI 2 s 100 H U B 58 SO RTT R ITT AR . 8T RS 247 SR SR A R e SN 2 A i
PHHIME R, 1ES 0 PSoC I (HARSHFM) A (A FaI2iRm) Hr WA,
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11.3.

11.4.

11.4.1.

11.4.2.

FRBEIR

RIFI%E

e AN54181 — PSoC 3 A[]

e AN79953 — PSoC 4 AT

e AN77759 — PSoC 5 Al

e AN81623 — PSoC 3 1 PSoC 5 [ v it e s ik

e ANB2250 — sLIl PSoC 3. PSoC 4 fll PSoC 5 [ m 4wt B4 & it

HIRPESCE

o KBAB86838 — ¥t R e & L H 4

e KBAB86336 — [fii[i] PSoC #efff Verilog it B+

o KBAB86338 — fill#HE T Verilog (120 1F

o KBA81772 — ||l H Hrifs 4 {2k 7t/ Verilog 414

o HTEIEMAMH Verilog MEHEIEARE TEMATIEER

BARSZEFM (TRM)

e PSoC 3% TRM
e PSoC5LP %4 TRM
e PSoC 4 %) TRM

L

PL R A5 44 T PSoC Creator il Verilog 44 (1) 61 i i 7 «
EEPR

o AIEB AT

e {7 Verilog Implementation (Verilog 231D
HApa e

e PSoC Creator 113: &7 PLD (] Verilog 2014

e PSoC Creator 210: #¥i B AL 1F I/

e PSoC Creator 211: g2t 5

e PSoC Creator 212: ##i#%1% FIFO

e PSoC Creator 213: £ i dli B2 4144

e  PSoC Creator 214: i 415 API Ak

e PSoC Creator (f%#: f{iH UDB %#H#s — 55 —#57r
e PSoC Creator #(f%: fiiH] UDB %% a5 — 25 —Hl/>
e PSoC Creator (f#: {{iH UDB %%f 2% — 5 =¥k
e PSoC Creator Z(f%#: {1/ UDB %%k a5 — 55 VUHE I
e PSoC Creator #(f%: fiiH] UDB %% a5 — 25 TLHB /)
e PSoC Creator #f: {#H] UDB i’ # — SE/5¥5r
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12 RTAEE

P4 Todd Dust

IR %% IS FH TR

o Todd EeMb FPEHEEURTER%, HRMRA TR %0 G, fh— B eSS h i 38 H
CREIM R AR

4 Greg Reynolds

5 Greg Reynolds +Z FRIEFE L R i —HHTZ M.
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1311

fits% A — 1 F B g i B T R

TE PSoC HRMEMIRUF ik — RAEFEAN WS . AMAHZILHEE T HARGITE, T4 anfa 3 2o
PEARTC B T RO 7S AN T RO 42 10 T S 2L

o BALEAIRIIHAE

e 8fiPWM

e 16 £ PWM

o BRI PWM

o HAF TX KB UART

o TR R

A LAEEFT A PSoC 3. PSoC 4 8t PSoC 5LP #s EAT A Z R BIT H o 58 A7 DAFEZEE 10 WX ol p A B 2830 10 ol
T B AR TR R R B .

BiH 1 — 8 ALt 2%

205 F ) B R A AR 00— AT MO R I AL R D BR. B0, BRI 8 BRI BCas AL,
SRR N 8 B PWM,

8 i T B0 58 411 1 % 1

A THT LA LA A RAS R A B R — A 408, W) 81 . ASCHR i e o L TR SRR
A AR e

81. fi] it Aas RS K

1= : \
Count!=0 [ Decrement ‘\

\ Count

Count==0

Count!=0

Reload

Count Count==0

FﬁJJF, THEES VTR A R SIS, R RASEAN S, R E B . AR AR T DU S R T4

BRI

A FREMHMA CFGRAM % H (B4 KELIIZIEE . A5 B H TR 64 E A TS H 1t
B . HoAFEHEHVAME. BRSNS CFGRAM 4 H A ZAEH .

o8 A F AN SO 45 A AT 28

o A0 — frfFIHEE, JFH i ALU .

o DO — TRAETHEE Jy 0 3 A F] AO N IME .
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BREFATTERIE LI NI E (84 B0 ERsGER. [ 81 Bor it B bl PR H,  BIAIWit
R T NE.

HEps e — A FRM B (ZDET) , AT K A0 Fl AL FBHEME. ZEA MM E 20 (A0 == 0) il z1
(A1==0) , 73R A0 1 AL HPIRZS . BUE WS, AR s 2B ARZ N, AR A4 oMK

FEZoR B, A 0 frth £ FFACE . CFGRAM HIFAERREE 3 2. W LURAL 0 T 20, JRRHEM R NIK. & 7

T E
K7, V1HERG 1
CFGRAM HihkAr
CFGRAM EL B BE
2 |1 0
0 0 |0]|z0=0 IR A
1 0 0| z0=1 ERITEUE
2-7 X | X X Sefdi

AO HHHITHEE N O, 20 &N ‘17 o XA, PR E MDY CHEBIIEE” o 2 DO K BUE FEEEF] AO
i, 207 ‘07, N ANECERSY RO EUE” .

AT T RS KRR T a, EEE IR RN SAIER, WK 82 fix.
82. e o A ] H - H 2 1

CS[—ZACE)]DRAA CFGRAM |

. >

. !

N

DO
(Reload Value)

¥
A0
'_>| (Count Value] 4{ Al

Y
A0, A1,
AO, A1 DO, D1
Pl—— t—”’o L
/
ALU
(Decrement AQ)
1
—__2
71 ZDET | ‘ CMPO ‘
‘ FFEDET ‘ ‘ CMP1 ‘

CS_ADDR =000 (Decrement Count)
CS_ADDR = 001 (Reload Count from DO)
Z0=CS_ADDR Isb
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13.1.2 S8 fuiEABmAMMAI RS E

LA BLA ) PSoC Creator Wi H . JF [l %50 H I INHT AL R AR1T0, AERXAIREIH, R —SERIHE .

1. J5%) PSoC Creator 3G 4 F Ny “AN82156_Appendix” K H, #& 83 ik,
X 4 BRI 2

“AN82156_Appendix” LAF

P 83. i i H

Mewr Project @
Design } COkher q b
= Empty Templates o

J Empty PSolC 3 Design

J Empty PSoC 4 Design

J Empty PSoC 5LP Design
=l PSal 3 Starter Designs

Pal ADC_DMA_VDAC

Pa] DelSig_16Channel

Creates a PSolC 3, 8 bit, design project
Creates @ PSoC 4, 32 bit, desian project. 3
Creates a PSoC 5LP, 32 hit, design project

Shows how to transfer data from an ADClo a
DAL using Db, with no CPU intervention

Shows a 16-channel, 12-bit Delta Sigma
ADC in PSoC 3 sequenced in hardware;
samples are transferred from ADC to SRAM

uzing DA - without processor intervention.
Shows the 16-bit differential 4DC. hardware

E‘ DelSig_12CM multiplexed into & channels and transpaorted
over |20
Shows the 16-bit differential ADC. hardware
E‘ DelSig_12C5 mu\t\p‘nleﬁad into & channels and transported
oyl
Mame: ANB2156_Appendis
Location: C:\MyProjects\ANE2156 E
Advanced

[ oK [ [ concel |

BN A E PSoC Creator FEUTH 1o T XM FEMAN 5 388 BT IARMEALPF B, 15 0 EATIEHEE— 4
Mo

2. FETAEXNWEH Source ik, 44 it Workspace ‘AN82156_Appendix’, I M 7R 1) Rz 32 8 rp Rk
%4 Add > New Project....

3. I&#% Other IR, /R PSoC EEMMR, W& 84 FiR. ey “AN82156_Appendix_Lib ”, F{f Fle iR
ML XEE, i%E5 AN82156_Appendix TAE X KAz 148 [F AL &

84. ININHTE

Add Mew Project

(e =

Diesign** Other qp
=] Empty Templates
= . Creates a Library project to create C libraries and/or
__J]J PSoC Library S A——
Mame: AMB2156_Appendis_Lib
\ametar CAM pProjects AN BZ1SERANEZ156_Appends D
[] Dependency of | ANE156_Appendis
Advanced

ak l l Cancel
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BUE, BTPER BoRfE TARXRIBEEE N o $2 R, WRAZPERER B RBITH , B A] 2 P vh B 4L
IRJE, S BT P I — ST LA

4. V3| Workspace Explorer H1[) Components &I+, #4541 AN82156_Appendix_Lib. M FHZEHEAF, ik
# Add Component Item...J5i, & 85 ffx.

P 85. s InZAET

|Worl:spnace Explorer 1 x|
[ “workspace 'BNE215E (2 Projects) 9
=-Pa] Project "AN82156" [CY8C3866AX1-040] o
=% TopDesign s
@ TopDesign.cysch \n% I
1| Project “ANBOEE Librant n
Add Component Item.., | 5
g
Ij Import Component... § |
3
lndate Cnminnnents (

5. &+ Symbol Wizard AR, FE¥ B 48 “SimpleCntr8_vl_ 0”7, 415 86 fiis.
K 86. ff 4510

Add Component Trem @
=l Symbol -
| Empty Symbol Createz a blank symbal. ‘E ‘

I=| Implemertation

8] Schematic Creates a blank schematic.

B Schematic Macro Creates a blank Schematic Macro

@ Creates a new file to add/configure UDB

1? UDE document clemants, i
Target

Generc: Device
Architecture; Item name: SimpleCntrg_v,
Farnily: Component name: SimpleCnti8_
Device: Diestination: AMEZ1EE
[ Create Mew '] I Cancel ]

HAF LR SO ERAR S . ¥ “_vX_ Y7 BREMIMBAEL4FR, Hf, X RRTEEAR., Y EBHRKE
WA . PSoC Creator B A RRAIE#IThRE, B E A LR B A8 A ALF 2 A KA.

6. Hiii Create New %4, LUAshAMRTSHS.
12 W SR S SURNAN ST, AR5 X e E ok B AN 5 .
7. f& Terminal Name B mmi &, B “clk” AR “tc” Hth, &l 87 Fivx.
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K 87. s inda A\ Fgar

Symbol Creation Wizard 7 ==
Terminal name Type Symbol label

ok |Dighalinput
e Digital output | =
[

SimpleCntr8_v1_0_N

SimpleCntr8_v|

ek tela

x| [+][+ Tils cokr

[ oK | [ concel

“clk” FINNBAIEEAAB B, “tc” Hi kS RIS BUE A F A
8. iy “OK” Ja, HERT S g e i th AR B AT 5, W 88 Fin.
K 88. P E BT 5

SimpleCntr8_v1_0_N
SimpleCntr8_v

Hclk tcj=l

SRS, ok’ A1 ‘te” S R REERA S K Eas ENAS SR, B Verilog KE CEATIZEE .
9. fEfFSHEAT, AmEAZN (AR SAL) , REN FHSEHRILESE Properties.
10. fEJRPET BT Symbol &7 i A & IEUE, 40 89 F:

o Doc.APIPrefix = SimpleCntr8.
SAEAE A A AP ST RITT R . AR ZoR Bl AR BUERT APL, (EZ S QIR , T A
A EUE.

o Doc.CatalogPlacement = AN82156_Appendix/Digital/Cntr8.
Wi s L. BT Catalog Placement XEHE, A5 A e N\ i1%{E. PSoC Creator i Fi%fH & LA H %
HIE IR o BB —BURARIETR, IR P RR Hx P dlr. 8- NME8mryfn—1HS. 44 H
SRR RGBS —AT Hako REPURHEER R ZAMNE ‘Cntr8” , E&EIRfE AN82156_Appendix
IR TR ‘Digital” FHZEW .

o Doc.DefaultinstanceName = SimpleCntr8.
T A T DR B R B BRI BRI B RR o N AR PR T R B S T LME O A R
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11. #1447 “Save All”

TR

12. fEFFSgmEasuh, AEpdsaasn, REIEE FRERTH Generate Verilog i,
13. {R¥F¥ Generate Verilog X iHHEHFIFT A BINEE, )58 Generate; 5 LK 91.

IR =
, BT

Kl 89. IINFT = Jw itk

Properties @
Doc. CunrentU ger tdu -
Do Filename CAMuProjectz ' aM 327 56N 321
Do, Lazthd odifiedBy tdu
[oc. Lasthodified0n 04/05/2014 16:36:34

EH Symbol
Doz APIPrefis SimpleCrti -
Do, CatalogPlacement [Collection] [
Doc. CataloghizibilityE spressio true
Doc.DefaullnstanceMame  SimpleCntid !
Doz ExternalComponent Falze 3
Droc. SembolSummary
Doc SymbolfisblelnCatalog  True
Doc.URL 5
Doc.CatalogPlacement
QK ] l Cancel

B’ 90. [ R B AL

Workspace Explarer (2 projects)

@ @

B "workspace '‘aM32156_aAppendis' [2 Projects)
=Pz Project 'ANB2156_Appendix’ [CY8C38564-1-040]

EIQ TopDesion

=[] *Project ENB215
=My R

----- |¢] SimpleCrttd_w1_0.cpsym

TR B R AT 5 R B — N R AR RSB

(Ctrl+Shift+S) #4E, BfrfrsE 17000 H BT ITA E el FATS 22" 7E Workspace
Explorer # Components #Ti-E ) AN82156_Appendix_Lib T, & 90 Fizr.

anog

sjuauodwo]
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K 91. Generate Verilog XF 15 HE
Generate Werilog @
Itern Mame SimpleCntrs w1 D
Destination AMB2156_Library
Target
Generic Device
[ Gererate ] ’ Cancel ]
14. PAT “Save All”  (EFRAE) BAE, HIROAE T X E BT A ok, X0, HAER—AHM Verilog SCAF,
I HAZ SR I A
Verilog X fFf4 7 Datapath #1S2ELLL K T2 #1% Datapath (1174 Verilog {35, =% C A4 T #r4lft Verilog
SCHERIR . ARSI I S AR S, VE A BB E LA
15. JABhER AR E T A
16. FMi#| Tools > Datapath Config Tool...., I FiR#/E. A DL Start 358 )8 2130 AR E TR (KK
1+ Start > All Programs > Cypress > PSoC Creator 3.x > Component Development Kit > Datapath
Configuration Tool) .
17. TEHRMAIRE T RS, K% File > Open, ZRJE3 %3 PSoC Creator 42 i) SimpleCntr8_v1_0.v S AT

FERIAL B ot R AL IR %R ] (&P R AT B4R, SR T ANB2156_Appendix T A X 3T & H

ANB82156_Appendix_Lib T B X3, Wikl 92 fis.

&l 92. 414 Verilog 371

% Open Verilog File

@\;_/'.4 « AN32156_Appendix.. » SimpleCntrd_vi_)

Organize v New folder

. MNarne
0 Favorites

B Desktop
& Downloads

] SimpleCntré_l 0w

=l Recent Places |=
(® Google Drive

i Libraries
& Documents
o Music
&) Pictures
5 Subversion

B8 videos

(==
= [3 |[ Search SimpleCntrg w10 2|
E- 0 @

Date modified Type

4/9/2014 400 Ph W File

- 4

File name:

T

r

« | Verilog Files (*) b

18. L%, ARG ol Open In#k Verilog XC1F 8 8dE 42 T A .

S PR BT RO B R AR O B

19. MR KRG Edit > New Datapath, 77T New Datapath X iEHEE O

20. £ Instance Name SCAMEH, FAN—ALFIAHK (EH “ontr8 7 ) , RJFIEFF “Instance Type” (SEBIZEA)
A cy_psoc3_dp8, il 93 A, £ OK.
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Pl 93. B 8 fr Hodhs i A2 S 4]

’New Datapath EI@

Instance Mame

chird
Instance Type
| oy_psocd_dp () cy_psoc3_dp2d
@ cy_psoc3_dpd (") cy_psoc3_dp3Z
1 cy_psoc3_dplb

[ Ok ][ Cancel ]

XA 8 i, P BRI E AR 8 A (cy_psoc3_dp8) . H e sl B s £ K/ NEiT 8
R FIZEAE
21. WK KL File > Save, 1] LUKC B {#7E3 Verilog S0t
B AR ERCE RN, BB AN B T B S26i4k Verilog ST I BIEBRAZRSE K, Ikt C Fon. @B HOZEEE ,
Al ABAT I B sh e
22. i%# Reg0 Al Regl 7B HiME, DIECEFIEHA, WK 94 Fix. HETBAT AR BN E .
23. Reg0 MR E SHEE 0 5354 0 (WAHF, Regl MXEBE SHE 18454 1 KA.
| 94. SimpleCntr8 411t &

Configuratior; [n::ntrE_a (2] ']

creRen Conifg 000 Decrement| | AO | |Using ALU|
Reset Hig/mnaryvame FLINII/ SFH::/ SRCBE S\HTRT\‘ ’;‘E‘EJH
|| e 01000000 1 01000000 | DEC PASS ALLI

:] Regl | 00000000 | 10000000 | PASS Do PASS DO

[:] Flen? TTROOO0O0 | 00000000 | P2 ss\ Al \DIII E&S’S/v MOME
F Conlfg 001 Oooonoon | B Pass into A0 From DO MOME

[:] Regd | D0D0DO0D | 00000000 | P&SS A0 Do PASS MONE

* 8. — MR AR IC B

FUNC SRCA SRCB SHIFT A0 WR SRC

DEC A0 DO PASS ALU
PASS A0 DO PASS DO

24. Reg0 Ffl Regl 73R /RAFAHTE CFGRAM H 8 MRS BE B F AT ANIC R - Be B 1028 — A5 F T3 iso - 4Es
HIAHTFEREE
TS HIWILA1E )9 A0 FI DO 2 /E 8 M. HTid CPU AT LLiJ ] Ax Fl Dx 27/%as, PRILAT UM A main.c S
ARSI EIX S E . EIITE Verilog ST E SCERIA BTG E 7] DL B R RIX s 2 788 4 . Bl s fe TR AL
SEI R AR

25. {RIRi%LFE View > Initial Register Values, 374724 {H X IHHE o
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26.

28.

20.

30.

31.

32.

33.
34.

35.

7Ji% a0_init_a F1 dO_init_a S5UMIENE . @it %P MERE RSN 15 @ GRIGEMERE, Wi 95 Fin.
| 95. SimpleCntr8 [I4] 44 %5 17 234

Initial Register Walues E\@
Datapath cntr8 (8)
DF " _a"
all ini_a: 15
al_init_a: =
dil_ini_a: 19
d1_irit_a: O]
Ok ] [ Cancel ]

- BRESERUE, R OK.

TEIXFIE BT, DO A A0 HIMERAHE (¥, B AT UG RIAR 00 T BB S H gk ) A0 . i RIS T — kT4
FIES R R BRI R, iEEHAEUE . ERIBOUN, WEURIE Y 16, FONTHEUT SR 15 2] 0 1.
MEEHR R IRIERE File > Save, fRIFXT Verilog SCHFT T E L. XPAIEIR AL E TR, 3H&EH PSoC
Creator F1/f] Counter_8bit_v1_0.v {4

EARTE T SO E G, BB AENE T HKXT Verilog STHFHHTEM. 4RI, PSoC Creator A]fE2rEk
5 B %% Verilog 1.

XK, mEAE Verilog SCHF, IXFERT LG R EE KT 5 B 280 I 12 4R . FTRBIMAIE ST LA Verilog SCARH
17 77 FFid.

¥ .clk (1'00) BN . clk (clk) o ATLUKEIR AN BB S0 ok’ &Kol M HIZLmE B EATN T
1EHE

.20 (), 5K .20 (tc) » XEERTLMERIELL (ZDET) [ z0 MHEHBIMFESM ¢ L. BEE,
23 [ W ZO i A .

#.cs_addr (3'b0) LAHKCHN .cs_addr ({2'b00, tc}) . XFEAT LK CFGRAM bk (5 A B i A 2 B0 BN
‘07, KA 0EEN tc RINE.

WA, to A& 20 M. B, z0 SPERMHNEE; HS0E 7,

TRAFRT Verilog ST T A B . Btk C R T W R A W B LR T T 581 Verilog A5 .

PUAE, JEA] LAE %A, AEH Y “Component Catalog” T & FZAMERT, FELE AN82156_Library Jyiii
HARIC R .

7f Source EWi£, 4% & Project ‘AN82156_Appendix’ , Jfi%t#% Dependencies.... #IIHTH
AN82156_Appendix_Lib, ¥ E ¥ E N AN82156 T H i FHk#i o< R — AAAMFIERNE, WK 96 iR,
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Kl 96. ¥R AN MyLibrary J44 2 1% B NI H KRG &R
Dependencies

Dependencies ]/Build Order ]/Bootloader ]

Frojects  [ANB2156_Appendis x|

System Dependencies

Project Components Code

CyComponent_ibrary
CyPrimitives
Uszer Dependencies X |+ E]
Project Components Code
CytnnatationLibrary 0
CyFieferencelibrary =
ANB2156_Appendix_Lib : ]|

[ oK ] I Cancel ]

IAE, 7E AN82156_Appendix kWi~ FIZHA4 H T, FIAE#1 AN82156_Appendix_Lib 444, 41¥ 97 Fis.

36.
37.
38.
39.

40.

K 97. H 3 st

AMB2156_Appendix | Cypress | OFf-Chip 4 #

AMB25E6 Apoends Component Catalo
=-%& Digital
L. @] Cntd [v1.0]

f£ Component Catalog T #EF B4, 0T LURZA M EAL B E b Z ARG L 5 e AP RIARTA .
N T IRZEA, AN — DA S e’ it B AL
H Cntr8 A1 CE AT H IR

RN B R ke &, TR HR I E Y 10 kHz. T CME RS T/EMZER, (HEE RS ES T M
10 kHz i,

%Igi&?ﬁﬁ FUHAMERES ok’ LR, WMITERBEHE DB E. Kemaly PO_0_ck, FORFFH LB
UNa-

VER: X1 PSoC 4, EARRFEN B B H i th 2 51 . ARG IS B el 251, B HEAT TR

W He i S AL OB R T JE R

TE 5| 52 ] 28 ik #E Clocking IETH .

% Out Clock: %4 External.

IR\l Pins &I, JFE 2] Output FIEII-R,

7£ Output Mode: Fi%# Clock.

Fid “OK” .

FG e S 5 RS 5 A -1 out_clk &3

-~ o 2 o0 o p

Q@
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AL R AT S A MRERR] ‘to’ Zm. Fedrdy PO_L_te, JRRAFHANBOARE . HEUE NER, %51
B umEEr . K 98 RO e B I H SR

P 98. iy s it-Heas i 5 H IR EE K

SimpleCntr8_1
SimpleCntr8_v

Clock_1 [} clock TC PO_1_tc

10 kHz

PO_0_clk

42. 7& cydwr [f) Pins i&T5-R N, 4GS 2 FRGEA15BC4s PO[O]A! PO[1].
43. BULE, HERTLAYR BRI H JR4nfE PSoC. #& AT LAYES| I PO[O]F PO[L] bW 5 i i N 28 ity 1144
44, fRETH, HIFE IR PSoC.
45. WHCEOR B ARE R R S, AT DO ‘clock” A1 ‘te” ik, ik 99 FR.
99. T BRI 3% (1 H

U t i
*

Ltrenc -FVEE e LT EL L T TS
Chil 1.00V  [@i¥ 1.00v M| A Chl 7 1.02V

46. KHEfME 15 B A0 A, BRI EUR N 16 (AN 15 3t 42 00 M. AOME A O,  ‘tc” SIITE
—AN RPN AL TR, RUONBERE, AO KrEE#K DO HIME. AOMEARERS, ‘tc” JMRF-F, JfHACE FHX b
A0,

TR SE BT B — N T B R AR AL, T AR5 2 S AR TS
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13.1.3 Kt B3N PWM
PWM J&—EBA LB IhAs A4 2s. N THIm PWM, BB FHEANTEE A0 hEIE 5 5B —ANF B E 317 .
AT LM ] D1 A A7 2 (RA7 8 el , it B bR ok A A0 &5 /N T D1.

] PLE B 100 /N SR KHE R & F %07 1
P 100. N B A 16 5 PWM HE

CS_ADDR
02:0] — CFGRAM
— FO - > F1 -
Y Y
DO D1
(Reload Value) (Compare)
Yy \ A

A

AO ¢
(Count Value, 4{ Al [

PI
—i \R vYY
\ / A0, Al,
Ayl DO, D1

Pl—] {— »PO
\ y

/

ALU
(Decrement A0)

___®
2 ZDET CMPO
cel
FFDET *.1| cCwmP1

CS_ADDR = 000 (Decrement Count)
CS_ADDR =001 (Reload Count from DO)

Z0=CS_ADDR Ish
cll=Compare A0 < D1

EZoRGIF, JAT— PR 8 A BT B AT DUN—N S ARG, R DA SR T T E 3R
A, T B SR AR E S LA O B s AT B L
1. TJF SimpleCntr8_v1_0 A5 C.cysym) 1F,
2. #HfE O, DURIN— ML A . BZse 2 ‘omp’ , IRBEIREER 101 FIRKALE .
K 101. #4 ‘cmp’ AuEHIALES

SimpleCntr8_N
SimpleCntr8_v

[Hclk (¢ sl
cmpi]

Simple PWM
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w

PAT “Save All” (AR HlE, (RAEHTH B

JBENBUEMARCE TR, 4TI SimpleCntr8_v1_0.v Verilog . #dE M2 & T B4 E sh#th Verilog S0,
HRRHIRE N

WHTHEPTE, PWM & — A DI tH s . Bltt, AFEPIADACE, AaEEEIFER A0 THITHEE. X
WA, BRI E TR PR B B R A, A 102 R

K] 102. PWM ff] CFGRAM #; &

Canfiguration: [cntrﬂ_a (2] "]

CFGRAM Conifa 000 Decrement || AN L] ll<inn —
Reset HeAg/MHary Walue FLINI:/ SFHC.V SRCE EmT\ égyﬂ

| | Rego 01000000 | 01000000 PASS AL

Regl | 00000000 | 10000000 PASS Al Do P&55 oo
% Fl:§2\ﬁﬂﬂﬂﬂﬂﬂﬂ | 00000000 | Pa SS\ Al \DD BNE’S/' MNOME
:] g C.onifao 001 | pooooonn | Bd PAsS< intn AD From DO MOME
:] Feqgd | 00000000 | 00000000 | PASS A0 Do PasSs MOME
TR IN(AC < D) M. it 1 B A e B v DS 38 .
5. ff CMP SELA & #’y “A0_D1” , JFECELLHINEE, M2 /] A0 Fl D1 #EAT LA, Wi 103 .
K1 103. Lheith 1 R E

CFG13-12

- CMP CMP q
Reset  Binary Value SELB SELA Cl SELB Cl SELA g

[ ] ooto0000 1 oooooooo A1 ARITH  |ARITH  |D

A1_D1
ATAD
CFG15-14
| A_AD
s i —y S e

THIER, A0 FI DO RN R T BUE M E 4 A . EREEREIAN ELBUER NS D1 FAE8 N
M BRI % $E View > Initial Register Values, FTIF3HEHER .
erfr d1_init_a FILEHE.
fREF ‘a0’ A1 ‘d0’ MUME N 15, IXFE, THEUEIIHEET 16 SETehEHA.
¥odl RMEREN 7. XFE, MK 7, W 104 Fios.
Bl 104. ¥14h PWM 251785 {H

© ® N o

Initial Register Walues EI@
Datapath cntr8 (8)
DF"_a"
al_init_a: 15
al_init_ar [
dl_init_a: 15
di_init_a: 7
[ QK l l Cancel ]

10. widy OK, DAGRAF 57747 a5 p B i B A fE -
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11. RFEXF Verilog XCAEHEAT IR G H k.
Y A0 fH/NT DL {EN, B E. SOvEes T R EAE, @R Verilog U AT LOKAF
5 B A A

12, KMEAREARCE TR, 4T PSoC Creator H(1) Verilog 3C 4.

13. £ output tc FMH, #M output cmp. XFEAEEEIIAMSFSHE ‘cmp’ K.

14. ¥ .c11 () BBCN.c1l (cmp) , BIANHE ‘cmp’ 584 2] Comparel B “/NT7 LIS

15. {#1E5F Verilog MCAEHEAT I BTE B 2L
7E Component Catalog & 11 # AN82156_Appendix &I+ 1R ol A& E PWM AR5 . HA-7ETH REE
B B BT

16. W— A4 s, B EEEE ‘emp’ Kin. BiZSIHa 2N PO_2_cmp , IREEASELLA S PO[2], W
P 105 Fis o

& 105. &2 PWM f 55 H 531 &

SimpleCntr8_1

SimpleCntr8_v
Clock_1[JI} clock TC—— —+{m PO_1_tc
10 kHz cmp P0_2_cmp
>{oo] PO_0_clk

17. BUfE, 180T LIgR I H HF 9w 2 PSoC. W LAZES| 1 PO[O]FN PO[1]_E M 824t M & imit ¥, 78 PO[2] LAl W52 PWM
.

18. fRFUIH, #wiFE I PSoC.

19. MR FEA RIS EREEM LS, B LIWE ‘cock’ . ‘tc’ A ‘cmp’ . B 106 BoRHIE ‘clk’
‘cmp’ 5%,

106. f& #.1 PWM i

S ——

U

_- cmp | - T
Clk .............................................

chil T.00V (& 1.00v M A Ch1 \ 20.0mV

Wil 15 InEkE A0 A1 DO Y, DRI THEE B 56 Bl 16 NHBp . 1K DL &N 7, BTl A /N T 7
i, ‘emp’ SIEERE Y. T BUBM B DL T EAEME, X PWM BEAT IR
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13.1.4 #HmmsH
i BEHCEA HA S Hor, Bk Verilog ARESEATTE. H4h, AFHEMAPIAD PWM A THEUR A ELEUE A A H]

W, PREANTAREE? 5 LF A R R A AR DT sOMIE, i AR AR P T i B S 4.

=

w N

T ZAM TS MBS T Ceysym) , FAGEEASME.
MR s ik Symbol Parameters .
A SHTIETN, MRS

o 4% = Compare_Value

o A = uint8

o fH=8
EE AN Misc W BFBd, ¥ Hardware FrEEN “True” , WK 107 Fis.

XRER] LUK S BT Verilog, Kt UDB fifi {4 v] LS A& .
E 107. #in— AN A S5

Pararmeters Definition @
Mame Tupe o lﬂ, |
Cy_MINOR_YERSIOM shing “=Gething B Misc
Cv_REMOVE bool alse Categary  Mise
Check Rar True
Cv_SUPPRESS_API_GEN |boal false Descriptior
C_VERSION sling “Gethark| | | Displaynt Fake
3 True =]
INSTAMCE_MAME shing “=GetShorl Fead Only False
» Cormpars_Yalue Lints i} Tab Biasic
| 4 Walidatars 0V alidator
* - | isble  Tne
< | [ r
~._Formals | Locals 4 b
MName: Compare_alue Hardware
{,l;f:‘;_uéms |5 the Parameter passed as
B Werilog DefParam?

=l

5. FEENIBIZE M HLAMEE KN —47, BN 7 — NS

6.

o %% = Counter_Period

o %A = uint8

o fH=15

EE AN Misc W BB, ¥4 Hardware FrEBN “True” , WK 108 Fir.
B 108. W0 55— AN B LA 25

Pararneters Definition @
Mame Type o 4l |
Cy_MINOR_YERSIOM shing “=GetMing B Misc
Cv_REMOVE bool false Category Mise
Check Rar True
CY_SUPPRESS_API_GEN |boal false Descriptior

DisplayOnt False

CY_YERSION shiing “Gethark| =
True =l
INSTAMCE_MAME shiing “=GetShor Read Orly False
Compare_Walue Lintd ] L4 Tab Basic
Walidatars  0Validator
3 Counter_Period uint3 15 - Visible Tiue
< | 1 +
~._Formals |. Locals 4 b
Hame: Counter_Period Hardware
{,’;f:é_u{?s |5 the Parameter passed as
B “erilog DefParam?

-
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7. miili OK, JHAT “Save All” 81, (RAFXSIZAAFREAT HIBT A .

BUE, SR ELROI AL T 5 S 8B Verilog 124K .

8. TP Verilog U, KA 25 47 EE 25 4T BT 40T STAR

// Your code goes here

9. EHIT I P RACE LSRR

parameter [7:0] Counter Period
parameter [7:0] Compare Value

8'd0;
8'd0;

10. AFREE 29 17 BOZAT HHIE 2 6 WIAE F A7 A I SRR
cy psoc3 dp8 #(.a0 init a(15), .d0 init a(15),

11, FEATAIRE SO 2 B R i e 1

cy psoc3 dp8 #(.a0 init a(Counter Period), .d0 init a(Counter Period),

.dl_init a(Compare Value),

XA RE AOL DO Al D1 MG A e BERC RIS 5. el R Bl &

AR FER R
PP AS FVAE el Pl R A 26 90 1 B L% S 8
12, DRAFPTH A, g0 00 H H- 402 PSoC.

SR IBOAN LB E S B By 7. DI, AT DRI H JR 2 T N2 0% S 4

13. R HKEFE, R)EWd SimpleCntr8_1 444, LTI B X iEAE .

14, K HBAESON 3, B2y By 10, ik 109 Fios.
K 109. i FHHSH

.dl init a(7),

Compare_Yalue | 3

Configure 'SitnpleCrtrd* , |
Marne: SimpleCntr_1
ey Easicl’ Euilt-in 4
Parameter Walle

Parameter Information

Counter_Period: [Mo description available]
Value:
Type: uintd

Co L=

15. B OK, MAEMHAE.
16. R EEMMANE, WEENH J4mFE PSoC.

SR e s P A AR e B TR SeBl B
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BRI LR e E L A 110 FOR.
K 110. MRIEH SR E PWM i

U .......... ..... :
- cmpl-oo ‘
........................................................ <

Clk ...............................................
chi 100V @@ 1oov M ] A ChT % 1.00V,

THERIIIIN KO 10 AN e ORI KT “10+17 , BUATHEERSE AN 10 36983 0, REAHTEED , K
{679 3. 13 BIMILERERE Y 8 AN i ] JUT A1 R 1t A0 =B k] 300 £ v P~ S

REFE BB R —A uint8, B LU S S MOSATFIME . =TT LI E P s 2 AN AR 26, IR Eins
B B A A S
FLHRBMAGSENEE CBISRER M NERED |, 5% 21 0/& 757,
13.1.5 @k ot
] R AR SR PWM BItERE, 540, @I C RIS PWM 4788, 8 a] AfEi2fT#RE S PWM. 1

n, %5y HMER DO Ml D1 FAFE R ORAF A HIE A LLBUE . A TE T U5 X e 35 4248, AT LA — AN T e LE R A7
kS

1. f£ Components &K F, A% d SimpleCntr8_vl_0, A5 fidi Add Component Item.
2. 7E Add Component Item & 191, 33 APl #4, 285 s APl Header File.
3. ¥ ltem name 2~ SimpleCntr8.h, I/ 111 fizR.

B 111, Akt
Add Component Trem @

=l AP

A 8051 Keil Assembly File Createz an empty 8051 Keil azsembly file.

¢ APICFie Creates an empty AP C File. ‘

n APl Header File Creates an empty AP header file.

A GNLU ARM Assembly File Createz an empty GNU ARM assembly file.

A8 Realfiow ARM Assembly File %%%gia%i?gigﬁgmﬁ: AR

= Mizr S
Target
Generic Device
Architecture; Item name: SimpleCntra.h
Farnily: Companent name: SimpleCnti8_x,
Device: Drestination: - SimpleCr
Create Mew '] I Cancel
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4. i Create New (BUEEHTID o Ak SCAFAIMBIEIILLAE Y
BAE, wRLRMT WEE (DL FEME (DO ME X.

5. fEKICMFE //[VEND OF FILE FUIT, AT IEATE X
#define 'SINSTANCE NAME  Period Reg (*(reg8 *) “SINSTANCE NAME  cntr8 ul_ DO REG )

#define “SINSTANCE NAME  Compare Reg (*(reg8 *) “SINSTANCE NAME ' cntr8 u0 DI REG )

XA SCAVFE B S N ) DO Rl D1 #4745 . cyfitter.h SCHEL & 7 10 H BT 6 -2 1R 1A 75 A7 48 28 X
Heo WERIEPTHEAT IO ERAE SAR 2L h P A I 5 D BRAE, A, EATREFREAE cyfiter.h STIFhlINAr 7 4%

SE X FAERTEA.
WR AR EAE ST IR E R E, RES ABERIGIE 2 AT B 4 a5 42 v SimpleCnitr8_1, 4
IEICAREB I T

SimpleCntr8 1 Period Reg = 0x08;
SimpleCntr8 1 Compare Reg = 0x02;

A 7 A S T A SME A EL A 9008 MI0x02. T 2 A S nfal i il X 2858 IS B, TEZ% A /1 0/ & 151
W, HEESARFASNNITE N ERPnAfCAiS) Hd M T8 a4k . ﬁ?mhimhui%%ﬁ%,
i AT AN IUH T R AT i

13.2 WiH 2-16 fr PWM

oI H A BT BRSO S . B A A ERTMHABE R AN TGS . Bl RES, WA
Zik 32 FiffiThEE. EiZaflh, SRR A A PWM EBITFH— AR E b PWM, BERHEEN 16 A7, fn
& 112 fioR.

K 112. #4450 UDB i 16 f3hfE

PLD ‘—‘ PLD LD H PO [
2c 2c
{8'2F‘1 U sz tﬁ‘IPT‘sJ {e‘ A UDB1 @FT‘J
—+ |(MSB) F1(LSB)
Deapatn Datapath Daaparn Datapath
Chaining Chaining

AR AT E ALU FTA5EAL . B A e DL ROk AHE SR B R B B e, Wl 113 P $5fiifh 2s
TR e A R T R BE R ISR AF AR 5 . 8 02 MR A R WL B A 7T . AR M iRimi A AL
TR R AR A T

K 113, ¥ R R i

CEO CEQi [-———  CE0 CEDi -4— 0
CLD CLOI cLo CLOI — O
CE1 CE1li g——— CE1 CE1i etp— 0
CL1 CL1i fag——— CL1 CL1i lag— O
Z0 Z0i (p———— 20 Z0i — O
Z1 2N f——— 21 Z1i -— 0
FFO FFOi («p———— FFO FFOi -— 0
FF1 uDe1 FF1i fug FF1 UDBO FF1l ag— D
CO_MSBE Cl (g————— CO_MSB Cl -— 0
S0OL_MSB SR (e S0L_MSB 5IR -g— 0
CFBO CFB| «¢——— CFBO CFB| ~a— 0

0 — SIL SOR ——— = SIL SOR

0 —» CMSEBI CMSBQ —— = CMSEI CMSBO

ZoRIBUE O A E TR — DR Blrh A AR S . AR ERTIN A2 16 2 PWM, VS,
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13.2.1 16 iz PWM HA K E1E

16 A7 PWM [WIEARIIEE 55— AN BB 8 i1 PWM (IERIIFEARR . %M nGld, HEUEassism, HH,

BN T HOBE RS, Mo . ANFERSE, AT AR A EE A A BE AL I 16 7 (1 BT R AE .

16 i PWM A48 H B

RT R, H2E—mBIIH PR AES TR, RS, SRR AE B S T — R B AR

1. J33h PSoC Creator, FF§TIFRiI—= M fifE ) AN82156_Appendix TAEX. HLAEXAHBM—AHHH, 34
HAr4 )y “16bitCounter” .
S n] LU R BT TAEX, B2 2B e S IE AR R S AT — U E AR R TAEX . 3 B RIRE 6 AR X nT A4k
K< Z2 0 P

2. {#/H Symbol Wizard ¥ f4 447 N E] AN82156_Appendix_Lib P, & 114 Fizs. Zanflth i 4R
“SimpleCntrl6_v1l_0” .

13.2.2

114, QIEFIFF S

Add Cormponent Ttern [ =3
1l Symbol ~
| Empty Symbal Creates a blank symbal. H

Creates a symbol using a wizard.

El Implementation

@ Schematic
@ Schematic Macro

% UDB documnent

Creates a blank schematic.

Creates a blank Schematic Macro

Creates a new file to add/configure UDB

elemerts. i
Target
[¥] Generic Device
Architecture: | - | Item name: SimpleCntrl 6
Farniily: | - | Component name: SimpleCntr 6_
Device: | v| Drestination: AMBA1EE. ~
E— [oeseton ][ coma ]

3. 158 PWM RGIH S BARRL AR —A ek A . — te FI—A cmp ik, Wi 115 Fios.
K 115. S PWM 8 & s

Symbol Creation Wizard [~ %] [E5m]
Terminal name Type Symbol label
ck Digital input | =
e Digital output |
Digital output |

SimpleCntr16_v1_0_N

SimpleCnir1s |
=k el
cmpia
(%] [+] [+ Til color
o | [ cene
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4. ATFTIEEE T, RIS R

o Doc.APIPrefix = SimpleCntrl6

o Doc.CatalogPlacement = AN82156_Appendix/Digital/Cntr16

o Doc.DefaultinstanceName = SimpleCntrl6

NI A R Verilog SCHE, AREFTE BRARE .

M7 Save All, TRAFFTA L.

JRB) HAEEE AL E TR, FHTITH IR Verilog SCF.

BINHEIR AR E . ZaFTH BB LN “ontrle” . %k “cy_psoc3 dpl6” , & 116 ffim.

K 116. ST H PWM ¥ ¥ 12

© N o U

'I"v.lew Datapath EI@
Inztance Mame
chtrlG
Inztance Type
7 cy_psoc3_dp () cy_psoc3_dp24
71 cy_psoc3_dpB () cy_psoc3_dp3?

@ cy_psocd_dplf

[ (1] 8 H Cancel ]

9. mii OK, fIEFIEMEHE.,

R, A cntrle_a(16)f cntrl6_b(16)F NACE o X PN I AR B AR I BB R N B Verilog SCHEW .
a’ MEBRHTRICE®RAM (LSB) , ‘b’ WMEMHTHREAMM (MSB) .

10. 1R¥E 8 fif PWM /Bl AR X E “ a” Bl H CFGRAM Al CFG13-12 #54y, & 117 F11A 118 Fizw.
& 117. SimpleCntr16 {4t &

Configueatiors [ cnir16_a (16) ']

CFGRAM Config 000 u Decrement Using ALU

Reset Reg ‘}afyv.m FUNC / sn‘cy SACB  SHIFN_ opeh

|F|990 01000000 | 01000000 DEC PASS ALU

| 10000000 | PASS
H] Config 001 ﬁ J Pass into From DO [

® 9. Hn AR e B or i 2

REG | FUNC | SRCA | SRCB | SHIFT | AO WR SRC

000 DEC A0 DO PASS ALU

001 PASS A0 DO PASS DO

Kl 118. theish 1 R HEE

CFG13-12

- CMP CMP q
Reset  Binary Value SELB SELA Cl SELB Cl SELA g

[ ] ooto0000 1 oooooooo A1 ARITH  |ARITH  |D

A1_D1
ATAD
CFG15-14 [AD D1 |
| A_AD
s i —y s i — e
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THER, ALU DIREAILLE BRI B B S 8 AR Bl A USSR BCEERE, T LUR LB B A —FE .
11. fRA7XF Verilog SCAHHEAT 15 250

BT “_b” BEER N PWM [ 8 fir, P DUEHE 0 B BT FIFF R . B s e i B TR AR AR
WENERHE .

12. kK& Edit > Copy Datapath K& Hli% A & .
13. YN ‘entrle_b’ FCE, JFik#k Edit > Paste Datapath il ‘_a’ BlEF ‘ b’ BlH.
14. {RAEXT Verilog SO HEAT I B 25
BB e H ‘_b’ BCEHIXE,
15. ‘ffcntrlé_b’ FREH, ¥ CI_SELAWE N “CHAIN” , Wl 119 Fis. XFERCE R A BT —HdE B A A &S .
] 119. P B #5514

CFG13-12

Reset Einary Value e S, asee csela S

[ Joot0011 1 0oooooon (a1.D1 |ADDT |ARITH  [CHAIN, x| DS

ARITH

REGIS

CFG15-14 ROUTE

| SHIFT (CHAIN |
Deocst  Biman: Wzl Pl gEl Bl MYYh MSE S E1

16. ¥ CHAIN1 A1 CHAINO % &N “CHNED” , WilK 120 fior. XFELK & b4 (ce0. cel. clO. cll. z0. z1.
ffo. ffl) BEEEAE —#E.

K 120. e & Hhs A g

BSEL Chep  CHANFB CHAN1 CHANO  Commert

0 NOCHN MNOCHN  |CHMED NOCHR =

NOCHN
HNED

17. {#4F5F Verilog MCAFREAT OB 2o

L HER BN TFARNOIGE #T—wBl SR 7 e i 5 S HOR I E FMEM U . BUSZRPIE R
T RBERTT TI N A, FT DA T R B 451 S 1

18. #¥Ki%#% View > Initial Register Values.
19. &% DP “_a” fI DP “_b” WE, Wk 121 Fim. ZnflEsie i g, RN aaasing 8 M.
K 121. 16 iz PWM [IHT146 %17 28414

Initial Register Walues EI@
Datapath cntr16 {16)
DF" &' DF" b
al_init_a 8011111111 all_init_b:  8'b00000007
al_init_a O alinitb: ]
d0init_a  8B11111111 d0init_b:  'b0000000
di_init_a 8511111111 d1_init_b:  &'b00000000
[ Ok ] [ Canicel ]

EEE, “ a” BENLSB (RIEEHAD) , M “ b” BE N MSB (EE AL « XE(ER PWM £ T —4
511 AN JE W KRB D 255 B ELEHE
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22.

28.

29.
30.
31.

32.
33.

- ARAEXT Verilog SCHFFATINTE S, HR AR AR E TR
. #TJF SimpleCntr16_v1_0.v Verilog 3 fF.

B, Verilog /A BA WA SRR E . XMW EIERARERAE I, W 16 {7 PWM. TR, &F
BRI EHSNE S, DUAT Verilog 124

TESH 25 4T LEFHER)  #start body' JEMM ELLFAHE:

// Unused Datapath Connections
wire tc 1sb, cmp lsb;

AP EERCRALT 8 2 PWM HIBERE . (BRI ZAME T SRR S i 0 2 Az Se AN 16258 RO e S R A E B
TAPECLHR Chain0 #7 Chainl &IE4E—d, Bl s e s TRA&LR. B0, 20 %t i A Ros s
PIN R AR AO B A7 S i Rk, BREE ‘tc” A ‘cmp’ rEC4A AL, IPREER 22 R TE
ISR TARML . REELL B ARG, (HIRATINEA, Verilog & s &L RUE 5

¥ clk (O WEAN.clk (clk) o

FLz0 OWERN. 20 ({te, tc 1lsb})

CK.c11() ®EAN.cll({cmp, cmp lsb}).

. ¥ .cs_addr (3'b0) WEN.cs_addr ({2'b0, tc}) .
. Mk Save All, TRAFFTH 5.

HAl, R TEmHE .

¥ AN82156_Appendix_Lib # &~ 16bitCounter i H T (& (N 2%

WA BoRE “HM B b, TR TEREE .

H Cntrl6 L1 N 5 HE 1 o

B A A ERR] ok’ &, SRR EEN 1 MHz.

¥ B A BIEERE ek’ . ‘tc’ M ‘emp’ &, K 122 FiR.
Bl 122. faj s 16 2 PWM Ti H JF 2] K

SimpleCntr16_1
SimpleCntr16_

Clock_1 [Tt} clk tc -] PO_1_tc
1MHz cmp——————= [ P0_2_cmp

% PO_0_clk

WY LA Fm LS5, I eEfIra s el its Po[0]. PO[1]F1 PO[2].
REFTE B N2, HRTHE H4FE PSoC.

BT e, R BUZE B E A LB L CART ATl ) 8 7 PWM K182, Wik 123 Frn. TR ENIRE
AR —A 16 HrEE .
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13.2.3

13.3

13.3.1

& 123. i FHY 16 7 PWM %

=T e :
Pl e T :
,,,,,,,,,,,,,,,,,,,,, ‘_
B Clk | RS LR LR EERE
Chil 1.00V |@® 1.00v M | A ChT % 1.00V

sl i e A Ry UM % TR 1 96 BRIk 32 1. KEAE o ) b i /v 21 B SR S F T K I Th g

PSoC 3 ff] 16 SréA k3o

WHTTRTIR, X 16 ML FR T SEAERNT 8 ML A AT —FE. T 1T DA &b B0 35 R 2% 12 27 A7 A 2 8]
WP 25, HETERES NS 8 M F A . MEEANE 16 Mok 5i/EF KM EFAETN, FELEINZZIINT
HIZE

PSoC 3 #1 8051 {7 P AR TR Zr A7 2 T o N 7B X F AR e AT 544, SR et 7 —89:, .
CY_SET REG16. CY_SET REG24. CY_SET REG32. XU S5MHANSE: H—NREFFEERE KT
e, BBoAREEEENE. X AIEATRENITE ZNIT A . ik, U IR SRR B AR I A A S o
5E SR L7 I FE S 2 R R M A AR 2 AAAE T8 AR, S B ( (reg8 *) AR

(* (reg8 *). BIRATIBHEIE KA TR . NiZE_PTRIFBIFE UGN E, DUEX 2.

SEHTHAMIIN, WEAEAIAE Sk SCRE R I E XU CY_SET_REG16 AfiEr . i B BRI -
TiH 3 — @M Em A

R BN 1R R AR A I B B AR AL R SR TR PWM BEACE S, DUEAT IS BOR T . 1RO
I kT AR BTN B AT I P B IS HL

ZonBIRIE CAME TRV R BB PR AR E . AN L gt 7 — e BRI Ad 5 PWM TiH
HEHRFARR
TR ] SRR TR PWM T AR RS . EARSCIUE N B I GE T s, R DUMRES, W 124 R
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124. M R H A RS 1B

Count Dwn = Count Up

Count!=0 Count < X

REG 010
Increment
Count

REG 000
Decrement

Count Count >= X

Count!=0

REG 011
Clear

Count I

REG 001

Reload
. Count
Count==0

WRIEFTIRE S, BRSBTS A0,
1332 HIgRFITE KB
T RN, E T LA B E AR, TR % AT . B AR IR R S T T AR A

1. JHZ) PSoC Creator, HFTHfEH 8 Al HF# K “AN82156_Appendix” TAEX . m LIEXFMINLIKN
“UpDwnCntrPwm” I3 H .

R AT LA AR ) AR X, (R 2o GBS S IEAE A A S5 AT — U A R AR X e A0 R i B G 2R

2. {#if] Symbol Wizard #3520 4- 7 in %) AN82156_Appendix_Lib P, #1125 fiR. Znfld il 4k 4
A “UpDwnCntrPwm_v1 0” .

B 125, NI AE B I — AN S

Count >= X

Add ComponentItern @
=l Symbol -
| Empty Symbal Creates a blank symbal. ‘E ‘

=l Implementation

3.

@ Sohematic
é} Sohematic Macro

@ UDE document

Creates a blank schematic.
Creates a blank Schematic Macrao

Createz a new file to add/configure UDB
elements. 8

UpLrwnChitrPy

Companent name: srkrPrn_v1_0
ANBZ15E

l Create New '] I Cancel ]

[ 8 iz PWM A PIIER—FE, #m—A clk i, tc Fl cmp %, Wikl 126 Fios.
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5
6.
7
8

9.

B 126. )38/ v B S s I & o

Teminal name Type Symbal label

clic Digital input

te Digital output

4444‘

Digital output

UpDwnCntrPwm_v1 0 N
UpDwnCnirPw|
FHelk Ic|
cmp)

]

Tille color

oK | [ cocal

Al R T, RN S R

o Doc.APIPrefix = UpDwnCntrPwm

o Doc.CatalogPlacement = AN82156_Appendix/Digital/UpDwnCntrPwm
o Doc.DefaultinstanceName = UpDwnCntrPwm

EREAHMIVS P PES IS, e TS A BORUEATEIE B H

WEITHE AN, 258 U288,

FBE R RS AR AR U, AT AT 5 S HOIEHE

Bifi ‘Types’ CEAD #AITIHE N, QIEHISHS,

B aN w0 IRESRIN I B E A& UpDwnCntrPwm_UpDwn,

B AEHAZ Enum Set 7B, DIFiE ‘CountDwn’ FlI ‘CountUp’ 53X, Wil 127 iz,
K 127, QIEA S HRET

Type Mames: + x Enum Set:

Mame Walue Dizplay Mame

CountDwn Count Down

Mame: CountUp
Walue:

[ oK | I Cancel

FLi OK 3R [B1 755 S B EHE .
T LR B SO LA XA R, IR )R 1 E v 0 (CountDwn) B¢ 1 (CountUp) -

10. ARFEFTJUARBIIB HEAE, NAMRMA=AESEG ES LK 10 f1E 128,
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10, BB S

HFR il &

Compare_Value uint8 4

Count_Mode UpDwnCntrPWM_UpDwn Count Down

Counter_Period uint8 9
Count_Mode Z ¥ A} T Hi 2B AURMA 117E X .

11. H=AFHZHN Hardware i EWE N ‘True’ , K&l 128 Fiok.

Bl 128, HINHT A S 5

Parameters Definition @
Mame Type G = "}l |
CY_REMOVE baal fals o Misc
CY_SUPPRESS_API_GEM |baal fals Category Misc
Check R: T
Cv_VERSION stiing = 5 ech Ty e
escriphic
INSTAMCE_MNAME string =G| = DizplayDr False
; i aidware [=]
Cormpare_Yalue uintd 4 Foad Onl False
Count_Maode UpD whCrttPym...| Cou Tab Basic
: . “Walidators 0 alidator
» Counter_Period uintd N - Visble  True
< I b
*._Formals | Locals 4P
Name: Counter_Period Hardware
Lﬁf:;_uéntB |z the Parameter passed as
B Yerilog DefParam?
[

12. fili OK, FHRFEXHALEHEAT M BT 3 2
13. EfFSRBHRPATTAME, HOBAMAT 54K Verilog XM, 5356, IREFTABNRE.
14. fiifi Save All, {RA7FFTA .
15. BH “$dRgsAamE TA” , AR UpDwnCntrPwm_v1_0.v (.

AT AN G B AT (T S 8 A7 PWM R B AL E, (AREGE TS AMHRAICE , Tl 4.
16. B — i Datapath Fc &, N “UpDwn” . i ‘cy_psoc3_dp8’ 2K7#,
17. fiiE CFGRAM, LIfF&% 11,

R 1L =AU R AR B

REG | FUNC | SRCA | SRCB | SHIFT | A0 WR SRC
000 | DEC | A0 DO | PASS ALU
001 | PASS | A0 DO | PASS DO
010 | INC A0 DO | PASS ALU
011 | XOR | A0 A0 | PASS ALU
18. XOR ELEF M TIHERH A frds . TH A 8B I v e I G , e B Qb7 XOR #1E, RITEERPT 4L

HIHEAE.
19. S5fai sy 8 it PWM snfilth—%E, ¥ CMP SELA BB N ‘A0_D1’ KA E D1 NEHLHHME.

£ LAy, S CAIN T AT 2 TR E AT A ARSI “Initial Register Values”  (#]#h%F
frali) BN, RN T80 g4 Verilog SCAF#EAT LT .

#iln, 5 8 A1 PWM -l s (50— 4%, 4% ZSHdr 4y “Counter_Period” F1 “Compare_Value” .
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20. #T7F Initial Register Values & 1, 3% &S &MHAZ A0, DO 1 D1, Wl 129 fizr.
Kl 129. ¥ & SHAE VI F A A
'Initial Register Walues E@
Datapath cntr8 (8)
DP"_a"
al_init_a:  Counter_Period
al_init_a: O
d0_init_a:  Counter_Period
d1_init_a:  Compare_W alue
[ k. ] [ Cancel ]
21. i OK, fRAFXT Verilog STHFFidEAT 08 Bl 25
22. REEHHNE, JERMAEBIRERARE LA,
TR, RN —L Verilog ARSI IR ZE 1 L SE X L4 B o
23. 4TJF UpDwnCntrPwm_v1_0.v 3Cff, F-3-48 T SCAFTTE AL E «
// Your code goes here
24, R TIMNERE LR SCA:

// Control Register "pwmCntlReg" bits
localparam CNTL CNT UP DWN = O;

// CompareO less than signal

wire up reload;

//Zero Detect Signal

wire zero detect;

// Up/down control

wire upDwn;

// Signal to control reload of counter
wire reload;

// Control register signals

wire [07:00] control;

// Up/down control

assign upDwn=control [CNTL CNT UP DWN];

// Logic for the 'reload' signal

assign reload = ( upDwn ) ? ( up reload ) : ( zero detect );
//assign termnical count output

assign tc = reload;

// Control register instance. This text is
// found in the Component Author Guide.
cy_psoc3 control #(.cy init value (Count Mode), .cy force order ( TRUE))
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pwmCntlReqg (
/* output [07:00] */ .control (control)
);

25. NEIEER A IR N T S e
o H.clk()BCNA. clk(clk).
o ¥.cs addr(3'b0)HN.cs addr ({1'b0, upDwn, reload}).
o ¥f.ce0 ()N.ceO(up reload).
o K.z0() BN .zo(te) .
o ¥.cl1(OEN.cll (cmp) .

MERCETENR T A R EREE, DU 6 5 B X L AR Sl 75 Bh A8 S h B R . & 2, SET i Im i 3% 1 25 /7 28
(cy_psoc3_control) FCiF#EIEAT B i o AQRY B8 it 30 7 1al o 8K T MR 2 AR I SR A 2R A R T (5 8., 1
S H O FTE R

Y SRR ARG AR T T 1A, BRSSO R I N AR AR . S I R BIIRE .

FHWER, .cs_addr HHAMEFISLITAR—A . £ LIRRE R, HIEmERAMHMHRE, Bk H— A6 6
B, BT XEEVUMIRE, PIFEE WA AL

Roh, BREFEFBEEEMA ‘reload’ FE5MARZ ‘tc’ B5REFHEIFRENLE. 2 UXFEM, FABLER
ATCAE AL, AR ZDET SRRARIE N EURIRI G R . IWFEMA ce0 i, Ft, BB ST
BT, HE AO HEIEAET DO FIME, ECRRELHHM TG T MR A ES T DO (R, TR
ERnET UG
‘upDwn’ {5 S IEEFAT I THE (INC. XOR) it &ifykit4%t (DEC. Load) .
26. RN Verilog U THIFTE H ik
Xf Verilog SCHFHHATRECE, ATUERRMIE S FZH AR . ARYE 58 — A9 350 H iR BT AH 24
27. f§f AN82156_Appendix_Lib iy UpDwnCntrPwm I H 1 i J& & 55
28. KA UpDwnCntrPwm 2H 14 it il )75 H JR .
29. ¥ — AN BOER S IZ AN ‘ol &3, IER TR E N 10 kHz.
30. B ANBUE S B AR R SR AR 2 (B PO_O_clk. PO_1_tc A1 PO_2 cmp) , & 130 iz,
Bl 130. i34 /id gk v H 3 1 PWM 11 H J5E 3 (&

UpDwnCntrPwm
UpDwnCntrPw
Clock_2[Hm} clock TC —on] PO_1_tc
10 kHz cmp ~Joa| PO_2_cmp
o] PO_0_clk

31. DRAFPTAH UM, HEITH JF4ifE PSoC.
HE BRI HLB B S HOR B 2 3B B 4 F0 9. @I F AT s I E0 55T 3 i 51T AL e AT
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K 131, kit 2 PWM T

AR e

M m—

ITC:

——————
v

200ps 5.00MS/s 7 200V
W+v-508.000us J| 10k points

200V & @& 200V 2.00V &

T LIRS L3R TR 5. PWM 7R Bl b (77 35 58 R A B 2 4. BT DU SR 24, 8 PWM AT 08 o Homn A

REIBITTEL

32. REIWHKEHE, X UpDwnCntrPwm 444 LT 414 1 .
33. 4 Count_Mode GIH#i=) W&y ‘Count’” , Wil 132 fiom.
132. %% PWM 5 B s T4

!on!lgure lplwn!n!rlwm - ILI

Mame: UpDwnCntrPwem_1
/ Basicl’ Built-in 4 b
e

Compare_Yalue | 4

Count Up

Counter_Period | 9

Farameter Information
Count_Mode: [Mo description available]
Yalue: [Count Daown]

Type: UpDwnChtrPwm_UpDwn

Apply

e,

| I Cancel

34. Hidy OK, NN,
35. DRAFFTA A A, FIEEIUH Jf 42 PSoC.

36. EWTLOEE, It AT, BROR R E R R

TC & cmp {E vE, Wi 133 Fios.
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K 133. i3 5 PWM T

TC

2.00V & € 2.00V ) [200ps 5.00MS/s 5 200V
W>v-294.000us || 10k points

37. WWHER, TC J&, THMEMRTILEAE, HATidmit g, ks oam. KSR B, T8 T L
{6, IFEEATIEET R BRI AR

13.4 WiH 4 — R UART
Zor BT H R T —AME AN BRI R IR . TX UART. AT AR IS Ba @A 411G —5 8. (HEmLl
TEM KRB T H & F A F Verilog SCAF. 7E & A 2 58 K 61 (1) AN82156_Appendix_Lib T B 1 3 #£
“Simple_Tx” M. ol ZHA 40— MR a SEMRRPNTEX A, F0T “SimpleTx” WH .

TX UART AR FE4HE R
LR, BRI R RIR T . T R SR B R BRI B BB 3E4% FO AR RMENZRE] A0 . ALU % i
LR AL, K 134 Fiw.

K 134. Fofrdetsith

é_‘_EtZa srch
cmshi — \—f cmsbo
cfho - Alu cfbi
co_msh-1 -4
co_msh - ol
co msh_req -

sol_msh sir
snl_msb_mﬁ; Shift SOT_reg
sil sor
WEER la—=— amask
ou1| [
cmsh

AL REE R B LR B RS, TR SR T B ER AR B0 R C B W MO R B R AL AR RO ERAE . AT AE B
HAR L B TR AR E X P i BiZE I, wnlsl 135 pos.

135. BARIERE

(AN
Bt Reg Binary Valus FUNC SRCA SRCE SHIFT
|| Req0 |0000D000O | 00DOD00D | PASS | AD ) PASS ~
| | Reg | 00000000 | 00000000 [PASS | AD Do o
qﬂegz 00000000 | 11000000 [FASS  |AD D0 gfﬁd -
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e S VA — M (SO Htlig. AR (Shift Out Right) FIZFSH (Shift Out Left) &l %
frh, i 136 Fis.

] 136. Fdm s 42 5t (1) 2 2R AE I

ce0
clo
z0
ffo
cel
cll
z1 6
ff1 < dp_out[5:0]
ov_msb

co_msb

(T 01 9T - 9) XN INdINO

cmsb
sor —»

Y YV YYYYYYYYY

15 14 1312 1110 9 8 7 6 5 4 3 2 1 0

sol_msb —»|
— fO_bus_stat —»|

fO_blk_stat —»

fl_bus_stat —»

f1_blk_stat —»

A ZE G B % 5 4%, T 7E CFG15-14 SHIFT SEL H S B X W3k T i/E, W& 137 fix.
& 137. SHIFT SEL [\t &

CFG15-14

Reset  Binary Value PI SEL

[ ) oioooooo 1 oooooooo | cc
1|

CFG17-16

EZonFid, Qg Verilog RV HIEHRK AN E . 7€ UDB PLD Fs2BliZ RSN EfiE T UART 145 Eit
ITHR — 5, ks, BdEsUs L.

IREAEE T Verilog fUi%, THER T AT

reg [1:0] state; // Main state machine variable and datapath control
RS R IR SR AR AR, EEE state CIRESD HTH5EHI CS_Addr:

/* input [02:00] */ .cs_addr ({1'b0, state}),

W case WA) AT LLSZIL Verilog IRASHL, AT B8 SOEOHE B A2 T /4 2 1E

case (state)

STATE IDLE:..
STATE START:..
STATE DATA:..
STATE STOP:..

endcase
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TR, LR ADREEAWTE X

// Main State machine states

// Idle / Stop bit 1

localparam STATE IDLE = 2'b00;
// Stop bit 2
localparam STATE STOP = 2'b01;

// Start bit

localparam STATE START = 2'bl0;
// Data

localparam STATE DATA = 2'bll;

REHACA PURRE, X DU R T f S s e iU B . DAk, Ml %42 7 ZE DY AN SR I

12, R T BURBR A E

REG FUNC SRCA SHIFT | AOWR SRC
000 it A0 7 Ps

001 piibus A0 7 7

010 SIS A0 7 FO

011 it A0 SR ALU

LAELFEN Verilog RSHLIN, E 3 T IR E . X2 — M@t JUFIra S8R0 i1 4 1 5 24 H

—A Verilog RAHLKE 7 HHE B2 L E -
& 138 SR I R TX Verilog RAKL AT TAE

& 138. TX UART Verilog H¥if& Kl

IEnable || fifoEmpty

TN DP: Reg0 (IDLE)
( v TX Pin: High

N 000 -
— Ioii= Enable &&. !fifoEmpty
yd N\
/ \
DP: Reg2: LOAD AO from FO
TX Pin: Low
DP: Regl: IDLE
TX Pin: High
001 bitCnt == 7 && 010
STOP ITWO_STOP_BITS START

bitCnt==7 &&
TWO_STOP_BITS___

DP: Reg3: Shift A0 (011)
TX Pin: Shifter
bitCnt 1 =7
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o, R fifoEmpty RS, REHUR AP EEE S A FIFO . FIFO A ¥, Eaild i TX &Lt
HEHSE (LOWD SkRIZE—A START GBI . EIZIRE T, BEBAK FO T EME S A0 1.

FER AR, BBk A0 . ZBMEA ARG, BRI A STOP (##1E) . Er LU —/ ek
P LA

WFHIRRSHRE AR H T HdE. ERIRE TR TX LENKET, MRS RSN BIRSH 2 8iZ 2 Eh 3 e
B, 3B PLR Verilog AURS AT $04T 1% 48 4F «

// This next statement determines the tx output. if in data state, output the shift
register output "srOut", else output a low during the start state, and a high during
stop state.

assign tx = (state[l:0] == STATE DATA ) ? srOut : ( !state[l] );

WRARTHARIRE, oMl TXZ L ‘state”  CIRZ) K msb fir. AERIERER, msboy ‘17, Kt
HERE 07 o MRS IEATIR BRI, msb oy ‘07, prAHAIH Ny 17
I H ) AR BE 7 M IR AL AL, SR)E LA 9600 BRrESfE s 0 2] 10 HfE. KAt BN 9600 BkF AP

MR

5 PSoC Creator 235 [ & — ANFRONF S A (BCP) R . &R LME A BCP R RX 745, £ BCP 1, &
#EF COM i (TX Ml C&ER 2% 1) .« £ Tools (T.E) > Protocol Configuration (FHYEE) &, BE
RX8 (UART) , il 139 fiTow.

5] 139. BCP RX8 il &

Protocal Configuration =]
[Pl [lec |8 [UART]:

Bit iate (bps) 9,600 -

D ata bits: [E - ]

Parity tepe: [ M ome b ]

Staop bit; [Twu:u v]

Flaw contral; Mone

[ Ok ] [ Cancel ]

7£ BCP gm#Easdr, WILLF A rx8 x X X X X X X X X X Xo MIEE K COM i O it 11 N7, AR5, LT
Repeat (HEE) kiS5 EWE .

13.5 WiH 5 — FTEAN AT H R
R OR T W0 £ RO B O AT NI AT R o S 8 7 6 AT MR B TT DRI M A . BV M
HATHIN (P 1EHL 8 RIIFATE, IS MEAETE AL . SIS T ETE AL TN DO i@ fl. AR5,
G LEIATRIE (PO) .
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K 140. FEAT VARSI SEHL

CS_ADDR !

[2:0] CFGRAM
—» FO - > F1 -
A A
DO D1
Yvy vy
> A0 ! —{ Al F—

Pl
—iv Y Y YV

AOD, AL
A A DO, D1
] PO i
 /

ALU

(Pass)

(Add)

|

CS_ADDR =000 (Pass P1to Al)
CS_ADDR =001 (Add Al to DO, Store in A0)

R BRI DA BR T BT LASR B H T A HM S . AR EiIh It T —A 52 M PI_PO_Example i H .
1351 AIESHITE KD E
T BERIREL, B E AT LA R B E AL, TR AT AR B R AR ]
1. J33h PSoC Creator, FHTIFMjE 8 i~ mi HFT A “AN82156_Appendix” TAEX . [a TAEX A& TN
“PI_PO_Example” HI#rHiH .
AT LME F T TAE X, (R B O EEE A 5 a0 — 00 H AR B TAEX . X Ae 2 Wifk EEE IR OC R

2. 8 Symbol Wizard #5457 NE] AN82156_Appendix_Lib H. %R H “Parallel_Adder vl 0”7 {E
RAZFR

3. I ok BAR—A G2 X 8 fr¥ A Parallel_In[7:015i. B4k, i@ X T Parallel_Out[7:0)%H, 0
K 141 Fios.
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B 141, R 2R In BT Ini g

Symbol Creation Wizard 7 ==

Teminal name Type Symbal label

Farallel_In[7:0] Digital input

clk Digital inpuat
> Digital output

Parallel Adder vi 0 N
Parallel_Adder_v1_0

Parallel_In[7:0] Parallel_Out[7:0]
clk

x][2][+ Tille color

oK | [ concel

4, AEfFTEEEE, RIS EE:
o Doc.APIPrefix = Parallel_Adder

o Doc.CatalogPlacement = AN82156_Appendix/Digital/Parallel_Adder
Doc.DefaultinstanceName = Parallel_Adder
IM—~429 Add_Value MFIfF5 54, FHIGHRAEE N uint8, S8/5% Hardware % &4 True (X .
A SRS A E, JE AR5 AN Verilog ST, S, IREPITE BRIAIRCE .
fidi Save All, {#TEFTAE ik,
BRI E TH, I FFRIA 8 Parallel_Adder_v1_0.v 3 ff.
B —NLFRAN “adder” KIFIEUERAEE . 1 ‘cy_psoc3_dp’ A, ESFIK 142,
142, BRI R

a

© ©® N o O’

Mewr Datapath EIIEF
Instance MNarne
Addeq
Instance Type
@ cy_psocd dp ) cy_pzocd_dp2d
) cy _psoc3 dpd ) cy_psoc3_dp32

() cy_psoc3_dpl6

[ 1]4 H Cancel ]

10. WITIZERE, AT LU AR B AR 1 PIL A PO, HiAhPUA Instance Types ANHET ] P1 A1 PO,

11. cy_psoc3_dp R —> 8 frfysihl. REFHEMM L T 8 £, MATEREZANLH], RFELSA Verilog
T REREEAT. Hi D SR (/2 X e S BB AE — R 24 A7 Em BAR K — Aol

12. fit B CFGRAM #4y, LAIfF&# 13,
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* 13, A AR B R
REG | FUNC | SRCA | SRCB | AOWR |A1WR | CFB EN
SRC SRC
000 | PASS | A0 DO NONE ALU ENBL
001 | ADD Al DO ALU NONE | DSBL
13. E—HMEE (REG 000) XH T Pl LMfH, JFHHELRAEEALN. FE_MEE (REG001) KT AL HiME, I
FHZAE N - DO A, A5 BIRIMERTFEE AO .
14, #FR, EE PR,
15. 7£ CFG15-14 B+, fidi PIDYN THPFE, #)J51%E+# Enable Bit (fFgghr) , ik 143 Fios.
K] 143. ffi5e3hAs Pl 424
CFG15-14
Feset EBinary Value PiseL  SHTT PIDYN  MSESI  F1INSEL
[ | oooooooo | oooooooo | acc sL -mbz
[ EnableBt |
CFG17-16 Copy Register
| Reszet  Binar Walue Hr.lu.sid ’EEPH HTU.SE e [ReghEy
16. ¥ PI DYN #% & A EN.
17. XFE, AL SRCA I NBIAIER A Pl. A0 BL ALl; 1ESH% K 144,
Kl 144. scra B H %%
7 Moy
AD &
srca d«:h
18. iZE P MIEREL I CFB EN N ) CFGRAM FEBifziil. K% E N DSBLIN, srca’iiA\kH A0 B AL; HH
P E N ENBL, srcafiiA\kKH Pl.
19. WP EERK 13, K EIESE A E+, CFBEN #WE N ENBL. HILE/R srcakE Pl FTLAfEE—ANE
W, BRI AR LN P AR AL Y.
20. fEEZ/NECEF, CFBEN #i1xE N DSBL. X{H#*/~ scrafil A\l CFGRAM #iill, F# K E N Al.
21. ¥ DO (#IiR{E B B A Add_Value.
22. (RAFEUNE, FERMABIRBARE T H,
BTk, T2 L Verilog ARSI I 3 204 LS HLX e P g
23. #T7F Parallel_Adder_v1_0.v 3, 54 T HSCAFITERIA E -
// Your code goes here
24, fFATHASRE LR SOk

/* Register to hold state of statemachine*/
reg state;
wire[7:0] po;

/*State loads the value from the PI into Al, latches value in A0 out to PO*/
localparam STATE LOAD = 2'b00;
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/*State adds the value in Al to DO and stores in AQ*/
localparam STATE ADD = 2'b01;
/*State machine is always run on positive edge of clock*/
always @ ( posedge clk )
begin
case (state)
/* Datapath loads in value from PI to Al, the value in A0 is latched to PO*/
STATE LOAD:
begin
state <= STATE ADD;
/*we must latch the PO value here, because in the next state PO is not wvalid*/
Parallel Out <= po;
end
STATE ADD:
begin
state <= STATE LOAD;
end
endcase
25. NEHE AR RSB IN T P B

o K.clk()BUN.clk(clk).

o f.cs addr(3'b0)HN.cs _addr ({2'b0, state}).

o ¥ .pi()N.pi(Parallel In),

@ ¥ .p0() . po(po)

TATRIRIEIE T —DRERENL, BEERNEEE RN E BTV, H—FRERIT Pl _EME, FREHR
e AL . S5 ML ECSRE T AL RIME, FRRzE M - DO M1E, RJEHARIMEREE A0 .

PO UG£ S AL B A0, R AHK srca iy AO I, &5 RAHRL, ILIRATLAVE @R EN PO. Nl
i AT R AT -

Parallel Out <= po;

ZAE 5 HECRE PO (MME, IR HARAFE(S S Parallel_Out CHfHRIH) H. £ F—ANIREN, # scra &fF N AL,
k% PO JoRl. XAE R EAEMBARE T BTN o

26. SERUITA ESUS, W IRAERTA S U 2

27. ff AN82156_Appendix_Lib iy PI_PO_Example 3 B [ @ #55
28. ¥ Parallel_Adder #7245 (1 2 22 4

29. HRAEA 145 BB R FLIA.

K 145. JRAT ik a R LA

P6_1 i _~ PI[0] Parallel_Adder_1 POIO
Pl Parallel_Adder_v1_0 Y P6_3
~ ] )
P15_50= PUZO . lparallel_In[7:0] Parallel_Out[7:0] PO[7:0] PO [ P6_2
[
Clock 1 [JIIL clk PO[2] PO_7
o _PI[7:2]
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P6_1 1 P15_5 2 N\ 5l 4L, EATH: A E A Resistive Pull Up (HFH B0
P6 3. P6_2 fll PO_7 =7l 5l 4.

ZJRFRE A CY8CKIT-030 1l CY8CKIT-050 %[ J#¢it. iR IEAEA FIASE MAEF &, A THEEM T E s

I 53 -
% 14. PSoC 4 E4E1 5] B
=1 BV A\ 51 FEWUEF s el 51
CY8CKIT-042 PO[7]. P1[0] PO[5]. PO[6]. PO[0]
CY8CKIT-043 PO[7]. P1[0] P1[1]. P1[2]. P1[3]
CY8CKIT-044 PO[7]. P1[0] P1[1]. P1[2]. P1[3]
CY8CKIT-049-42xx PO[7]. P1[0] PO[5]. PO[6]. PO[0]

BRMARAEL, EPATUTEME (ZFE 146) -

W ZIELE -

HU3H /5) % Use Computed name and width & i%4E.
A% Specify Full Name EikiE.

BNZMLE (R WARK, HEFTREBALE Indices.

Kl 146. iy A ELS T HE
Signal Marme @

[T] Use cormputed name and width

a
b

Signal Mame

Specify Full Name

FI

Indices

) More

@ Bit Index 1 B
) Bus Left Index 0 : Right Indes 0
Preview: PI[1]

[ oK. || conce

30. FEAMEHIT, ¥ Add_Value B E N 2.

1. RAFFTATE N NE, FHXT1%IH BT @M IE .

32. £ CY8CKIT-050 5% CY8CKIT-030 L, £ PO_7 1 LED2 2 [HliEH—i S2k.
HAD AR LED 4 BoR A B INVERHE 1T IR UL, LED 4 R ZfH A7 0, LED 3 R/R{7 1, LED 2 RIRNL 2.
SW2 ERiZHAMIAL 0, SW3 Rz AL 1.
IR IEEME AR 14 AR —AEM4, IARZE— A MR IERES PL[0] |, IG5 LED HHEH1ZR
T F A S
WMARH I TR, MEERHHAL LI LED 335 K06. R DO RFF THUE 2, MREHE T 7SS
AL O FHREE, IR EREE AL O Ff HIAL 1 7Y LED NAZ A& 6 LR HEUE 3.

oI T A0 P B B AR 1K) P A PO BTE RS 28 18 A i £ A X 2845 5ok B AE A PILAT PO SN A4 1
Wit
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o CYPRESS

> EMBEDDED IN TOMORROW™ PS0C® 3. PSC 4 il PSoC 5LP — fii] UDB %#i2# #%3%f PSoC Creator™ 2 {43t {7 it

14 W3 B — HEBEE TR

AR s R B A I B TR A B B A A (B PR 2R R
GUI W] LAy RPN A ES 7, BB E S A S ECE A7, &l 147 PR
= SSNE — EFT DB E SR AR BB AR S AR T AR K77 s AT
» ERSHE — ERARIRE T R FEAR R I T fE
P 147, Hodl R ARG B LR S 2y

Fle Edit View Help

Corfiguration: | dummy_empty_a (8) =

[ v e s BPGP om on em e o
T B O T = N S = N

L T ) T R N 7 pnpygreperrpppmerg B S -

| Jrgt ooooo000 1 0000000 pass [0 Joo  [eass |noe |nowe [osa creA Jema oA | |
[
[ o o0 oo eass [0 o fpass  Jwowe Juowe fosm sk o jon | ]

Static Configuration
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EMBEDDED IN TOMORROW™

PSoC®3. PSoC 4 1 PSoC 5LP — {§i ] UDB % %% PSoC Creator™ 244 14T %11

P 148. £ HARHE R

8-bit Datapath

sol_msb —»|

8-bits
parallel /0 In/Out FIFOs
- f1_blk_stat
A ’ 7 > ? — f1_bus_stat
T = fO_blk_stat
2l |o f 9 FO  ® |—m fO_bus_stat
© © 3 ]
Data Registers
Y
| M Control *® D1 ¢ ® Sink
nput Mux RAM s - S O Source
rado [ © Agcumulatgrs
radi |3 S,E w| 16 Y
TS 3 X
rad2 )§> 5 % 5 ° ? Al e
= O
®5 1S ° & A0 o
dp_in[5:0] —m»| gé —» f0_ld
Y= » f1 Id cfb_en
———» d0_ld Y
—— dl_Id srca srch
- Ci
> si cmsbi — cmsho
cfbo - ALU cfbi
co_msb-1 -
co_msb - [4——— Ci
co_msb_reg -
sol_msb - - @« Sir
sol_msb_reg - Shift ——»sor_reg
sil - f—— sor
Mask 4—8% amask
out‘ ¥
cmsb
A0 cmaskO DO
A0 AL Conditions
z0 + 20i 0 oi
- ZDET ¥ -~ ce! CMP == cell
é ZDET 441" clo CMP < < cloi
A;O Al Al Af Dﬁ A0
ffo ffOi
FFDET, I +cmask1
DR FFDET e O
co_msb co_msh-1 - Cel | CMP == « celi
cll CMP < clii
ov_msb OVDET 4

Sor —m|

[ cmsb —m
fO_bus_stat —m
fO_blk_stat —w
f1_bus_stat —w

Output Mux
ce0 —» o
clo —»
20 =N
ffo —w ™
cel —m <
2
cll w5
=
71 —»{© ;g’
ffl —m~ X
(=2}
ov_msb —w o
&
co_msb —» o 3
or
S E

-

-

N

-

™

-

<

-

wn

-

f1_blk_stat —#

6
=< dp_out[5:0]
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~a” EMBEDDED IN TOMORROW™ PS0C®3. PSoC 4 #ll PSoC 5LP — {#i i UDB ({147 % PSoC Creator ™4 {4471 1

14.1 FEEE RAM (CFGRAM) 4
HIAME WS FA T HAMLE RAM. BIEE T )\ EAS S ISR SR . FRIEMAE T GUI & B %L
% 15. HE k12 E T B CEFGRAM #4y

FHAEE RAM H5
HiEAmE TR
CFGRAM
Reset| Reg Binary Value FUNC ~ SRCA  SRCB  SHIFT  gne"  GRO'™  CFBEN  CISEL  SISEL  CMPSEL
[ RegO | DO0OD000 | 0ODOOD0O | PASS AD Do PASS NOMNE NOME DSBL CFGA CFGA CRGA
[ Reg1 | DDOO0DO0DO | 0ODODOODO | PASS AD Do PASS NONE NONE DSBL CFGA CFGA CFGA
[ Reg2 | DDO00DO0DO | 00DODODO | PASS AD Do PASS NONE NONE DSBL CFGA CFGA CFGA
’ Reg3 | DDO00D000 | 00000000 | PASS AD Do PASS NONE NONE DSBL CFGA CFGA CFGA
’ Reg4 | DO00D000 | 0OD0OD0O | PASS AD Do PASS NONE NOME DSEL CFGA CFGA CFGA
’ Reg5 | DO0OD000 | 00000000 | PASS AD Do PASS NONE NOME DSBL CFGA CFGA CRGA
’ Regt | DO00D000 | 00000000 | PASS AD Do PASS NONE NOMNE DSBL CFGA CFGA CRGA
’ Reg? | DO00D000 | 0OD0OD0O |PASS AD Do PASS NONE NOME DSBL CFGA CFGA CRGA
Kl AT HE
e 8-bit Datapath
paralled 1o In!Out FIFDs
- 11_blk_stat
F1 r % 1 bus_ siat
of |2 [ Fo o Output Mux
e Diata Reglsters [
D ®sink el =12
= - =3
g — 5 M e
I ool —ehr
TER NIk "
F° . A0 & E
- - o mmz|
de_nls: b e 11'; = 2 [ dosus)
%Ze srch ] co_msb —-{ ?
. I o cmsh |2 =
e :% A — :| F—-
o_msbe] - sol_mat #0_bus_stat —ad D
0_Miah e ] - -
co_msh_rag - M bk stel —-{2
sel_rub - H_bus_stat —| T
sol_msb_reg Shift ——wgar_reg -
=l (50T M_blk stal —={i2
Mask oL amask —

il FROET] | il
- -

an_msb co_mab-1

e OVOET
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PSoC®3. PSoC 4 1 PSoC 5LP — {§i ] UDB % %% PSoC Creator™ 244 14T %11

#* 16. M E IS

ST B

I

ARHNRoR T 58— 17X L
BLEMAEASER. B =4

CFGRAM Hutik(5 5 FOME vT #f
RPN R

set Reg Binary Value FUNC SRCA SRCE SHIF

:] Reg088{ RAM Address 000 5 AD Do PASE
:] Reg1+#88 RAM Address 001 § AD oo PASE
] Rea2e88{ RAM Address 010 5 |0 DD PASE

oL B P TE 1T - .| Reg3@BB( RAM Address 0115 |a0 DO PASS
j Rend | [MWWWWWWY 1 TOWW0N0N | PASS PASE
FUNC
A E TR E A AT\
A~ ALU B30 19 5 FUNC A-l A-B
PASS
SRCA
A5 ALU K “srca’ HiA srea A HAH
. 3 3
srca th ] LR H Pl — &% % A0 Al
21 (CFG 15-14) .
SIRGE D1 D1 D1 D1
AFHiE ALU ff5 “srch’ A SRCB ~ ~ DA ~
I AQ ; AQ AQ AQ
v v A\ 4
AO Al DO D1
i O = = =
— SHIFT << >>
AT R LB ) R E
7 SR PASS  SL SR SWAP
A0 WR SRC
A0 WR
AT 5 ALU A /7 SRC
AQ FAFEHHIN 2 o = = = =
EQ EQ EQ EQ
D1 D1 D1 D1
DO 1 DO DO DO
Al | A1 Al Al
—> AQ Y AQ AQ AQ
ALU DO FO NONE
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- PSoC®3. PSoC 4 fll PSoC 5LP — fii/f] UDB ##fz#%4%%} PSoC Creator™ 4 {317 % it
2. BABLE B8 3H
FADBLE S
Al WR SRC
— Al WR

AFITE 56 ALU #0E f7 AL % SRC
fraphop . =1 =1 = [

EQ EQ EQ EQ

D1 D1 D1l D1

DO D% DQ DO

—> Al Al Al Al
AQ AQ AQ AQ
ALU D1 F1 NONE
CFB EN
cfb_en
CRC LB flifit — &% Y
CFG15 fll CFG14 2 /£ H1 11 Pl srca srch
DYN. \ f
ALU

CISEL. SISEL. CMP SEL CFGRAM
HERAE (Carry in Selech) Reset Reg Binary Value Func  srca  smce  swFr AR ATWR O empy |CISEL || SISEL || cMP SEL|
AL (Shift In Select) BL& creA CreA SFem
kA% (Compare Select) — /
R PO BB AR
B, VA IR4RE R TR IO Resst Binary Ve Pl ||c:| SELB  CISELA | SASKT CMASKD  AMSK  perg)
BT [ Joooooooo 1 ooooooo0 |1 01 a1 D1 [ARmH  [aRTH  [DseL  [pseL  |psBL  [DEF.0  [DEFSI  [DEFSI

BEAREL, BEHL20
(CFG13-12)
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~a” EMBEDDED IN TOMORROW™ PS0C®3. PSoC 4 #ll PSoC 5LP — {#i i UDB ({147 % PSoC Creator ™4 {4471 1

14.2 #HSHERS

BT B AR T AR A 2 1R 5 CFGO B CFGL7, 13 17, % 18, £ 19, 3 20 Fl3 21 FirR. XL/ s 5 55 1R
B, BIERAMITIA. M. FIFO ALE PL R .

1421 CFG9 HfFH%
% 17. CFGO &8s E X

AMASK &
K Br A AL E A
CFG3
AMASK A A A A A A A|A
Rest Vaiue [ 6 5 M @@ [ o frsed Comment

:]FF -|1"1"1||1||1||1||1||1|[DDDDDDI}

B AMASK i — iZ7FBAAE TR T HIEE ALU BB ) 8 AL Bl . SRS AL 2717 4% vh (46 H RN iZ 25 77 28 h i N & #E4T AND
B, BIMERT, Z5reisi . AT, YOI E AMASK EN i CFG12.

3 P %
Kl BR A HE
8-bit Datapath
B-bits P
parallel KO In/Out FIFOs
- f1_blk_stat
9 L7l - f1_bus_stat
= f0_blk_stal
2|8 FO [ fO_bus_stat Output Mux
@k ko .
Data Registers [
cell o
— Control e 7 . :rk a0 -
nput Mux  pam © Source -
o oo | & 20 -y
9 | A fi0 —e{
EEI cal —w{=
Qg K=k Al o
g§2° 7 7 ot =l 5
== § 54 a0 e
dp_in(5:0] L 10_kd ez,
pin[5: TE X 1 =it B s dp_outS:0]
iz 1_1d cfh_en =
- 40 1 av_msb —-= 1
di_id srca srch co_msh - 2
ci cmsh {2 =
s cmsbi — cmsbo sar -
cibo -4 Alu cfbi S0l msb -
Co_msb-1 . - O_bus_stat —w D
Go_msb ] ]
co_msh_req - f0_blk_stat —e{T
sol_msb — fa— sir 1_bus_stat —={F
sol_msb_r r reg
- =" M_blk_stat —|'2
Mask 4& amask —
oul‘ ']
AD  cmaskl oo
A0 A Conditio
ey "
ZDET
n S
ZDET
AD Al
FFDET) |
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1422 CFG11 Ml CFG10 &7

% 18. CFG11 fll CFG10 % 8% 5E X

CMASKO {EH# CMASK1 &

B ki E TR

CFG11-10
Resst CMASK1 CMASKD C1 Cl. &1 | B B | E1 | £ (£ CD Co Co Co CD CO CO CO - omment
WValue Value Bl 51 [4 [BI [& [ [0 6 [51 [4 Bl [ D W fr

[ ] FF

.|1||1||1||1|\1||1||1||1| |1|\1||1||1||1||1\|1||1|

B CMASKO fil CMASK1 — X4t BUi sl B A T LLE s M N B BRI . AT ELCRT, SeZ0K AO 3R AL %5 748 B A A IR He 27 17 G Y

AT AND 5. BEAEREEA], SAE CFG12 Hi%H CMASKO EN fll CMASK1 EN fi (£ 19) .

B Br AR AE ]

Input Mux  “paps

radd
rad1
rad2

Wigd 0
ogenBiyuog
9ixg

2lweuiq

dp_in[5:0]

=
2
=4
=
=
5

3
[}

[

il

ao
=]

@ Q.

1

=3

8-bit Datapath

B-bite
parallel 'O In/Out FIFOs
}—= T1_blk_stat
o F1 d [ f1_bus_stat
% f0_blk_stat
| |3 Fo . iy busss:,al Output Mux
@ b feo .
I Data Registers [
ot oo o Sink e ==
€l —-{—
¢ o o | & o Souree
20—ty
b i =l
cal —mw
Al [=]
g b cll ==l &
s & 8 AD g
21—l
Els
b en i1 —e{r % (oo dp_out]5:0]
ov_msh —s|= llm
%7 =
shea sreh co_msh —slo g
3\ f cmsh —=|2.2
cmshi — cmsho sor =
cibo - Alu cfbi a
co_msb-1 sol_msb 0_bus stat —s|2
- 0 blk_stat —s=|T
f1_bus stat —eT
F1_blk_stat —=22
L—
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PSoC®3. PSoC 4 1 PSoC 5LP — {§i ] UDB % %% PSoC Creator™ 244 14T %11

1423 CFG13 1 CFG12 %

% 19. CFG13 fll CFG12 %885 X

CFG13-12 KRB IR
B A E LA
CFG13-12
Reset Einary Value SHs SHa  CsEB ciseLa GUASKT BWASKD BESK perg sisme sisea
[:] 00000000 | 00DOODOD |A1_D1 |A1D1  |ARITH  |ARITH  |DSBL DSBL DSEL DEF.0  |DEFSI DEFSI
CFG13-12 I 4afE B

CMP SELB & CMP SEL A Al D1: Al<D1. Al==D1
Sbbisek B 1 W b B RILLER A % AL_AD0: Al<AD. Al==A0
Til. RAM CE ) CMP SEL #B#fiE7E | AO_D1: AO<D1. A0==D1
CATE N AT B WEIH K. AO_AO: AO<AO. AO == A0
EE: LEEE 0 KXt DO A1 A0
AR AT LA
CI SELB & CI SEL A ARITH: #3) (carry) J5la i ALU SRS
A% carry in 3. REGIS: A (carryin) & E—AMZFFMEH (carry out) .

ROUTE: MR ATIERE—F N (Carryin)

CHAIN: F& X\ (Carry in) B8 T — MR B2 IS .
CMASKO EN. CMASK1 EN. AMASK Al AD D1 Al
EN e 4] oo
fdRE L 1 FIELE: O BEE (AN FT =) o)
R LR ALU (ANEIR) firH B E el CMP == celi wal CMP == sl
BRI B . 1E 2% 17 FI5E 18, ol TP = ol oh GMF = ciid
DEF SI DEF_0: 0

DEF 1:1

ZIETE SCERIAFE AL IE 2 0 I8 1.
VER: A% SI SELB Y SI SELA &N
DEFSI.

SI SELB & SI SEL A

AR B B NFRER shift in J&.

DEFSI: Shifts in [Pl 0, 32 1, 41 DEF Sl Fr@ .

REGIS: Shift in /& L — & #7547 shift out.
ROUTE: Shift in J& W& B 12 5 N\ g B .
CHAIN: Shift in H1%E 87 — M40 5% 23k 30
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PSoC®3. PSoC 4 1 PSoC 5LP — {§i ] UDB % %% PSoC Creator™ 244 14T %11

1424 CFG15 # CFG14 FfF%

% 20. CFG15 fll CFG14 %7885 X

CFG15-14 1%k #*
HEBARETR
CRG15-14
Reset Binary Value PISEL  of ' PIDYN  MSBSI  FINSEL FOINSEL MSEEN MSBSEL el  CHANFE CHAN1 CHANO
(L] 00000000 1 00000000 | AcC sL BUS BUS DSEL  |BITO NOCHN |NOCHN |NOCHN | NOCHN
CFG15-14 K 4a(E B
PI SEL ACC: BT 7EhA L E X S AT I B o] DOEBEIR A 1KE . T
. . e Al
PIN: 5 A FRISK I B S B 42 (0 SR AT SN I % - T e

ZIE T % SRCA
KA. Ui
NAT LR E Zh AR E
) SCRA %
T, A] DL E JEAT
HINo

Alu

Shift SEL SL: % Jyfii 1 sol_msb
£a
MR i e | SRe BV sor o -
FI#& shift out {5 =
= sol_msb =l
ol - Allu &l
oo misb-1 -
o mEb - e
co_msh_rag -
sol_msh - T4
sol_msh_ *E Shirt @Iﬁ
&_ )
PI DYN DS: PI &M & HiZ%H #4510 Pl SEL izl

FEREIFATHIAN (PD

EN: PIZH#H2)Z& RAM H1[1) CFB_EN i3] (% PISEL Y ‘0° ) « HEAZAFHH CFB_EN
4 ‘0’ B, ALU ASRCHi AN AOEL Al; 24 CFB_ENA ‘1’ I, ALU ASRC #i AN Pl % 75

2R RSl 3,
i, IS 5 ek
F| ALU ASRC #ii\ .
MSB SI REG: ZRIAM shift in -2 i DEF SIE#iEN (CFG12, % 19) .
— MSB: i 2457 E X ) MSB  (CFG14 H1{f) MSB EN il MSB SEL 7 B) 7 m2RiN shift in {8
SCRFHEOR Shift Right (F SELA[L:0//SELB[L:0]%, Z%{H#E XN 00" D .

CH#) $#AE.
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PSoC®3. PSoC 4 1 PSoC 5LP — {§i ] UDB % %% PSoC Creator™ 244 14T %11

CFG15-14 FIFAIAE (4R)

F1 INSEL & FO INSEL

Bus: FIFO ¥\ & CPU

B2, FIFO Hit o « o o« 2
5 LT FIFO 1 1 FIFO 0 (5% J& A0 5 DO 7 A7 L «= 9
A0: FIFO fii N\ /& AO.
FIFO i th /&2 CPU I
B, S
Al: FIFO i\ AL, Y 2 Y
FIFO #ith /& CPU 2
24 op o
B, o
ALU: FIFO#i\= &
ALU. FIFO 51 FIFO FO z FIFO F1
CPU #14;. i
MSB EN Al MSB SEL 24 MSbit 55 AkR Default (tie value)

T rl LU % ALU Finth i)
MShit. e X P> e B AT L
SRR R R, JF PR
79 MShit FIfiz.

fi2 7 LA AR AT Registered (ser_reg) — shift in left {sil)
i, shiftin. shift
out F1 carry out %

Routed (from interconnect) — Selected M5B

Chained (from next Datapath) —

HREA S SR
—
| 7 | ? e © e
| N PN

shift out left (sol_msh}
{to DP output mux)

sol_msb_reg -

co_msb
{to DP cutput mux)

co_msh_reg --——

M CMSB

i BE¥ CRC MSB MEERE H1 11
TR R A AR
B,

CRC MSB 557t /& )\ MS Btk 3] LS i), MR AN E S CRC IR A AL, HE
L%

NOCHN: CRC MSB A#k#s,

CHNED: M iZHE % H 1)~ AN i 2 A it B2 CRC MSB.,

BB FB

fiRE CRC [ BERE T I —
B R AR I SRR

CRC FB 557t /2 M LS B3] MS B ). Mg A& CRC I BARE AL, HE
L%

NOCHN: CRC IR ER% »

CHNED: M\ H T — AN i /28 82 CRC.

BERK 1 FEERK O

%X CLO. CL1. CEO. CE1.
Z0. Z1. FFO LLK FF1 f%iH
R RAEM

{f %3 (CHNED) J5a0Hf, mT— R A2 10 25 PR 1 B T B b AR i 42 . BE I O K5 B
CLO. CEO. ZO VLM FFO 444, #Eik 1520 CL1. CELl. Z1 LA FF1 %4
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1425 CFG17 1 CFG16 # %
% 21. CFG17 1l CFG16 % fEa%E X

FIFOFRLE
AR ARE T H
CFG17-16
] Unused | ADD Unused FICK  FICK  FIFO FIFO FIFO EXT WRK16
Reset  Binary Valus [1513] | SYNC g F1EYN FODYN gy INV FAST FIFOCAP  cpGe | async | CRCPRS — CONCAT
[ ] oovio000 | poooooon |aoo ADD 00 op ax LEVEL  |sYNC DSBL DSBL

B ADD SYNC — Hi5E &7 1A FIFO BEHURZS iR Ao 1 [R5 i 2 o 1% 7 BUS H25 DU ZR I o 23 9 SR HEAT 28352/ 55 B0 AR IR AN E A7 28 508 % 12
far e N R UOHDIRZS Z TR LA e o R —ANEC B o] LU BB AS FIFO #3715 2% F— 7 FIFO Bl & =75 .

NONE: A2¥fil )k S8 NE] FIFO MHUIRZS 14 H o o
ADD: KR B2 R IS FIFO KEHUIRZAS RIS H 3tk .

® F1 DYN — $&#] FIFO1 J5 25 SHE R EhER . SN, FL_SEL[L:0f#ZH]%E FIFO MM EJi .. ¥iztiik 8 AhshEsEn, &
TEAEPMELE: WEVI CBIREAAEXT FIFO AT S#AE) MAME I M (RGBT FIFO BT E#H/E) o /N, F1_SEL[1:0]f7%
il PO UG A 20 R 1K FIFO SRR
OFF: #&#E. FIFO 7 NS, 3 F1_SEL[1:0)# 4.

ON: B, FIFO AR, Wil Y1# DP fiZk{55 d1_load, W LAFESHIZE PIEE AN AR il A1 P46t .

m  FODYN—F1DYN FizHL i g

® FO CLK INV l F1 CLK INV — #fi 58 FIFO 4 i S % /2 15 ) N B B A e
NEG: FIFO I &hF1 DP I 4 iy #1248 [ 1
POS: FIFO M4 ) 3%t i DP i 8l s %

B FIFO FAST — #iis€ FIFO FIIH e R B B 2 I ek f&: PSoC LRI Bl TEBRGEREIN T, FIFO Yo 4 $ 4E IR 15 31 PR A A 2R B o
WA ZAE S, DHRESIEIN. X DRy 5 B A8 1 B RS 2RI B P R T4 . A% UDB A FIFO B, (H'e HiE& T E
Jyfn A=) FIFO.

DP: H¥ ey o
BUS: i Zkhf4of

®m  FIFO CAP — flifit FIFO filigkiia. #eflifens, X A0 Bk ALl MIBEBURIER 2 M 5 N3 FO B F1 4.
AX: BEHUAO 3% AL IK BB IR [8] 25 A7 2% P A
FX: BHUAO (B AL Wil & ¥ %45 15 NE FO (8L F1) WINERLE.

B FIFO EDGE — e MK B P4 i fi P 2 155 FIFO #E TS5 N E. B3, Wk RA5 FIFO #HT544E, FO 5k F1 {535 = R
R
LEVEL: FIFO 5N (i) & s P Ui,

EDGE: FIFO 5N (i) RihZeu®n.
B FIFO ASYNC — i€ FIFO RS E S M A R EMAER . HSH NI LM FIFO RLE &4,
SYNC: Al k& INE] FIFO BLHURZS 4
ASYNC: Kl k27 INE] FIFO BIHURASHH . RAELIERAENH S MASTER_CLK [E6R, 7#&8K ADD SYNC &N NONE LLLK
FIFO ASYNC # &4 ASYNC, i ADD SYNC % & N ADD LUK FIFO ASYNC % & N SYNC .

m  EXT CRCPRS — 7E##i CRC/PRS i &M AEECE, I AUX CRCIPRS (55 T4 Bkt . Bz, Al LLUTIR CRC #:AF M R i b
N CELIE shift in BE AU BREOE)  JF BB AMTTH X85S, GE¥E PLD ) .

DSBL: W#f CRC/PRS #itk
ENBL: 4Mi CRC/PRS #i%k.

B WRK16 CONCAT — %Ml 16 hrijy il 4% A A [ TAE S 2 2oy il k. BRI R, HiZACAO R, V5 HDKAE UDB St B — 27 17 2%
BRI T KA. B E 1w, x4 UDB AP R A A A AT 16 ALMRERE ViR . &AL 4 I 8{AL,A0}. {D1,D0}.
F1,FO}. {CTL,STAT}. {MSK, ACTL}. {8'b0,MC}.

DSBL: 16 frBRAVT IR . 16 Az 6] 4 42 HE BERE ML IE IR T X PR ANEESE (1) UDB th EL45 27 A7 28 0EAT W S R 1k .
ENBL: 16 A8 By5 i, 16 A5 bk Xt By UDB i (1 £ Bk 25 A7 28 E AT 15 5 # 4
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FIFO I8
FIFO #ith RIS HER
System Bus
S
bik_stat J
#empty empty | U Empty to
Cleared at bus clock DP state
resolution by CPU write, ‘:,\1 ; machine
DP set at DP clock resolution S (blk_stat)
by DP read =d q e >
4
Datapath Process DP clk l |
{Asynch)
=
DP
Truu | w0 > Full to
Cleared at i lock P state
. (Rx)blk_stat res«oi%on bygglf?ead ‘:,\1 ; I ‘rt machine
set at DP clock resolution S 5& 1 (hlk_stat)
by DP write » d q—'_.— =d q
DP clk J
System Bus
ASYNC ADD SYNC B fEFRAEA
0 . - S CPU B/ 5 AR 2 DLE LRI S MR AT 10 . a0 SR 2 7 R Bl /7, B4 AT LA
_E'\i‘~—~ Gk N
SRAMHES g,
0 MRt Eh FER | X RBOARP AR S SRR B DP i 8 [F2P 4T CPU B/ 5 RS i E
KRR/ DP Bl | HiRRERt, ¥ UDB IBARILAL DP i i5 B i i) ) 52 48 5 41 .
1 LR
1 MR XUE L | HEH—A 8 His TR DP BB, @i % & 0] LUK CPU 15215 e XU 5 3
FI| DP i DP i 4.
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14.3 W EWIMHFARE

FAEEE DCT H1i¥) AO. AL, DOl D1 FIFIGHME, EMHKIKIERE View > Initial Register Values. #l1, W1 4E #E
LA Cntr8, BAZE DI 149 (K14 FiR.

&l 149. Initial Register Values (¥J44 2717 A%(H)

Initial Register "u"aluesl. = | El ﬂh,l Initial Register "u"aluesl. = | [E ﬂh,l
Datapath cntr8 (8) Datapath cntrd (3)

DF " a" CP"_a"

all_init_a: [ al_int_a: Counter_Period
al_init_a: [ al_int_a: [
dl_init_a: [ dl_int_a: 15
d1_init_a: [ d1_init_a: Compare_Value

ok | [ canca | | ok | | canca |

I SIS R IERE I H A Verilog SRS A BB BT, 16 DR B PIIE ( 2% [ 149 47 o s
A .

14.4 BIiEMAEEE
I i et P R B R B (S S, FT LU A ST R ) 16, 24 1 32 AL DA, /S A A PR A 2

Nl 150 B, FITAS A R 2 A R 3RAR 5 B2 14 5 i S M fERAT RIORRER B8 v A7 RS B o 2 8 AR IR R0 1Y
BB R A AT BRI T IR B R ARA 7T, CFBO (R 1 CRC/IPRS HE#:AS 5 MIRMIA 2L
TSR 1 B f e AR, T CMSBO  (MSB it ) M B e 1 A B 22 3 B AR A e

150. Hudfs Bt A RS S

UDB_c UDB_b UDB_a
CEO CEOQi [ CEO CEOQi CEO CEQi r«¢— O
CLO CLOi CLO CLOi -t CLO CLOi ¢— O
CEl CE1li |t CE1l CEli (- CE1l CEli l«¢— O
CL1 CL1i |t CL1 CL1i v CL1 CLli ¢— O
Z0 Z0i -t Z0 Z0i -t Z0 Z0i -¢— O
Z1 Z1i - Z1 Z1i -t Z1 Zli -¢— O
FFO FFOi | FFO FFOi - FFO FFOi -¢— O
FF1 UDB2 FFLli g FF1 UDB1 FFli - FF1 UDBO FFli -¢— O
CAPO CAPOi & CAPO CAPOi ¢ CAPO CAPOi «¢— O
CAP1 CAPli |« CAP1 CAPLi CAP1 CAPli -¢— O
CO_MSsB Cl -t CO_MSB Cl -t CO_MSB Cllg—O0
SOL_MSB SIR | SOL_MSB SIR |- SOL_MSB SIR «4— O
CFBO CFBI |- CFBO CFBI| CFBO CFBI ¢— 0O

0 — SIL SOR P SIL SOR P SIL SOR

0 —» CMSBI CMSBO - CMSBI CMSBO - CMSBI CMSBO
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151 BoR AR EER AR AR A B G L. UDB_a 2 fINH AUk, UDB_c i A Auiib. 15 151 SoR il
THPREE S () AR A E, ATLLEVE 3-UDB (£ik 24 7)) TheE. 16 ek 32 frThfg. ZEIWER 18k FB Mtk
# CMSB IRCE L (BIEETTRBAERD -

WiC(ERE 150, KA B SAREREE —RN, 208 (B, @Rz KK 151 i AR
B, FERTAEES M LSB (UDB a) #4%% MSB (UDB_c) (#i4% CMSB 44 . B EHAT T BALERAE,
A4 T BARIERL AL 7 1A R O AL D B (1A 151 TP BoR 19 Shift-Left (8D . Shift-Right (%) Al Arithmetic

Shift-Right (AL .

K 151. #EH:0 DCT fic &

UDB_c UDB_b UDB_a
) Cl SELx: CHAIN Cl SELx: CHAIN ClI SELx: ARITH
Basic CHAINx: CHAIN CHAINx: CHAIN CHAINx: NO CHAIN
Configuration Chain FB: CHAIN Chain FB: CHAIN Chain FB: NO CHAIN
Chain CMSB: NO CHAIN Chain CMSB: CHAIN Chain CMSB: CHAIN
UDB_c UDB_b UDB_a
Cl SELx: CHAIN Cl SELx: CHAIN Cl SELx: ARITH
_ CHAINx: CHAIN CHAINx: CHAIN CHAINx: NO CHAIN
Shift Left Chain FB: CHAIN Chain FB: CHAIN Chain FB: NO CHAIN
Chain CMSB: NO CHAIN Chain CMSB: CHAIN Chain CMSB: CHAIN
SI SELx: CHAIN SI SELx: CHAIN S| SELx: DEFSI
UDB_c UDB_b UDB_a
Cl SELx: CHAIN Cl SELx: CHAIN Cl SELx: ARITH
o CHAINx: CHAIN CHAINx: CHAIN CHAINx: NO CHAIN
Shift Right Chain FB: CHAIN Chain FB: CHAIN Chain FB: NO CHAIN
Chain CMSB: NO CHAIN Chain CMSB: CHAIN Chain CMSB: CHAIN
S| SELx: DEFSI SI SELx: CHAIN S| SELx: CHAIN
UDB_c UDB_b UDB_a
EL‘SA'IE,\']i gm:m Cl SELx: CHAIN CI SELx: CHAIN
) ) Chain EB: Chain CHAINx: CHAIN CHAINx: CHAIN
Arithmetic Chain GMSE: NO CHAIN Chain FB: Chain Chain FB: No Chain
Shift Right : Chain CMSB: CHAIN Chain CMSB: CHAIN
S| SELx: DEFSI ) _
MSB SI-MSB SI SELx: CHAIN S| SELx: CHAIN
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145 BIEHE AR E R

MWIH % CY_SET_REG8 (Hufik. f8) 1 CY_GET_REGS8 (Hilih) BLiXLepgHiiM R 16, 24 5 32 fifiR4ds, ATLA
TE[E 4 4 17 ) 48 B 12 77 A7 8%

XL AF AR B IE SR AEAE cyfitter.h SO ORI G S AERZSCHE) o Bln, WR—4470y “cntr8” [ 8 A Hdf
1ESBIE— N4 “SimpleCntr_17 FIZHAFh A3 R]SLBIL, B4 cyfitter.h SUIRREAL & — NG T BT A Bl A 25 17 4%
HuhE ARSI R, 1275 ] 152,

152, ¥R A2 25 A7 A 1k

/% SimpleCntrg 1 */
#define SimpleCntr® 1 cntrf wl 16BIT A0 REG CYREG Bl UDEQS 06 AO

#define SimpleCntr8 1 cntr8 ud 16BIT A1 REG CYREG Bl UDEOS 06 21

#define SimpleCntrg 1 cntrf w0 16BIT DO REG CYREG Bl UDEOS 06 DO

#define SimpleCntr8 1 cntrd ud 16BIT D1 REG CYREG Bl UDEOS 06 D1

#define SimpleCntrg 1 cntrd ul 16BIT DP AUX CTL REG CYREG E1 UDBOS 06 ACTL
$#define SimpleCntr8 1 cntrd uwd 16BIT FO REG CYREG Bl UDEOS 06 FO

$define SimpleCntrg 1 cntr& ud 16BIT F1 REG CYREG Bl UDEOS 06 F1

#$define SimpleCntr8 1 cntrf wd AOQ A1 REG CYREG Bl UDBOS A0 Al

$define SimpleCntrf8 1 cntr® ul A0 REG CYREG BE1 UDBOS AO
$define SimpleCntr8 1 cntxrd ul A1 REG CYREG Bl UDBOS 21
#define SimpleCntr8 1 cntrf ud DO D1 REG CYREG Bl UDEQOS DO D1
#define SimpleCntrg 1 cntrg ul DO REG CYREG Bl UDBOS DO
#define SimpleCntr8 1 cntrf ud D1 REG CYREG El1 UDE0OS D1
#define SimpleCntrg 1 cntr® ul DP AUX CTL REG CYREG E1 UDEOS RCTL
#$define SimpleCntr8 1 cntr8 wd FO F1 REG CYREG Bl UDBOS FO F1
$define SimpleCntr® 1 cntrg ul FO REG CYREG Bl UDBOS FO
$define SimpleCntr8 1 cntrf wd F1 REG CYREG Bl UDBOS F1

146 HAER

WA R MARE LANE R, EEKRYUS D Help > Documentation J& &R 1) DCT BUK X sHidi Help >
Documentation > Component Author Guide J& &7~ PSoC Creator #1720 {1l i i 5 (1) fi4 3% B
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15 M C — BIAERK Verilog 15

AW FARML T PSoC Creator A% M 42HL B T HA MK Verilog S35, X B 5 R FACHS R MR G130 H#1 (20461
AR B IR . 5ANHZICHREEN PSoC Creator 1 HALE T 58 ¥ M7 35 H A1V RE . 1% BB R ARG 7~
T 1#iH PSoC Creator 1% 12 B T B Verilog A5 (328 .

15.1 PSoC Creator A RHI3%T Verilog 3044
24 PSoC Creator 1 X4 Verilog SCAFI, EARH & T rEA:

// #start header’' -- edit after this line, do not edit this line

// Copyright YOUR COMPANY, THE YEAR
// All Rights Reserved
// UNPUBLISHED, LICENSED SOFTWARE.

// CONFIDENTIAL AND PROPRIETARY INFORMATION
// WHICH IS THE PROPERTY OF your company.

//

// ========================================

‘include "cypress.v"

// #end® -- edit above this line, do not edit this line

// Generated on 09/17/2012 at 11:02
// Component: UpDwnCntrPwm vl 0
module SimpleCntr8 vl 0 (

output tc,

input clk
)

// #start body' -- edit after this line, do not edit this line
// Your code goes here

// #end® -- edit above this line, do not edit this line
endmodule

// #start footer® -- edit after this line, do not edit this line
// #end® -- edit above this line, do not edit this line

TEXFES T, BT ‘tc” Al ‘clk’ 51 RTE SimpleCntr8 41475 b, B EATRIME] T S0 WA
AN BLAE AR 2, U A X e AR AT

15.2  WHHEHRBEAELHIK Verilog X

4 AR BT LR B O B A R ARRI , 3 AREDIS W BB 140 Veerilog SCAERY. — AR X IR E
KT LI 1%

// #start header® -- edit after this line, do not edit this line

// Copyright YOUR COMPANY, THE YEAR
// All Rights Reserved
// UNPUBLISHED, LICENSED SOFTWARE.

// CONFIDENTIAL AND PROPRIETARY INFORMATION
// WHICH IS THE PROPERTY OF your company.

//

/| ========================================

“include "cypress.v"

// #end® -- edit above this line, do not edit this line

// Generated on 09/17/2012 at 11:02
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// Component: UpDwnCntrPwm vl 0
module SimpleCntr8 vl 0 (
output tc,
input clk
) ;

// #start body' -- edit after this line, do not edit this line
// Your code goes here
// #end’ -- edit above this line, do not edit this line

cy psoc3 dp8 f# (.cy dpconfig a(

{
"CS_ALU OP PASS, “CS_SRCA A0, 'CS_SRCB DO,
"CS_SHFT OP _PASS, 'CS A0 SRC_NONE, 'CS Al SRC NONE,
"CS_FEEDBACK DSBL, 'CS_CI SEL CFGA, CS_SI SEL CFGA,
'CS_CMP_SEL CFGA, /*CFGRAMO: */
"CS_ALU OP PASS, “CS_SRCA A0, 'CS_SRCB DO,
"CS_SHFT OP PASS, 'CS A0 SRC NONE, 'CS Al SRC NONE,
"CS_FEEDBACK DSBL, 'CS_CI SEL CFGA, °CS_SI SEL CFGA,
'CS_CMP_SEL CFGA, /*CFGRAM1: */
"CS_ALU OP PASS, “CS_SRCA A0, 'CS_SRCB DO,
"CS_SHFT OP PASS, 'CS A0 SRC _NONE, 'CS Al SRC NONE,
"CS_FEEDBACK DSBL, 'CS_CI SEL CFGA, °CS_SI SEL CFGA,
'CS_CMP_SEL CFGA, /*CFGRAMZ2: */
"CS_ALU_OP PASS, “CS_SRCA A0, 'CS_SRCB DO,
"CS_SHFT OP PASS, 'CS A0 SRC _NONE, 'CS Al SRC NONE,
"CS_FEEDBACK DSBL, 'CS_CI SEL CFGA, °CS_SI SEL CFGA,
'CS_CMP_SEL CFGA, /*CFGRAM3: */
"CS_ALU _OP PASS, “CS_SRCA A0, 'CS_SRCB DO,
"CS_SHFT OP PASS, 'CS A0 SRC NONE, 'CS Al SRC NONE,
"CS_FEEDBACK DSBL, 'CS_CI SEL CFGA, 'CS_SI SEL CFGA,
'CS_CMP_SEL CFGA, /*CFGRAM4: */
"CS_ALU _OP PASS, CS_SRCA AO0, 'CS_SRCB DO,
'CS_SHFT OP PASS, 'CS A0 SRC _NONE, 'CS Al SRC NONE,
"CS_FEEDBACK DSBL, 'CS_CI SEL CFGA, CS_SI SEL CFGA,
'CS_CMP_SEL CFGA, /*CFGRAMS5: */
"CS_ALU OP PASS, CS_SRCA AO0, 'CS_SRCB DO,
"CS_SHFT OP PASS, 'CS A0 SRC NONE, 'CS Al SRC NONE,
"CS_FEEDBACK _DSBL, 'CS_CI SEL CFGA, CS_SI SEL CFGA,
'CS_CMP_SEL CFGA, /*CFGRAM6: */
"CS_ALU OP PASS, CS_SRCA AO0, 'CS_SRCB DO,
"CS_SHFT OP PASS, 'CS A0 SRC _NONE, 'CS Al SRC NONE,
"CS_FEEDBACK _DSBL, 'CS_CI SEL CFGA, CS_SI SEL CFGA,
'CS_CMP_SEL CFGA, /*CEGRAM7: */
8'hFF, 8'h00, /*CFG9: */
8'hFF, 8'hFF, /*CFGl11-10: */
'SC_CMPB Al D1, "SC_CMPA Al D1, "SC_CI B ARITH,
"SC_CI A ARITH, "SC_Cl MASK DSBL, 'SC_CO MASK DSBL,
"SC_A MASK DSBL, “SC _DEF SI 0, 'SC_SI B DEFSI,
'SC_SI A DEFSI, /*CFG13-12: */
"SC_AO0 _SRC_ACC, °SC_SHIFT SL, 1'ho,
1'h0, “SC_FIFOl BUS, “SC_FIFOO BUS,
'SC_MSB_DSBL, 'SC _MSB BITO, ~SC_MSB_ NOCHN,
*SC_FB NOCHN, 'SC_CMP1 NOCHN,
'SC_CMPO NOCHN, /*CFG15-14: */
10'h00, “SC_FIFO CLK_DP, SC_FIFO CAP AX,
'SC_FIFO _LEVEL, 'SC_FIFO_ SYNC, 'SC_EXTCRC DSBL,
"SC_WRK16CAT DSBL /*CFGl7-16: */

}

)) cntr8(
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/* input */ .reset(1'b0),
/* input */ .clk (1"'b0),
/* input [02:00] */ .cs_addr (3'b0),
/* input */ .route si(1'b0),
/* input */ .route ci(1'b0),
/* input */ .f0 load(1'bO),
/* input */ .f1 load(1'b0),
/* input */ .d0_load(1'b0),
/* input */ .dl_load(1'b0),
/* output */  .cel(),
/* output */ .cl0(),
/* output */ .z0(),
/* output x/ f£f0(),
/* output */ .cel(),
/* output */  .cll(),
/* output */ .zl (),
/* output */  Jff1(),
/* output */ .ov_msb(),
/* output */ .co msb(),
/* output */ .cmsb (),
/* output */  .sol(),
/* output */ .f0 _bus stat(),
/* output */ .f0 blk stat(),
/* output */ .fl bus_stat(),
/* output */ .fl blk stat()
);
endmodule
// #start footer® -- edit after this line, do not edit this line
// #end® -- edit above this line, do not edit this line

R, BARCHENTHE RAM MBEFERIE T, (HENAN UM Cbric ERE . Dz8dE a2 .
T 22 P R B R AT B P OB R

& 22. Verilog MfFZ# 1) E X

Verilog /0% & X /st
-reset(1'b0), BRI AL S
.clk(1'b0), B A R AN
.cs_addr(3'b0), fit & A bt 5 5
.route_si(1'b0), A Ze 16 Shift In
.route_ci(1'b0), ik Carry In
.f0_load(1'b0), FIFO 0 n#f5 %
f1_load(1'b0), FIFO 1 fn#/f5 %
.d0_load(1'b0), DO fi#i {55
.d1_load(1'b0), D1 fi# 55
.ce0(), L 0“4
.clo), EAgE 0N T4
.20(), TR 0 K%
ff0(), 2 1P O ki
.cel(), B 15 T
.cl1(), LR 1N T
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Verilog f%5% & /BT
210, TR 1 1
ff10), 4 1R 14
.ov_msh(), i R
.co_msh(), Carry Out
.cmsb(), WA A ETEARN HE 1L+
.s0(), Shift Out
.f0_bus_stat(), FIFO 0 B2 RS hrE>
.fO_blk_stat(), FIFO 0 FEHuR A bR
.f1_bus_stat(), FIFO 1 SRS brEr
f1_blk_stat() FIFO 1 #iHUIR ZS bR &+

FEZH RSB NER, ESERARSE TN
IX SRS R AR AT DL IAE R RT3 . WA EAT, A5 S . Verilog A RIEIE B A2 44 2 (B BEA 14 5Bk .
15.3  #4T SimpleCntr8 BXUE I Verilog X4
X fAi R 8 A AR i 52 8 Verilog SO

// #start header’' -- edit after this line, do not edit this line

// Copyright YOUR COMPANY, THE YEAR
// All Rights Reserved
// UNPUBLISHED, LICENSED SOFTWARE.

// CONFIDENTIAL AND PROPRIETARY INFORMATION
// WHICH IS THE PROPERTY OF your company.

//

// ========================================

“include "cypress.v"

// #end’ -- edit above this line, do not edit this line

// Generated on 09/17/2012 at 11:02
// Component: UpDwnCntrPwm vl O
module SimpleCntr8 vl 0 (

output tc,

input clk
)

// #start body' -- edit after this line, do not edit this line
// Your code goes here
// #end® -- edit above this line, do not edit this line

cy psoc3 dp8 #(.a0 init a(8'b00001111), .d0 init a(8'b00001111),

.cy dpconfig a(

{
"CS_ALU OP DEC, "CS SRCA A0, "CS SRCB DO,
*CS_SHFT OP PASS, 'CS A0 SRC__ALU, 'CS_Al SRC_NONE,
*CS_FEEDBACK DSBL, 'CS CI SEL CFGA, 'CS SI SEL CFGA,
*CS_CMP_SEL_CFGA, /*CFGRAMO: */
"CS_ALU OP PASS, 'CS _SRCA A0, "CS SRCB DO,
*CS_SHFT OP PASS, 'CS A0 SRC__ DO, 'CS_Al SRC_NONE,
*CS_FEEDBACK DSBL, 'CS CI SEL CFGA, 'CS_SI SEL CFGA,
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}
))

'CS_CMP_SEL CFGA, /*CFGRAMI: */

"CS_ALU OP PASS, "CS_SRCA A0, 'CS_SRCB DO,

"CS_SHFT OP_PASS, 'CS A0 SRC _NONE, 'CS_Al SRC NONE,
'CS_FEEDBACK DSBL, 'CS CI SEL CFGA, 'CS _SI SEL CFGA,
'CS_CMP_SEL CFGA, /*CFGRAM2: */

"CS_ALU OP PASS, ‘CSisRCAiAO, *CS_SRCB_DO,

"CS_SHFT OP_PASS, 'CS A0 SRC _NONE, 'CS Al SRC NONE,
cs FEEDBACK DSBL, 'CS CI SEL_CFGA, °CS_SI SEL CFGA,
*CS CMP SEL CFGA, /*CFGRAM3: */

‘CSiALUioPiPASS “CS_SRCA A0, “CS_SRCB DO,

"CS_SHFT OP_PASS, 'CS A0 SRC_NONE, 'CS Al SRC NONE,
*CS_FEEDBACK DSBL, 'CS _CI SEL CFGA, CS_SI SEL CFGA,
s _CMP_SEL CFGA /*CFGRAMA4 : */

*CS ALU OP PASS, *CS_SRCA A0, “CS_SRCB DO,
‘CS_SHFT_OP_PASS "CS_AO0_SRC _NONE, ‘CS Al SRC_NONE,
*CS_FEEDBACK DSBL, 'CS_CI SEL CFGA, CS_SI SEL CFGA,
'CS_CMP_SEL CFGA, /*CFGRAMS5: */

"CS_ALU OP PASS, “CS_SRCA A0, 'CS_SRCB DO,

"CS_SHFT OP PASS, 'CS A0 SRC NONE, ‘CS Al SRC_NONE,
cs _FEEDBACK DSBL, °CS cI SEL_CFGA, °CS_SI SEL CFGA,
*CS CMP SEL CFGA, /*CFGRAMG6: */

‘CS_ALU_OP_PASS "CS_SRCA A0, “CS_SRCB DO,
"CS_SHFT OP PASS, 'CS A0 SRC NONE, ‘CS Al SRC_NONE,
"CS_FEEDBACK DSBL, 'CS_CI SEL CFGA, °CS_SI SEL CFGA,

"CS_CMP_SEL CFGA, /*CEFGRAMT7: */
8'hFF, 8'h00, /*CFG9: */
8'hFF, 8'hFF, /*CFG11-10: */

'SC_CMPB_Al DI,
"SC CI A . ARITH
"SC_A MASK DSBL,

'SC_CMPA Al D1, "SC_CI B ARITH,
'SC_Cl1 MASK DSBL, 'SC CO MASK DSBL,
"SC DEF SI 0, 'SC SI B DEFSI,
'SC_SI A DEFSI, /*CFG13-12: */

"SC A0 SRC ACC, 'SC_SHIFT SL, 1'hoO,

1'h0, “SC_FIFOl BUS, ‘SC_FIFOO BUS,

'SC_MSB_DSBL, 'SC_MSB BITO, °SC_MSB_NOCHN,

'SC_FB NOCHN, “SC CMP1 NOCHN,

'SC_CMPO_NOCHN, /*CFG15-14: */

10'h00, \SC FIFO CLK DP, \SC7FIFO CAP AX,

"SC FIFO LEVEL SC FIFO SYNC, 'SC EXTCRC DSBL,

“SC WRKlGCAT ~ DSBL /*CFG17 16: */

cntr8(

/* input */ .reset(1'b0),
/* input */ .clk(clk),
/* input [02:00] */ .cs_addr ({2'b0,tc}),
/* input */ .route si(1'b0),
/* input */ .route ci(1'b0),
/* input */ .f0_load(1'b0),
/* input */ .f1 load(1'b0),
/* input */ .d0_load(1'b0),
/* input */ .dl load(1'b0),
/* output x/  .ce0(),
/* output */ .clO()
/* output */ .z0(tc
/* output */ .ffO(),
/* output */  .cel(),
/* output */  .cll(),
/* output */  .z1(),
/* output */  Jff1(),
/* output */ .ov_msb(),
/* output */ .co msb(),
/* output */ .cmsb (),

/* tie clk signal to datapath clock */

/* tc determines address lsb */

), /* tc signal comes from z0 state */
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/*
/*
/*
/*
/*
) ;
endmodule

output
output
output
output
output

// #start footer®

// #end’ -- edit above this line,

*/
*/
*/
*/
*/

.so (),

.f0_bus_stat
.f0 blk stat
.f1 bus_ stat
.f1 blk stat

)l
)y
)l
)

-- edit after this line, do not edit this line
do not edit this line

CRECHE TR E RN A0 XA EET, J5E X T A0 1 DO WA AR IIME . T34k, IR R 1 5 4

NIt}
ifif o

AT ANk iZ 30, B e s AR i B TR AR B R S
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16 M3 D — WA PI M PO B 24 A¥dR Bt A2n Bl

// Requires these signals to tie the 3 datapaths together
wire [14:0] chainO;
wire [14:0] chainl;

// Datapath 0
cy psoc3 dp #(.cy dpconfig(
{
'CS_ALU OP_PASS, 'CS _SRCA A0, CS_SRCB DO,
'CS_SHFT OP_PASS, 'CS_ A0 SRC NONE, 'CS_Al SRC_NONE,
'CS_FEEDBACK DSBL, 'CS CI SEL CFGA, 'CS ST SEL CFGA,
'CS CMP_SEL CFGA, /*CS REGO Comment: */
'CS_ALU OP_PASS, 'CS_SRCA A0, 'CS_SRCB DO,
'CS SHFT OP PASS, 'CS A0 SRC NONE, 'CS Al SRC NONE,
'CS_FEEDBACK DSBL, 'CS _CI SEL CFGA, 'CS SI SEL CFGA,
'CS CMP_SEL CFGA, /*CS REG1 Comment: */
'CS_ALU OP_PASS, 'CS_SRCA A0, 'CS_SRCB DO,
'CS SHFT OP PASS, 'CS A0 SRC NONE, 'CS Al SRC NONE,
'CS_FEEDBACK DSBL, 'CS _CI SEL CFGA, 'CS SI SEL CFGA,
'CS CMP_SEL CFGA, /*CS REG2 Comment: */
'CS_ALU OP_PASS, 'CS_SRCA A0, 'CS_SRCB DO,
'CS SHFT OP PASS, 'CS A0 SRC NONE, 'CS Al SRC NONE,
'CS_FEEDBACK DSBL, 'CS _CI SEL CFGA, 'CS SI SEL CFGA,
'CS CMP_SEL CFGA, /*CS REG3 Comment: */
'CS ALU OP PASS, 'CS SRCA A0, 'CS_SRCB DO,
'CS_SHFT OP PASS, 'CS A0 SRC _NONE, 'CS Al SRC_NONE,
'CS_FEEDBACK DSBL, 'CS_CI SEL CFGA, 'CS_SI SEL CFGA,
'CS_CMP_SEL_CFGA, /*CS REG4 Comment: */
'CS ALU OP PASS, 'CS SRCA A0, 'CS_SRCB DO,
'CS_SHFT OP PASS, 'CS A0 SRC _NONE, 'CS Al SRC_NONE,
'CS_FEEDBACK DSBL, 'CS _CI SEL CFGA, 'CS_SI SEL CFGA,
'CS_CMP_SEL_CFGA, /*CS _REG5 Comment: */
'CS_ALU OP_PASS, 'CS_SRCA A0, ‘CS_SRCB DO,
'CS_SHFT OP _PASS, 'CS A0 SRC_NONE, 'CS Al SRC_NONE,
'CS_FEEDBACK DSBL, 'CS _CI SEL CFGA, 'CS SI SEL CFGA,
'CS_CMP_SEL_CFGA, /*CS _REG6 Comment: */
'CS ALU OP PASS, 'CS SRCA A0, 'CS_SRCB DO,
'CS_SHFT OP PASS, 'CS A0 SRC NONE, 'CS Al SRC NONE,
'CS_FEEDBACK DSBL, 'CS_CI SEL CFGA, 'CS_SI SEL CFGA,
'CS_CMP_SEL_CFGA, /*CS_REGT Comment: */
8'hFF, 8'h0O, /*SC_REG4 Comment: */
8'hFF, 8'hFF, /*SC_REG5 Comment: */
*SC_CMPB Al D1, 'SC_CMPA Al D1, 'SC_CI B ARITH,
"SC_CI_A ARITH, 'SC_Cl MASK DSBL, SC_CO MASK DSBL,
'SC_A MASK DSBL, 'SC_DEF SI 0, 'SC_SI B DEFSI,
"SC_SI_A DEFSI, /*SC_REG6 Comment: */
*SC_AO_SRC_ACC, 'SC_SHIFT SL, 1'b0,
1'p0, “SC_FIFOl BUS, ‘SC_FIFOO_ A0,
"SC_MSB DSBL, "SC _MSB BITO, "SC MSB NOCHN,
*SC_FB NOCHN, 'SC_CMP1 NOCHN,
*SC_CMPO_NOCHN, /*SC_REG7 Comment: */
10'h0, “SC_FIFO CLK DP, SC_FIFO CAP AX,
*SC_FIFO LEVEL, 'SC_FIFO__SYNC, SC_EXTCRC DSBL,
"SC_WRK16CAT DSBL /*SC_REG8 Comment: */

})) DatapathO (
/* input */ .clk(), // Clock
/* input [02:00] */ .cs_addr(), // Control Store RAM address
/* input */ .route si(1'b0), // Shift in from routing
/* input */ .route ci(1'b0), // Carry in from routing
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/* input */ .f0 load(1'b0), // Load FIFO 0
/* input */ .fl load(1'bO), // Load FIFO 1
/* input */ .d0_load(1'bO), // Load Data Register 0
/* input */ .dl load(1'bO), // Load Data Register 1
/* output */ .ceO(), // Accumulator 0 = Data register O
/* output */ .cl0(), // Accumulator 0 < Data register 0
/* output */ .z0(), // Accumulator 0 = 0
/* output */ .f£f0(), // Accumulator 0 = FF
/* output */ .cel(), // Accumulator [0|1] = Data register 1
/* output */ .cll(), // Accumulator [0|1] < Data register 1
/* output */ .zl(), // Accumulator 1 = 0
/* output */ .ff1(), // Accumulator 1 = FF
/* output */ .ov msb(), // Operation over flow
/* output */ .co msb(), // Carry out
/* output */ .cmsb(), // Carry out
/* output */ .so(), // Shift out
/* output */ .f0_bus_stat(), // FIFO 0 status to uP
/* output */ .£f0 blk stat(), // FIFO 0 status to DP
/* output */ .fl bus stat(), // FIFO 1 status to uP
/* output */ .f1l blk stat(), // FIFO 1 status to DP
/* input */ .ci(1'bO0), // Carry in from previous stage
/* output */ .co(chainO[12]), // Carry out to next stage
/* input */ .sir(1'b0), // Shift in from right side
/* output */ .sor(), // Shift out to right side
/* input */ .sil(chainO[10]), // Shift in from left side
/* output */ .sol(chainO[11]), // Shift out to left side
/* input */ .msbi(chain0[9]), // MSB chain in
/* output */ .msbo(), // MSB chain out
/* input [01:00] */ .cei(2'b0), // Compare equal in from prev stage
/* output [01:00] */ .ceo(chain0[1:0]), // Compare equal out to next stage
/* input [01:00] */ .cli(2'b0), // Compare less than in from prv stage
/* output [01:00] */ .clo(chain0([3:2]), // Compare less than out to next stage
/* input [01:00] */ .zi(2'bO), // Zero detect in from previous stage
/* output [01:00] */ .zo(chainO[5:4]), // Zero detect out to next stage
/* input [01:00] */ .£fi(2'bO), // OxFF detect in from previous stage
/* output [01:00] */ .fo(chainO[7:6]), // OxXFF detect out to next stage
/* input [01:00] */ .capi(2'b0), // Capture in from previous stage
/* output [01:00] */ .capo(chain0[14:13]), // Capture out to next stage
/* input */ .cfbi(1'b0), // CRC Feedback in from previous stage
/* output */ .cfbo(chain0[8]), // CRC Feedback out to next stage
/* input [07:00] */ .pi(), // Parallel data port
/* output [07:00] */ .po() // Parallel data port

) ;

// Datapath 1
cy psoc3 dp #(.cy dpconfig(
{

'CS_ALU OP_PASS, 'CS_SRCA A0, 'CS_SRCB_DO,
*CS_SHFT OP PASS, 'CS A0 SRC_NONE, ‘CS_Al SRC_NONE,
'CS_FEEDBACK DSBL, 'CS CI SEL CFGA, 'CS SI SEL CFGA,
*CS_CMP_SEL_CFGA, /*CS REGO Comment: */

'CS_ALU OP_PASS, 'CS_SRCA A0, 'CS_SRCB_DO,
‘CS_SHFT OP PASS, 'CS A0 SRC_NONE, 'CS_Al SRC_NONE,
'CS_FEEDBACK DSBL, 'CS CI SEL CFGA, 'CS SI SEL CFGA,
‘CS_CMP_SEL_CFGA, /*CS REG1 Comment: */

'CS_ALU OP_PASS, 'CS_SRCA A0, 'CS_SRCB_DO,
*CS_SHFT OP PASS, 'CS A0 SRC_NONE, ‘CS_Al SRC_NONE,
*CS_FEEDBACK DSBL, 'CS CI SEL CFGA, 'CS_SI SEL CFGA,
"CS_CMP_SEL CFGA, /*CS_REG2 Comment: */

'CS ALU OP PASS, 'CS SRCA A0, ‘CS SRCB DO,

'CS_SHFT OP_PASS, 'CS A0 SRC _NONE, 'CS Al SRC_NONE,
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"CS_FEEDBACK DSBL,

"CS_CI_SEL CFGA,

'CS_SI SEL_CFGA,

'CS CMP SEL CFGA, /*CS REG3 Comment: */

'CS_ALU OP_PASS,
'CS_SHFT OP_PASS,
'CS_FEEDBACK DSBL,

'CS_SRCA A0,

'CS_A0_SRC_NONE,
'CS_CI_SEL CFGA,

*CS_SRCB DO,
'CS_Al SRC_NONE,

'CS_SI SEL_CFGA,

"CS _CMP_SEL CFGA, /*CS REG4 Comment: */

'CS_ALU OP_PASS,
'CS_SHFT OP_PASS,
'CS_FEEDBACK DSBL,

"CS_SRCA_AO0,

'CS_AO0_SRC_NONE,
'CS_CI SEL CFGA,

*CS_SRCB DO,
'CS_Al SRC_NONE,

'CS_SI SEL CFGA,

'CS_CMP_SEL_CFGA, /*CS _REG5 Comment: */

'CS_ALU OP_PASS,
'CS_SHFT OP_PASS,
'CS_FEEDBACK DSBL,

'CS_SRCA_AO0,

'CS_AO0_SRC_NONE,
'CS_CI_SEL _CFGA,

*CS_SRCB DO,
*CS_Al SRC_NONE,

'CS_SI SEL CFGA,

'CS CMP SEL_CFGA, /*CS REG6 Comment: */

'CS_ALU OP_PASS,
'CS_SHFT OP_PASS,
'CS_FEEDBACK DSBL,

'CS_SRCA_AO0,

'CS_AO0_SRC_NONE,
'CS_CI SEL _CFGA,

*CS_SRCB DO,
'CS_Al SRC_NONE,

'CS_SI SEL CFGA,

*CS_CMP_SEL CFGA, /*CS REG7 Comment: */

Comment: */

- Comment: */
'SC_CMPB Al D1, 'SC_CMPA Al D1, 'SC_CI B ARITH,
'SC_CO_MASK_DSBL,

*SC_CI A ARITH,
*SC_A MASK_DSBL,

8 'hFF,
8 'hFF,

8'h00,
8'hFF,

/*SC_REG4
/*SC REG5

'SC_C1 MASK DSBL,
*SC_DEF_SI 0,

*SC_SI B DEFSI,

'SC_SI_A DEFSI, /*SC_REG6 Comment: */

*SC_AO0_SRC_ACC,

1'p0, “SC_FIFOl BUS,

*SC_SHIFT SL,
*SC_FIFOO

1'b0,
A0,

'SC_MSB DSBL, 'SC_MSB BITO, 'SC_MSB NOCHN,

*SC_FB_NOCHN,
*SC_CMPO_NOCHN,

1

0'ho,

*SC_CMP1 NOCHN,

/*SC_REG7 Comment: */
'SC_FIFO CLK_ DP, SC_FIFO CAP AX,

*SC_FIFO LEVEL, "SC_FIFO SYNC, SC_EXTCRC_DSBL,

"SC_WRK16CAT DSBL /*SC REG8 Comment:

})) Datapathl (
/* input */ .clk(),
/* input [02:00] */ .cs_addr(),
/* input */ .route si(1'bO),
/* input */ .route ci(1'b0),
/* input */ .£f0 load(1'bO),
/* input */ .f1 load(1'b0),
/* input */ .d0_load(1'b0),
/* input */ .dl load(1'b0),
/* output */ .cel(),
/* output */ .cl0(),
/* output */ .z0(),
/* output */ .££f0(),
/* output */ .cel(),
/* output */ .cll(),
/* output */ .zl(),
/* output */ .£f£f1(),
/* output */ .ov msb(),
/* output */ .co _msb(),
/* output */ .cmsb(),
/* output */ .so(),
/* output */ .f0 bus_stat(),
/* output */ .£f0 blk stat(),
/* output */ .fl bus stat(),
/* output */ .fl blk stat(),
/* input */ .ci(chain0[12]),
/* output */ .co(chainl[12]),
/* input */ .sir(chainO[11]),
/* output */ .sor (chain0[10]),

//
!/
//

*/

Clock

Control Store RAM address
Shift in from routing
Carry in from routing
Load FIFO O

Load FIFO 1

Load Data Register O

Load Data Register 1

Accumulator 0 = Data register O
Accumulator 0 < Data register 0
Accumulator 0 = 0

Accumulator 0 = FF

Accumulator [0]|1] = Data register
Accumulator [0]1] < Data register
Accumulator 1 = 0

Accumulator 1 = FF

Operation over flow

Carry out
Carry out
Shift out
FIFO 0 status
FIFO 0 status
FIFO 1 status
FIFO 1 status to DP

Carry in from previous stage
Carry out to next stage
Shift in from right side
Shift out to right side

to
to
to uP

uP
DP
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) ;

input */ .sil(chainl[10]), // Shift in from left side

output */ .sol(chainl[11]), // Shift out to left side

input */ .msbi(chainl[9]), // MSB chain in

output */ .msbo(chain0[9]), // MSB chain out

input [01:00] */ .cei(chain0[1:0]), // Compare equal in from prev stage

output [01:00] */ .ceo(chainl[1:0]), // Compare equal out to next stage

input [01:00] */ .cli(chainO[3:2]), // Compare less than in from prv stage
1)

output [01:00] */ .clo(chainl([3:2
input [01:00] */ .zi(chainO0[5:4]

, // Compare less than out to next stage
// Zero detect in from previous stage

output [01:00] */ .zo(chainl[5:4]), // Zero detect out to next stage

input [01:00] */ .fi(chainO[7:6]), // OxFF detect in from previous stage

output [01:00] */ .fo(chainl[7:6]), // OxFF detect out to next stage

input [01:00] */ .capi(chain0[14:13]),// Capture in from previous stage

—~

)
]
)
]

output [01:00] */ .capo(chainl[14:13]), // Capture out to next stage
input */ .cfbi(chain0([8]), // CRC Feedback in from previous stage
output */ .cfbo(chainl([8]), // CRC Feedback out to next stage
input [07:00] */ .pi(), // Parallel data port

output [07:00] */ .po() // Parallel data port

// Datapath 2
cy psoc3 dp #(.cy dpconfig(

{

'CS_ALU OP_PASS, 'CS_SRCA A0, 'CS_SRCB DO,

'CS_SHFT OP_PASS, 'CS_ A0 SRC NONE, ‘CS_Al SRC_NONE,
'CS_FEEDBACK DSBL, 'CS_CI_SEL CFGA, 'CS SI SEL CFGA,
"CS _CMP_SEL CFGA, /*CS REGO Comment: */

'CS_ALU OP_PASS, 'CS_SRCA A0, 'CS_SRCB DO,

'CS_SHFT OP_PASS, 'CS_ A0 SRC NONE, ‘CS_Al SRC_NONE,
'CS_FEEDBACK DSBL, 'CS_CI_SEL CFGA, 'CS SI SEL CFGA,
"CS _CMP_SEL CFGA, /*CS REGl Comment: */
'CS_ALU_OP_PASS, 'CS_SRCA A0, CS_SRCB_DO,

'CS_SHFT OP_PASS, 'CS_AO0 SRC_NONE, CS_Al SRC_NONE,
'CS_FEEDBACK DSBL, 'CS_CI SEL CFGA, 'CS_SI SEL CFGA,
"CS_CMP_SEL _CFGA, /*CS _REG2 Comment: */
'CS_ALU_OP_PASS, 'CS_SRCA A0, CS_SRCB_DO,

'CS_SHFT OP_PASS, 'CS_AO0 SRC_NONE, 'CS_Al SRC_NONE,
'CS_FEEDBACK DSBL, 'CS_CI SEL CFGA, 'CS_SI SEL CFGA,
"CS_CMP_SEL CFGA, /*CS_REG3 Comment: */

'CS_ALU OP_PASS, 'CS_SRCA A0, CS_SRCB_DO,

'CS_SHFT OP_PASS, 'CS_ A0 SRC_NONE, CS_Al SRC_NONE,
'CS_FEEDBACK DSBL, 'CS_CI SEL CFGA, 'CS_SI SEL CFGA,
"CS_CMP_SEL CFGA, /*CS _REG4 Comment: */

'CS_ALU OP_PASS, 'CS_SRCA A0, CS_SRCB_DO,

'CS_SHFT OP_PASS, 'CS A0 SRC NONE, 'CS_Al SRC_NONE,
'CS_FEEDBACK DSBL, 'CS _CI SEL CFGA, 'CS_SI SEL CFGA,
'CS_CMP_SEL_CFGA, /*CS_REG5 Comment: */

'CS_ALU OP_PASS, 'CS_SRCA A0, CS_SRCB_DO,

'CS_SHFT OP_PASS, 'CS A0 SRC NONE, 'CS_Al SRC_NONE,
'CS_FEEDBACK DSBL, 'CS _CI SEL CFGA, 'CS_SI SEL CFGA,
'CS_CMP_SEL_CFGA, /*CS _REG6 Comment: */

'CS_ALU OP_PASS, 'CS_SRCA A0, 'CS_SRCB_DO,

'CS_SHFT OP_PASS, 'CS A0 SRC NONE, 'CS_Al SRC_NONE,
'CS_FEEDBACK DSBL, 'CS _CI SEL CFGA, 'CS_SI SEL CFGA,
'CS_CMP_SEL_CFGA, /*CS _REG7 Comment: */

8'hFF, 8'h00, /*SC_REG4 Comment: */
8'hFF, 8'hFF, /*SC REG5 Comment: */

'SC_CMPB Al D1, 'SC_CMPA Al D1, 'SC_CI B ARITH,
'SC_CI A ARITH, "SC_Cl MASK DSBL, 'SC_CO MASK DSBL,
'SC_A MASK DSBL, 'SC_DEF SI 0, "SC_SI B DEFSI,
*SC_SI_A DEFSI, /*SC_REG6 Comment: */
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'SC_A0_SRC_ACC,

'SC_SHIFT SL,

1'b0,

1'b0, “SC FIFOl BUS, 'SC FIFOO A0,

*SC_MSB_DSBL,
*SC_FB_NOCHN,

*SC_MSB_BITO,
*SC_CMP1_NOCHN,

'SC_MSB_NOCHN,

"SC_CMPO_NOCHN, /*SC_REG7 Comment: */

10'ho,

'SC_FIFO CLK DP, 'SC_FIFO CAP AX,

'SC_FIFO LEVEL, 'SC_FIFO SYNC, 'SC_EXTCRC DSBL,

"SC_WRK16CAT DSBL /*SC_REG8 Comment: */

})) Datapath2 (

/* input */
/* input [02:
/* input */
/* input */
/* input */
/* input */
/* input */

.clk(),

00] */ .cs addr(),

.route _si(1'b0),

.route ci(1'b0),

.f0 _load(1'b0),

.f1 load(1'b0),

.d0_load(1'b0),
( )

Clock
Control Stor

e RAM address

Shift in from routing
Carry in from routing

Load FIFO 0
Load FIFO 1
Load Data Re

gister 0

/* input */ .dl load(1'b0), // Load Data Register 1

/* output */ .ceO(), // Accumulator 0 = Data register 0

/* output */ .clO0(), // Accumulator 0 < Data register O

/* output */ .z0(), // Accumulator 0 = 0

/* output */ .ff0(), // Accumulator 0 = FF

/* output */ .cel(), // Accumulator [0|1] = Data register 1
/* output */ .cll(), // Accumulator [0|1] < Data register 1
/* output */ .z1l(), // Accumulator 1 = 0

/* output */ .ffl(), // Accumulator 1 = FF

/* output */ .ov _msb(), // Operation over flow

/* output */
/* output */
/* output */

Carry out
Carry out
Shift out

/* output */ .f0 _bus_stat(), // FIFO 0 status to uP

/* output */ .£f0 blk stat(), // FIFO O status to DP

/* output */ .fl bus stat(), // FIFO 1 status to uP

/* output */ .fl blk stat(), // FIFO 1 status to DP

/* input */ .ci(chainl[12]), // Carry in from previous stage

/* output */ .co(), // Carry out to next stage

/* input */ .sir(chainl[11]), // Shift in from right side

/* output */ .sor(chainl[10]), // Shift out to right side

/* input */ .sil(1'b0), // Shift in from left side

/* output */ .sol(), // Shift out to left side

/* input */ .msbi (1'b0), // MSB chain in

/* output */ .msbo(chainl[9]), // MSB chain out

/* input [01:00] */ .cei(chainl[1:0]), // Compare equal in from prev stage

/* output [01:00] */ .ceo(), // Compare equal out to next stage

/* input [01:00] */ .cli(chainl[3:2]), // Compare less than in from prv stage
/* output [01:00] */ .clo(), // Compare less than out to next stage
/* input [01:00] */ .zi(chainl[5:4]), // Zero detect in from previous stage
/* output [01:00] */ .zo(), // Zero detect out to next stage

/* input [01:00] */ .fi(chainl[7:6]), // OxFF detect in from previous stage
/* output [01:00] */ .fo(), // OxFF detect out to next stage

/* input [01:00] */ .capi(chainl[14:13]),// Capture in from previous stage

/* output [01:00] */ .capol(), // Capture out to next stage

/* input */ .cfbi(chainl([8]), // CRC Feedback in from previous stage
/* output */ .cfbo(), // CRC Feedback out to next stage

/* input [07:00] */ .pi(), // Parallel data port

/* output [07:00] */ .po() // Parallel data port
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